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1.  Uvod

Dakujeme, Ze ste si vybrali analyzator QlAstat-Dx® Analyzer 2.0. Sme presveddeni, Ze tento systém sa stane neoddelitelnou

sUcastou vasho laboratéria.

V tejto prirucke je popisané, ako pouzivat analyzator QlAstat-Dx Analyzer 2.0 s verziou softvéru 1.6. Pred pouzitim
analyzatora QlAstat-Dx Analyzer 2.0 je nevyhnutné, aby ste si pozorne preStudovali tuto pouzivatelsku priru¢ku a venovali
mimoriadnu pozornost bezpeénostnym informaciam. Pokyny a bezpeénostné informacie v pouzivatelskej prirucke sa musia

dodrziavat, aby sa zabezpecila bezpecna funkcia pristroja a aby sa pristroj udrziaval v bezpe¢nom stave.

Poznamka: Obrazky uvedené v tejto pouzivatel'skej prirucke su iba prikladmi a mézu sa liSit v zavislosti od testu.

1.1. Informacie o tejto pouzivatelskej prirucke

Téato pouzivatelska priru¢ka poskytuje informacie o analyzatore QlAstat-Dx Analyzer 2.0 v nasledujucich Castiach:

e Uvod

e Bezpecnostné informacie

e VSeobecny popis

e  Postupy instalacie

e  Spustenie testu a zobrazenie vysledkov
e  Funkcie a moznosti systému

e  Pripojenie HIS/LIS

e Externa kontrola (EK)

e Udrzba

e Riesenie problémov

e  Technické Specifikacie

Dodatky obsahuju nasledujuce informacie:

e InStalacia a konfiguracia tlaiarne vratane zoznamu testovanych tlaCiarni
e Vyhlasenie o zhode

e Odpad z elektrickych a elektronickych zariadeni (OEEZ)

e Dolozka o zodpovednosti

e Licenéna zmluva pre softvér

e Odmietnutie zaruk

e Slovnik

1.2.  VSeobecné informacie

1.2.1. Technicka pomoc

V spolo¢nosti QIAGEN sme hrdi na kvalitu a dostupnost’ nasej technickej podpory. Na nasich oddeleniach technického
servisu pracuju skuseni vedci s rozsiahlymi praktickymi a teoretickymi poznatkami v oblasti molekularnej biolégie a

pouzivania vyrobkov od spolo¢nosti QIAGEN. Ak mate akékolvek otazky alebo problémy s analyzatorom QlAstat-Dx

Analyzer 2.0 alebo vSeobecne s vyrobkami od spolo€nosti QIAGEN, nevahajte nas kontaktovat.
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Zakaznici spolo¢nosti QIAGEN su hlavnym zdrojom informacii tykajucich sa pokrocilych alebo $pecializovanych pouziti
nasich vyrobkov. Tieto informacie su uzitoéné pre inych vedcov, ako aj pre vyskumnych pracovnikov spolo€nosti QIAGEN.
Preto vam odporu¢ame, aby ste nas kontaktovali, ak mate akékolvek navrhy tykajuce sa vykonnosti vyrobku alebo novych
aplikacii a technik.

Technicku pomoc vam poskytne technicky servis spolo¢nosti QIAGEN na stranke support.qiagen.com.

Pri kontaktovani technického servisu spolo¢nosti QIAGEN v suvislosti s chybami si pripravte nasledujuce informacie:
e  sériové Cislo, typ, verzia softvéru a nainstalované subory definicie testu analyzatora QlAstat-Dx Analyzer 2.0
e  ko&d chyby (ak je to relevantné),
e okamih, kedy sa chyba vyskytla prvykrat,
o frekvencia vyskytu chyb (. j. ob&asna alebo trvala chyba),
o fotografia chyby, ak je to mozné,
e pomocny bali¢ek.

1.2.2. Vyhlasenie o politike

Politikou spolo€nosti QIAGEN je zlepSovat' produkty, ked budu k dispozicii nové techniky a komponenty. Spolo¢nost
QIAGEN si vyhradzuje pravo kedykolvek zmenit Specifikacie. V snahe vytvorit uzitoénu a vhodnu dokumentaciu si vazime
vase pripomienky k tejto pouzivatelskej prirucke. Kontaktujte technicky servis spolo¢nosti QIAGEN.

1.3.  Ur€ené pouZitie analyzatora QlAstat-Dx Analyzer 2.0

Platforma QlAstat-Dx Analyzer 2.0 je uréena na pouzitie ako diagnosticka pomocka in vitro s testami QlAstat-Dx a poskytuje

plnd automatizaciu od pripravy vzorky az po detekciu pomocou testov real-time PCR pri molekularnych aplikaciach.

Tento systém je indikovany na profesionalne pouzitie. Toto zariadenie nie je uréené na samotestovanie ani delokalizovanu
diagnostiku.

1.3.1. Obmedzenia pouzivania

e Analyzator QlAstat-Dx Analyzer 2.0 sa mdze pouzivat iba s testovacimi kazetami QlAstat-Dx podla pokynov
uvedenych v tejto pouzivatelskej priru¢ke a v navode na pouzivanie testovacej kazety QlAstat-Dx.

e  Pri pripajani analyzatora QlAstat-Dx Analyzer 2.0 pouzivajte len kable dodané so systémom.

e Servis alebo opravy smie vykonavat len personal autorizovany spolo¢nostou QIAGEN.

e Analyzator QlAstat-Dx Analyzer 2.0 sa musi pouzivat iba na plochom, vodorovnom povrchu bez rohov alebo
nakloneni.

e Testovaciu kazetu QlAstat-Dx nepouzivajte opakovane, ak ste ju uz ispesne pouzili, alebo ak pri nej doslo k
chybnej alebo neuplnej prevadzke.

e Na kazdej strane analyzatora QlAstat-Dx Analyzer 2.0 nechajte volny priestor aspon 10 cm, aby sa zaistilo
dostatocné vetranie.

e Uistite sa, Ze je analyzator QlAstat-Dx Analyzer 2.0 umiestneny mimo akychkolvek vystupov klimatizacie alebo
vymennikov tepla.

e  Pristroj nepremiestriujte po€as prebiehajuceho testu.

e Pocas cyklu nemerite konfiguraciu systému.
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e Na zdvihanie alebo premiestfiovanie analyzatora QlAstat-Dx Analyzer 2.0 nepouzivajte dotykovu obrazovku.

e  Pristroj nevypinajte ani nereStartuje, kym prebieha zalohovanie, obnova alebo aktualizacia systému.
2. Bezpelnostné informacie

Pred pouzitim analyzatora QlAstat-Dx Analyzer 2.0 je nevyhnutné, aby ste si pozorne preStudovali tuto pouzivatelsku
prirucku avenovali mimoriadnu pozornost bezpecnostnym informaciam. Pokyny a bezpecnostné informacie
v pouzivatelskej prirucke sa musia dodrziavat, aby sa zabezpecila bezpecna funkcia pristroja a aby sa pristroj udrziaval

v bezpe€nom stave.

Mozné rizika, ktoré by mohli poskodit pouzivatela alebo spdsobit poSkodenie pristroja, su jasne uvedené na prislusnych

miestach v tejto pouzivatelskej prirucke.

Ak sa zariadenie pouziva spdsobom, ktory nie je Specifikovany vyrobcom, méze to nepriaznivo ovplyvnit ochranu
poskytovanu zariadenim. V tomto dokumente st uvedené nasledujuce typy bezpeénostnych informacii (navod na pouzitie

analyzatora QlAstat-Dx Analyzer 2.0)

VAROVANIE Vyraz VAROVANIE sa pouziva na informovanie o situaciach, ktoré by mohli viest k zraneniu vas

f alebo inych os6b.
Podrobnosti o tychto okolnostiach su uvedené v poliach, ako je toto.
UPOZORNENIE Vyraz UPOZORNENIE informuje o situaciach, ktoré by mohli mat za nasledok poskodenie
iz pristroja alebo iného zariadenia.
Podrobnosti o tychto okolnostiach su uvedené v poliach, ako je toto.

Vyraz DOLEZITE sa pouZiva na zvyraznenie informécii, ktoré st rozhoduijtice pre dokon&enie Glohy

DOLEZITE _
alebo optimalny vykon systému.
i Vyraz Poznamka sa pouziva pre informacie, ktoré vysvetluju alebo objasnuju konkrétny pripad
Poznamka lebo tiloh
alebo ulohu.

Usmernenia uvedené v tejto prirucke sluzia na doplnenie, a nie nahradenie beznych bezpecnostnych poziadaviek platnych

v krajine pouzivatela.

2.1. Spravne pouZitie

Analyzator QlAstat-Dx Analyzer 2.0 pouzivajte podla tejto pouzivatelskej prirucky. Dérazne sa odporuca, aby ste si pred

pouzitim analyzatora QlAstat-Dx Analyzer 2.0 pozorne precitali navod na pouzitie a oboznamili sa s nim.
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e Dodrziavajte vSetky bezpe€nostné pokyny, ktoré su vytlatené alebo upevnené na analyzatore QlAstat-Dx
Analyzer 2.0.

e Nespravne pouzivanie analyzatora QlAstat-Dx Analyzer 2.0 alebo nedodrzanie spravnej instalacie a udrzby
moZze sposobit zranenie os6b alebo poskodenie analyzatora QlAstat-Dx Analyzer 2.0.

e Analyzator QlAstat-Dx Analyzer 2.0 smie obsluhovat iba kvalifikovany a riadne vySkoleny zdravotnicky personal.

e  Servis analyzatora QlAstat-Dx Analyzer 2.0 smu vykonavat len zastupcovia autorizovani spolo¢nostou QIAGEN.

e Analyzator QlAstat-Dx Analyzer 2.0 nepouzivajte v nebezpecnych prostrediach, pre ktoré nebol navrhnuty.

e Dodrziavajte zasady kybernetickej bezpecnosti vadej organizécie pre uschovu povereni.

e  Pristroj nepremiestriujte po¢as prebiehajuceho testu.

Nebezpeéenstvo poranenia osob a materialnych skéd
VAROVANIE/

UPOZORNENIE Neotvarajte kryt analyzatora QlAstat-Dx Analyzer 2.0. Kryt analyzatora QlAstat-Dx Analyzer 2.0

je navrhnuty tak, aby chranil obsluhu a zaistil spravnu prevadzku analyzatora QlAstat-Dx
& Analyzer 2.0. Pouzivanie analyzatora QlAstat-Dx Analyzer 2.0 bez krytu predstavuje elektrické
nebezpecenstva a mdze spdsobit poruchu analyzatora QlAstat-Dx Analyzer 2.0.

VAROVANIE/ | Nebezpeéenstvo poranenia oséb a materialnych $kod

UPOZORNENIE Pri zatvarani veka vstupného portu kazety budte opatrni, aby sa predislo zraneniu osbb, napr.

if} stlaCeniu prstov.

2.2. Bezpelnostné opatrenia pri preprave analyzatora QlAstat-Dx Analyzer 2.0

Nebezpeéenstvo poranenia osdb a materialnych skéd

VAROVANIE/
UPOZORNENIE | Analyzator QlAstat-Dx Analyzer 2.0 je tazky pristroj. Aby ste sa vyhli zraneniu alebo poskodeniu
analyzatora QlAstat-Dx Analyzer 2.0, davajte pozor pri jeho dvihani a pouzite vhodné metddy
{ f } dvihania.

2.3. Elektricka bezpecnost
Dodrzujte vSetky vSeobecné bezpecnostné opatrenia, ktoré sa vztahuju na elektrické pristroje.

Pred vykonavani servisu odpojte napajaci kébel z elektrickej zasuvky.

Elektrické nebezpecenstvo
Vnatri analyzatora QlAstat-Dx Analyzer 2.0 je smrtelne nebezpecné napatie. Neotvarajte kryt

analyzatora QlAstat-Dx Analyzer 2.0.

VAROVANIE Napajaci kabel musi byt zapojeny do sietovej napajacej zasuvky, ktora ma ochranny vodi¢ (vyvod
f Z uzemnenia).
Nedotykajte sa ziadnych spinacov ani napajacich kablov mokrymi rukami.

Nepouzivajte pristroj mimo Specifikovanych podmienok napéjania.

Pouzivatelska prirucka pre analyzator QlAstat-Dx Analyzer 2.0 09/2024 8



2.4.

Bezpecnostné informacie k elektromagnetickej kompatibilite (EMC)

A

VAROVANIE Nebezpeéenstvo straty Gidajov a materialu
Elektromagnetické rusenie mbdze spdsobit poruchu analyzatora QlAstat-Dx Analyzer 2.0, o mdze viest k
A strate udajov a/alebo strate vzorky.
VAROVANIE Nebezpeéenstvo straty Gidajov a materialu

Malo by sa zabranit pouzivaniu tohto pristroja v blizkosti inych zariadeni alebo uloZeného na nich, inak
moéze dojst’ k jeho nespravnemu fungovaniu. Ak je takéto pouzitie nevyhnutné, musia sa tento pristroj a

ostatné zariadenia sledovat s cielom overit ich spravne fungovanie.

VAROVANIE

A

Nebezpecenstvo straty udajov a materialu
Nepouzivajte iny ako napajaci kabel dodany s pristrojom. V pripade poskodenia alebo straty kontaktujte

servis spolo¢nosti QIAGEN, ktory zabezpeci vymenu.

Ostatné kable m6zu negativne ovplyvnit charakteristiky elektromagnetickej kompatibility pristroja.

VAROVANIE

A

Nebezpecenstvo elektromagnetickych emisii
Vdaka svojim emisnym charakteristikam je tento pristroj vhodny na pouzivanie v priemyselnom prostredi
a nemocniciach (CISPR 11, trieda A). Ak sa tento pristroj pouziva v obytnych priestoroch (pre ktoré sa
zvyc€ajne vyzaduje norma CISPR 11, trieda B), nemusi ponukat primeranu ochranu pre radiofrekvenéné
komunikaéné sluzby. Pouzivatel mozno bude musiet vykonat opatrenia na zmiernenie ucinkov, napriklad
premiestnit zariadenie alebo zmenit orientaciu zariadenia.

A

VAROVANIE Nebezpeéenstvo elektromagnetickych emisii
é Toto zariadenie nie je uréené na pouzivanie v obytnych priestoroch a nemusi v takomto prostredi
poskytovat primeranu ochranu pre prijem radiového signalu.
VAROVANIE Nebezpeéenstvo elektromagnetickej odolnosti

VAROVANIE: Nepouzivajte toto zariadenie v blizkosti zdrojov silného elektromagnetického Ziarenia

(napr. netienené ucelové RF zdroje), pretoze mozu rusit spravnu funkciu.

VAROVANIE

A

Nebezpecenstvo elektromagnetickej odolnosti
VAROVANIE: pred pouzitim tohto zariadenia by sa malo posudit elektromagnetické prostredie.

Pouzivatelska prirucka pre analyzator QlAstat-Dx Analyzer 2.0 09/2024 9




VAROVANIE

A

Nebezpecenstvo elektromagnetickej odolnosti
VAROVANIE: Prenosné RF komunika¢né zariadenia (vratane periférnych zariadeni, ako su anténne kable
a externé antény) by sa nemali pouzivat vo vzdialenosti menej ako 30 cm (12 palcov) od akejkolvek Casti
[ZARIADENIA ME alebo SYSTEMU ME] vratane kablov $pecifikovanych vyrobcom. Inak méze dojst k

zhorSeniu vykonu tohto zariadenia.

VAROVANIE

>

Nebezpecenstvo elektromagnetickej odolnosti
Podlahy musia byt drevené, betdénové alebo z keramickych dlazdic. Ak su podlahy pokryté syntetickym

materialom, musi byt relativna vihkost' minimalne 30 %.

VAROVANIE

>

Nebezpecenstvo elektromagnetickej odolnosti

Kvalita elektrickej siete musi dosahovat hodnoty bezného komeréného alebo nemocni¢ného prostredia.

VAROVANIE

>

Nebezpecenstvo elektromagnetickej odolnosti
Vedenia signalu (napr. ethernet) nesmu byt dihsie ako 30 m, aby sa predislo oslabeniu z dévodu razovych

napati.

VAROVANIE

>

Nebezpecenstvo elektromagnetickej odolnosti
Ak pouzivatel analyzatora QlAstat-Dx Analyzer 2.0 vyzaduje nepretrziti prevadzku pocas vypadkov
napajania z elektrickej siete, odporuc¢a sa, aby sa vyrobok napdjal zo zdroja neprerusovaného napajania

alebo batérie. UT je napatie elektrickej siete so striedavym prddom pred pouzitim testovacej trovne.

VAROVANIE

A

Nebezpecenstvo elektromagnetickej odolnosti
Magnetické polia sietového kmito&tu musia byt na urovniach, ktoré su typické pre bezné miesto v beznom

komer&nom alebo nemocni¢nom prostredi.

2.5.

Chemicka bezpecénost

Karty bezpe&nostnych tdajov (KBU) pre materialy kaziet st k dispozicii a mézete si ich vyZiadat od spolodnosti QIAGEN.

Pouzité testovacie kazety QlAstat-Dx sa musia likvidovat v sulade so vSetkymi narodnymi, Statnymi a miestnymi predpismi

a zakonmi o ochrane zdravia a bezpec¢nosti pri praci.
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Nebezpecéné chemikalie
VAROVANIE V pripade poSkodenia puzdra kazety mozu z kazety vytekat chemikalie. Niektoré chemikalie
i:} pouzivané v testovacich kazetach QIAstat-Dx mézu byt nebezpecné alebo sa mézu stat

nebezpecnymi. Vzdy pouzivajte ochranu oci, rukavice a laboratérny plast.

UPOZORNENIE Nebezpecéenstvo poskodenia analyzatora QlAstat-Dx Analyzer 2.0
Zabrarite rozliatiu chemikalii alebo inych kvapalin do alebo z analyzatora QlAstat-Dx Analyzer 2.0.
A Poskodenie sposobené rozliatim kvapaliny zrusi platnost zaruky.

2.6. Biologicka bezpecnost

Samotny analyzator QlAstat-Dx Analyzer 2.0 a kazety neobsahuju biologicky nebezpecné materialy. So vzorkami a
reagenciami obsahujucimi materidly z biologickych zdrojov by sa v8ak vo v8eobecnosti malo zaobchédzat' a likvidovat' ich
ako potencialne biologicky nebezpecné. Pouzivajte bezpecné laboratérne postupy, ako je uvedené v publikaciach, ako napr.
Biosafety in Microbiological and Biomedical Laboratories (Biologicka bezpecnost v mikrobiologickych a biomedicinskych
laboratériach) od inétitacii Centers for Disease Control and Prevention a National Institutes of Health
(www.cdc.gov/od/ohs/biosfty/biosfty.htm).

Vzorky testované na analyzatore QlAstat-Dx Analyzer 2.0 m6zu obsahovat infekéné latky. Pouzivatelia by si mali byt
vedomi zdravotnych rizik, ktoré takéto latky predstavuju, a mali by tieto vzorky pouzivat, skladovat’ a likvidovat v sulade s
pozadovanymi bezpecnostnymi predpismi. Pri manipulécii s reagenciami alebo vzorkami pouzivajte osobné ochranné

pomocky a jednorazové rukavice bez prasku, a potom si dokladne umyte ruky.

Zasadne dodrziavajte bezpecnostné opatrenia, ako je uvedené v prislusnych pokynoch, ako je napriklad Klinicky a
laboratorny inétitat pre normalizaciu Clinical and Laboratory Standards Institute® (CLSI) Protection of Laboratory Workers
from Occupationally Acquired Infections, Approved Guidelines (Ochrana pracovnikov laboratérii pred pracovnymi
infekciami; Schvalené usmernenie) (M29) alebo iné vhodné dokumenty poskytované:
e OSHA®: Occupational Safety and Health Administration (Urad pre bezpe&nost a ochranu zdravia pri praci)
(Spojené staty americké)
¢  ACGIH®: American Conference of Government Industrial Hygienists (Americka konferencia viadnych
priemyselnych hygienikov) (Spojené Staty americké)
e  COSHH: Control of Substances Hazardous to Health (Kontrola latok ohrozujucich zdravie) (Spojené kralovstvo)

Zabrarite kontaminacii analyzatora QlAstat-Dx Analyzer 2.0 a pracovného priestoru opatrnou manipulaciou so vzorkami a
testovacimi kazetami QlAstat-Dx. V pripade kontaminacie (napr. unik z kazety) vycistite a dekontaminujte postihnutu oblast

a analyzator QlAstat-Dx Analyzer (pozrite si Cast' 9).
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VAROVANIE

A

Biologické nebezpecenstvo
Pri vkladani alebo odstrafiovani testovacich kaziet QlAstat-Dx obsahujucich infekéné vzorky do
alebo z analyzatora QlAstat-Dx Analyzer 2.0 budte opatrni. V pripade poruSenia kazety by sa

mohol kontaminovat analyzator QlAstat-Dx Analyzer 2.0 a jeho okolie.

So vSetkymi testovacimi kazetami QlAstat-Dx sa musi zaobchadzat' tak, ako keby obsahovali
potencialne infekéné latky.

UPOZORNENIE

A

Nebezpecéenstvo kontaminacie
Kontaminaciu z porusenej alebo viditelne poSkodenej testovacej kazety

QlAstat-Dx okamzite zachytte a vyCistite. Obsah, hoci aj neinfekény, sa mdze Sirit’ pri normalne;j
aktivite a mdéze kontaminovat dalSie analytické vysledky, ¢o by viedlo k faloSne pozitivnym

vysledkom.

Pokyny na Cistenie a dekontaminaciu analyzatora QlAstat-Dx Analyzer 2.0 ngjdete v €asti 9.2 resp. 9.3.

2.7. Likvidacia odpadu

Pouzité testovacie kazety a plasty QlAstat-Dx mézu obsahovat nebezpecné chemikalie alebo infekéné latky. Takyto odpad

musi byt riadne zozbierany a zneSkodneny v sulade so vSetkymi narodnymi, Statnymi a miestnymi predpismi a zakonmi o

bezpecénosti a ochrane zdravia.

Informécie o odpade z elektrickych a elektronickych zariadeni (OEEZ) najdete v prilohe 11.4.

2.8. Symboly na analyzatore QlAstat-Dx Analyzer 2.0

Na pristroji QlAstat-Dx Analyzer 2.0 a/alebo testovacich kazetach QlAstat-Dx su uvedené nasledujuce symboly.

Symbol

Umiestnenie Popis

C€
&

o[ JRI B
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Typovy Stitok na zadnej strane pristroja Znacka CE pre Eurépu

Typovy $titok na zadnej strane pristroja Znacka TUV od spoloénosti TUV SUD Product
Service pre testovanie
Typovy stitok na zadnej strane pristroja UPOZORNENIE

Nebezpecenstvo — riziko poranenia oséb a
materialnych skéd

Typovy 8titok na zadnej strane pristroja Znacka OEEZ pre Eurépu

Typovy Stitok na zadnej strane pristroja Vyrobca

Typovy 8titok na zadnej strane pristroja Diagnosticka zdravotnicka pomécka na pouZitie
v podmienkach in vitro

Typovy stitok na zadnej strane pristroja Kataldgové Cislo

Typovy 8titok na zadnej strane pristroja Sériové Cislo




Symbol

Umiestnenie

Popis

uUDI

al
]

www.giagen.com
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Typovy §titok na zadnej strane pristroja

Typovy Stitok na zadnej strane pristroja

Vonkajsia Skatula

Unikatny identifikator pomocky
Datum vyroby

Navod na pouzivanie je k dispozicii na adrese
www.giagen.com


http://www.qiagen.com/

2.9. Bezpecnost udajov

Poznamka: Dérazne odporu¢ame vykonavat pravidelné zalohy systémy podla zasad vaSej spoloCnosti, aby boli udaje
dostupné a chranené pred stratou.

Analyzator QlAstat-Dx Analyzer 2.0 sa dodava s Uloznym USB zariadenim, ktoré by sa malo, pokial mozno, pouzivat na
kratkodobé uloZenie udajov a vSeobecny prenos udajov (napr. vysledky uloZenia, vytvorenie zalohy systému a archivu,
aktualizacie systému alebo importy suborov definicie testu). Dérazne odporu€ame pouzit na trvalé ulozenie udajov iné

umiestnenie.

Poznamka: Pouzivanie ulozného zariadenia USB nepodlieha Ziadnym obmedzeniam (napr. kapacita paméate alebo riziko

prepisania), ktoré by sa malo pred pouzitim zvazit.

Na dlhodobé zaistenie bezpecnosti udajov postupujte podla zasad pre ukladanie udajov a bezpe€nostnych zasad vasej
spolo¢nosti pre zachovanie opravnenia.

2.10. Kyberneticka bezpecnost

Pri pouzivani analyzatora QlAstat-Dx Analyzer 2.0 dérazne odporu¢ame dodrziavat odporucania kybernetickej bezpe€nosti
uvedené nizSie:

e Analyzator QlAstat-Dx Analyzer 2.0 pouzivajte v bezpe€nom prostredi a v zabezpecenej sieti.

e V pripade aktualizacie systému vzdy pred inStalaciou porovnajte kontrolny sucet aktualizaného balika s
kontrolnym suc¢tom uvedenym na webovej adrese (www.qiagen.com).

o Neodchadzajte od pristroja, kym prebieha aktualizacia a zalohovanie systému a obnova a vytvaranie archivu,
pretoZe je pogas tychto procesov zapnuté funkcia automatického vypnutia. DalSie informacie o automatickom
odhlaseni najdete v Casti 6.7.4.

o Neustale (idaje zalohujte a zalohované subory uloZte na zabezped&ené, idedlne offline tloZisko. Dalsie informacie
o zalohovani najdete v Casti 6.7.12.

e  Vzdy pouzivajte USB ulozny priestor bez malvéru.

e Pouzivajte rezim Multi-User (Viac pouzivatelov) analyzatora QlAstat-Dx Analyzer 2.0. Dal$ie informéacie o Sprava
pouzivatelov najdete v Casti 6.5.

Dalsie informacie o sprave pouzivatelov najdete v &asti 6.5.

e Dodrziavajte zasady vasej organizacie tykajuce sa nastavenia zlozitych hesiel a frekvencie ich zmeny.

e Ked analyzator QlAstat-Dx Analyzer 2.0 nechate bez dohladu, vZzdy sa odhlaste. Dal$ie informécie o odhlaseni
najdete v Casti 6.2.1.

e Nepouzivajte volne editovatelné polia na zadavanie osobnych udajov umoznujucich identifikaciu (PIl) alebo
chranenych zdravotnych informacii (PHI). Patria sem polia, ako su napriklad polia pre ID vzorky, ID pacienta a
komentare k vysledkom.

e Zistené udalosti tykajuce sa kybernetickej bezpenosti sa zaznamenavaju do systémového dennika (pozri
Cast 6.7.8).
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e Ak mate podozrenie, Ze zabezpecenie vasho analyzatora QlAstat-Dx Analyzer 2.0 mohlo byt narusené, okamzite
informujte svoje oddelenie IT alebo kybernetickej bezpe€nosti a postupujte podla miestnych pokynov. Pokyny sa
moézu znacne lisit v zavislosti od miestnych priorit a mézu zahffat odpojenie zariadenia od siete, vypnutie
zariadenia alebo ponechanie zariadenia nedotknutého a privolanie miestneho reakéného timu, aby ho
preskumal. Okrem toho €o najskoér informujte svojho zastupcu technickej sluzby QIAGEN, aby vam poskytol
dalSie pokyny a podporu.

Zaplaty pre analyzator QlAstat-Dx Analyzer 1.0 su sucastou pravidelnej aktualizacie systému. Obsahuju aktualizacie a
napravu zranitelnosti aplikacného softvéru a zakladného opera¢ného systému. Tieto aktualizacie podliehaju zavedenému
procesu overovania a validacie podla globalneho systému riadenia kvality QIAGEN.

Zakaznici su informovani, ked su k dispozicii aktualizacie vratane zaplat na zaistenie kybernetickej bezpeénosti. Zakaznici
moézu proaktivne ziskavat aktualizacie zo stranky www.qiagen.com alebo kontaktovat technicku sluzbu QIAGEN a
poziadat ju o dalSiu podporu.

Priru¢ka k bezpecnosti a ochrane osobnych Udajov analyzatora QIAstat-Dx Analyzer 2.0 vam pomdze bezpecne
nainstalovat, konfigurovat, prevadzkovat’ a udrziavat vas pristroj v sulade s nariadeniami na ochranu udajov. Priruc¢ka k
bezpecnosti a ochrane osobnych tdajov analyzatora QIAstat-Dx Analyzer 2.0 je dostupna na adrese giagen.com/QlAstat-
Dx.
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3. VSeobecny popis
3.1. Popis systému

Analyzator QlAstat-Dx Analyzer 2.0 v kombinacii s testovacimi kazetami QlAstat-Dx vyuZziva real-time PCR na detekciu
nukleovych kyselin patogénov v ludskych biologickych vzorkach. Analyzator QlAstat-Dx Analyzer 2.0 a kazety su navrhnuté
ako uzavrety systém, ktory umozriuje pripravu vzorky bez kontaktu ruk s naslednou detekciou a identifikaciou nukleovych
kyselin patogénov. Vzorky sa vkladaju do testovacej kazety QlAstat-Dx, ktora obsahuje vSetky reagencie potrebné na
izolaciu a amplifikaciu nukleovych kyselin zo vzorky. Detegované amplifikaéné signaly v realnom Case su interpretované

prostrednictvom integrovaného softvéru a su hlasené prostrednictvom intuitivneho pouzivatel'ského rozhrania.

3.2. Popis analyzatora QlAstat-Dx Analyzer 2.0

Analyzator QlAstat-Dx Analyzer 2.0 sa sklada z operacného modulu a 1 alebo viacerych (az 4) analytickych modulov.
Operacny modul obsahuje prvky, ktoré umoznuju pripojenie k analytickému modulu a umozriuje interakciu pouzivatela s

analyzatorom QIAstat-Dx Analyzer 2.0. Analyticky modul obsahuje hardvér a softvér na testovanie a analyzu vzoriek.

Analyzator QlAstat-Dx Analyzer 2.0 obsahuje nasledujuce prvky:
e Dotykova obrazovka pre interakciu pouzivatela s analyzatorom QlAstat-Dx Analyzer 2.0
o Citatka giarovych kédov na identifikaciu vzorky, pacienta, pouzivatela a testovacej kazety QlAstat-Dx
e Porty USB na aktualizaciu testov a systému, export dokumentov a pripojenie tlaciarne (jeden vpredu, tri vzadu)
e Vstupny port kazety na vkladanie testovacich kaziet QlAstat-Dx do analyzatora QlAstat-Dx Analyzer 2.0

o Ethernetovy konektor pre sietové pripojenie
Obrazok 1 a obrazok 2 znazorruju umiestnenie réznych funkcii analyzatora QlAstat-Dx Analyzer 2.0.

Operaény modul Analyticky

modul
Vstupny port kazety o
I 1N Ochranny kryt

Dotykova

obrazovka -

i ! (l Ochranny kryt
Indikator stavu operaéného ) g S
Indikator stavu analytického modulu “_Zasuvka vzduchového filtra

Obrazok 1. Pohlad na analyzator QlAstat-Dx Analyzer 2.0 spredu. Opera¢ny modul je vlavo a analyticky modul je vpravo.
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Vstupny port kazety

Analyticky modul

Vetracie_ otvory.

Vypina¢ napdjania

Ukonéovaci most

N
Operacény modul

=3

Napajaci
konektor

\ USB porty (x3)

Ethernetovy konektor

Most analytického/operaéného modulu

Obrazok 2. Pohl'ad na analyzator QlAstat-Dx Analyzer 2.0 zozadu. Opera¢ny modul je vpravo a analyticky modul je viavo.

3.3. Popis testovacej kazety QlAstat-Dx

Testovacia kazeta QlAstat-Dx je jednorazové plastové zariadenie, ktoré umoznuje vykonavanie plne automatizovanych
molekularnych testov. Medzi hlavné vlastnosti testovacej kazety QlAstat-Dx patri kompatibilita s r6znymi typmi vzoriek
(napr. tekutiny, tampdny), hermetickym uzavretim vSetkych vopred naplnenych reagencii potrebnych na testovanie a

prevadzkou bez dozoru. VSetky kroky poc€as pripravy vzoriek a testovania sa vykonavaju v testovacej kazete QlAstat-Dx.

VSetky reagencie potrebné na Uplné vykonanie testovacieho cyklu su vopred naplnené a obsiahnuté v testovacej kazete
QlAstat-Dx. Pouzivatel nemusi prist do styku so ziadnymi reagenciami resp. s nimi manipulovat. PocCas testu sa s
reagenciami manipuluje v analytickom module pomocou pneumaticky ovladanych mikrofluidik a neprichadzaju do priameho
kontaktu s ovladami analyzatora QlAstat-Dx Analyzer 2.0. Analyzator QlAstat-Dx Analyzer 2.0 obsahuje vzduchové filtre
pre privadzany aj odvadzany vzduch, ¢im chrani zivotné prostredie. Po testovani zostava testovacia kazeta QlAstat-Dx

hermeticky uzavreta, ¢im sa vyrazne zvySuje bezpecnost jej likvidacie.

V ramci testovacej kazety QlAstat-Dx sa automaticky vykonava niekolko krokov pouzitim pneumatického tlaku na prenos
vzoriek a tekutin cez prenosovu komoru do prislusnych miest urenia. Po zavedeni testovacej kazety QlAstat-Dx do
analyzatora QlAstat-Dx Analyzer 2.0 sa automaticky vykonaju nasledujuce kroky:

¢ Resuspendovanie internej kontroly

e Rozklad bunky pouzitim mechanickych resp. chemickych prostriedkov

e Membranova purifikacia nukleovej kyseliny

e ZmieSanie purifikovanej nukleovej kyseliny s lyofilizovanymi reagenciami prvotnej zmesi

e  Prenos urenych alikvotnych Casti eluatu/prvotnej zmesi do jednotlivych reakénych komér

e Vykonanie multiplexného testovania PCR v realnom ¢ase v ramci kazdej reakénej komory. ZvySena

fluorescencia na indikaciu pritomnost cielového analytu, sa deteguje priamo v kazdej reakénej komore.

VSeobecné usporiadanie kazety a jej vlastnosti si znazornené na obrazku 3.
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Hlavny port

Tamponovt

& O
A g

Reakéné komory

Obrazok 3. Vlastnosti testovacej kazety QlAstat-Dx.

3.4. Softvér analyzatora QlAstat-Dx Analyzer
Softvér (SW) analyzatora QlAstat-Dx Analyzer je v systéme vopred nainstalovany. Implementuje tri hlavné skupiny funkcii:

e Bezné prevadzkové funkcie umoznuju jednoduché nastavenie, vykonanie a vizualizaciu testu a jeho pridruzenych
vysledkov.

e  Funkcie konfiguracie umoznuju konfiguraciu systému (sprava pouzivatelov, sprava testov a sprava konfiguracie
hardvéru/softvéru).

e Riadenie realizacie testu na vykonanie potrebnych automatizovanych analytickych krokov

Pouzivatel'ska prirucka pre analyzator QlAstat-Dx Analyzer 2.0 09/2024 18



4. Postupy inStalacie

4.1. Poziadavky na pracovisko

Pre analyzator QlAstat-Dx Analyzer 2.0 vyberte rovny, suchy a Cisty pracovny priestor. Zabezpecte, aby bol priestor bez
priliSného prievanu, vihkosti a prachu, ako aj chraneny pred priamym sine€nym Ziarenim, velkymi vykyvmi teploty, zdrojmi
tepla, vibraciami a elektrickym rusenim. Pozrite si ¢ast' 11, kde su uvedené Udaje tykajuce sa hmotnosti a rozmery analyzatora
QlAstat-Dx Analyzer 2.0 a spravne prevadzkové podmienky (teplota a vlhkost). Analyzator QlAstat-Dx Analyzer 2.0 by mal
mat dostato¢nu volnost na vSetkych stranach, aby sa umoznilo spravne vetranie a aby sa umoznil neruSeny pristup k
vstupnému portu kazety, zadnej Casti analyzatora QlAstat-Dx Analyzer 2.0, k vypinacu, tlacidlu ON/OFF (Zap./Vyp.), Citacke

Ciarovych kédov a dotykovému displeju.

Poznamka: Pred inStaldciou a pouzitim analyzatora QlAstat-Dx Analyzer 2.0 si pozrite ¢ast 11 a obozndmte sa s

prevadzkovymi podmienkami analyzatora QlAstat-Dx Analyzer 2.0.

Nedostato¢na ventilacia
UPOZORNENIE Na zaistenie spravnej ventilacie dodrziavajte minimalnu volnu vzdialenost 10 cm v zadnej Casti
: analyzatora QlAstat-Dx Analyzer 2.0. a neblokujte pridenie vzduchu pod jednotkou.

Strbiny a otvory, ktoré zabezpe&uju vetranie pristroja, nesmu byt zakryté.

Elektromagnetické rusenie
UPOZORNENIE Neumiestriujte ani nepouzivajte analyzator QlAstat-Dx Analyzer 2.0 v tesnej blizkosti zdrojov
é silného elektromagnetického Ziarenia (napr. netienené ucelové RF zdroje), pretoze mézu rusit

spravnu funkciu.

4.2. Dodavka a komponenty analyzatora QlAstat-Dx Analyzer 2.0

Analyzator QlAstat-Dx Analyzer 2.0 sa dodava v dvoch samostatnych Skatuliach a obsahuje vSetky potrebné komponenty

pre nastavenie a prevadzku systému. Obsah Skatul je popisany niZSie:

Obsah Skatule 1:

Komponent Popis

‘ : | 1x analyticky modul
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Komponent

Popis

SAN

1x pamat'ové zariadenie USB

1x napajaci kabel

1x most analytického/analytického modulu

1x ukonéovaci most

1x nastroj na montaz analytického-operaéného modulu

1x semiSova tkanina na obrazovku

1x nastroj na odstranenie ochranného krytu

Obsah Skatule 2:

Komponent

Popis

1x operacny modul

1x most analytického/opera¢ného modulu
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4.3. Vybalenie a instalacia analyzatora QlAstat-Dx Analyzer 2.0
Analyzator QlAstat-Dx Analyzer 2.0. opatrne rozbalte podla nasledujucich krokov:

1. Vyberte analyticky modul zo $katule a polozte ho na rovny povrch. Odstrarte kisky peny pripojené k analytickému
modulu.

Poznamka: Analyticky modul sa musi zdvihnat' a musi sa s nim manipulovat tak, Ze sa odoberie zo zakladne dvoma
rukami, ako je znazornené na obrazku 4.

VAROVANIE/ Nebezpecenstvo poranenia oséb a materialnych skéd

UPOZORNENIE | Analyzator QlAstat-Dx Analyzer 2.0 je tazky pristroj. Aby ste sa vyhli zraneniu alebo poSkodeniu

analyzatora QlAstat-Dx Analyzer 2.0, davajte pozor pri jeho dvihani a pouZite vhodné metédy
{ j 5 dvihania.

Obrazok 4. Spravna manipulacia s analytickym modulom.

2. Odstrante ochranné kryty z bo€nej strany analytického modulu pomocou nastroja na odstranenie ochranného krytu
dodavaného s analyzatorom QIAstat-Dx Analyzer 2.0 (obrazok 5).

Obrazok 5. Odstranenie ochrannych krytov.
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3. Vyberte opera¢ny modul zo Skatule a pripojte ho na lavu stranu analytického modulu. Utiahnite skrutky pomocou

nastroja na montaz analytického-opera¢ného modulu dodaného s analyzatorom QIAstat-Dx Analyzer 2.0 (obrazok 6).

UPOZORNENIE

Riziko mechanického poskodenia
Operacny modul nenechavajte bez podpory alebo polozeny na dotykovej obrazovke, pretoze by

sa tym mohla poskodit’ dotykova obrazovka.

Obrazok 6. Pripojenie operaéného modulu k analytickému modulu.

4. Nasadte ochranné kryty na bo¢nu stranu analytického modulu (obrazok 7).

Obrazok 7. Znova nasad'te ochranné kryty.
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5. Prepojte most analytického/operaéného modulu na zadnu stranu analyzatora QlAstat-Dx Analyzer 2.0 na vzajomné

prepojenie opera¢ného a analytického modulu (obrazok 8).

Obrazok 8. Pripojenie mosta analytického/operaéného modulu.

6. Pripojte ukonCovaci most na zadnu stranu analytického modulu (obrazok 9).

Obrazok 9. Pripojenie ukonéovacieho mosta.
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7. Pripojte napajaci kabel dodany s analyzatorom QlAstat-Dx Analyzer 2.0 k zadnej strane analytického modulu
(obrazok 10).

Obrazok 10. Pripojenie napajacieho kabla.

8. Pripojte napajaci kabel do elektrickej zasuvky.

9. Zapnite pristroj stlacenim vypinaca napajania na zadnej strane analytického modulu do polohy , I (obrazok 11). Uistite
sa, ze su stavové indikatory analytickych a operaénych modulov modré.

Poznamka: Ak je stavovy indikator €erveny, doslo k poruche v analytickom module. Poziadajte o pomoc technicky
servis spolocnosti QIAGEN pomocou kontaktnych informacii uvedenych v ¢asti 10.

Poznamka: Pristroj nesmie byt umiestneny tak, aby bolo ovladanie vypina€a napdjania tazkeé.

Obrazok 11. Umiestnenie vypinac¢a napajania a jeho nastavenie do polohy ,I*.

10. Analyzator QlAstat-Dx Analyzer 2.0 je teraz pripraveny na konfiguraciu na uréeny ucel pouZitia. Pozrite si €ast 6.7, v

ktorej su uvedené informacie o konfiguracii systémovych parametrov, nastaveni systémového ¢asu a datumu a
konfiguracii sietového pripojenia.
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4.4. InStalacia pridavnych analytickych modulov

Opatrne rozbalte pridavny analyticky modul a nainstalujte ho podla nasledujucich krokov:

1. Pripravte analyzator QlAstat-Dx Analyzer 2.0 na inStalaciu nového modulu:
1a. Vypnite systém stlacenim tlacidla ON/OFF (Zap./Vyp.) na prednej strane analyzatora QlAstat-Dx Analyzer 2.0.

1b. Vypnite pristroj stlatenim vypinaca napajania na zadnej strane analytického modulu do polohy , 0.
1c. Odstrante napéjaci kabel.

1d. Demontujte ukon€ovaci most zo zadnej strany analytického modulu (obrazok 12).

Obrazok 12. Odstranenie ukonéovacieho mosta.

1e. Odstrante ochranné kryty z bo¢nej strany analytického modulu, kde sa pripoji pridavny analyticky modul
(obrazok 13).

Obrazok 13. Odstranenie ochrannych krytov.

2. Vyberte pridavny analyticky modul zo Skatule a polozte ho na rovny povrch. Odstrante kusky peny pripojené k
analytickému modulu.
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Poznamka: Analyticky modul sa musi zdvihnat' a musi sa s nim manipulovat tak, Ze sa odoberie zo zakladne dvoma

rukami, ako je znazornené na obrazku 14.

VAROVANIE/
UPOZORNENIE

Nebezpecéenstvo poranenia os6b a materialnych skéd

Analyzator QlAstat-Dx Analyzer 2.0 je tazky pristroj. Aby ste sa vyhli zraneniu alebo poSkodeniu
analyzatora QlAstat-Dx Analyzer 2.0, davajte pozor pri jeho dvihani a pouzite vhodné metédy

dvihania.

Obrazok 14. Spravna manipulacia s analytickym modulom.

3. Odstrarite ochranné kryty z bo¢nej strany analytického modulu pomocou nastroja na odstranenie ochranného krytu
dodavaného s analyzatorom QIAstat-Dx Analyzer 2.0 (obrazok 15).

Qlyys,
et -a"a‘[]a
. s

Obrazok 15. Odstranenie ochrannych krytov.
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4. Zarovnajte pridavny analyticky modul s existujucim analytickym modulom. Utiahnite skrutky pomocou nastroja na
montaz analytického-operaéného modulu dodaného s analyzatorom QlAstat-Dx Analyzer 2.0 (obrazok 16).

Obrazok 16. Zarovnanie a pripojenie dodato¢ného analytického modulu.

5. Znova nasadte ochranné kryty na bo¢nu stranu analytického modulu (obrazok 17).

Obrazok 17. Opatovné nasadenie ochrannych krytov na pridavny analyticky modul.
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6. Pripojte mostik analytického/analytického modulu na zadnu stranu QlAstat-Dx Analyzer 2.0. a spojte obidva analytické
moduly dohromady (obrazok 18).

Obrazok 18. Pripojenie mosta analytického/analytického modulu.

7. Pripojte ukon€ovaci most na zadnu stranu analytického modulu (obrazok 19).

Obrazok 19. Pripojenie ukon€ovacieho mosta.
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8. Pripojte napajaci kabel dodany s analyzatorom QlAstat-Dx Analyzer 2.0 k zadnej strane pévodného analytického
modulu (obrazok 20).

™

Obrazok 20. Pripojenie napajacieho kabla.

9. Pripojte napajaci kabel do elektrickej zasuvky.

10. Zapnite pristroj stlacenim vypina€a napajania na zadnej strane analytického modulu do polohy ,|“ (obrédzok 21). Uistite
sa, Ze su stavové indikatory analytickych a operacnych modulov modré.

Poznamka: Ak je stavovy indikator €erveny, doslo k poruche v analytickom module. Poziadajte o pomoc technicky
servis spolocnosti QIAGEN pomocou kontaktnych informacii uvedenych v ¢asti 10.

Poznamka: Pristroj nesmie byt umiestneny tak, aby bolo ovladanie vypina€a napdjania tazkeé.

Obrazok 21. Umiestnenie vypina¢a napajania a jeho nastavenie do polohy ,,I“.

11. Analyzator QlAstat-Dx Analyzer 2.0 je teraz pripraveny na konfiguraciu na ur€eny ucel pouzitia. Pozrite si Cast 6.7, v

ktorej su uvedené informacie o konfiguracii systémovych parametrov, nastaveni systémového ¢asu a datumu a
konfiguracii sietového pripojenia.
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4.5. Opatovné zabalenie a odoslanie analyzatora QlAstat-Dx Analyzer 2.0

Pri opatovnom baleni analyzatora QlAstat-Dx Analyzer 2.0 na odoslanie je nutné pouzit pévodny obalovy material. Ak nie

su k dispozicii pévodné obalové materialy, obratte sa na technicky servis spolo¢nosti QIAGEN. Pred balenim skontrolujte,

¢i bol pristroj spravne pripraveny (pozrite si ¢ast' 9.2) a ¢i nepredstavuje Ziadne biologické alebo chemické nebezpecéenstvo.

Opatovné zabalenie pristroja:

1.

]

Uistite sa, ze je pristroj vypnuty (stlacte vypina¢ napajania do polohy ,0%).

. Odpojte napajaci kabel z elektrickej zasuvky.
. Odpojte napéjaci kabel zo zadnej strany analytického modulu.

2
3
4.
5

Odpojte ukonéovaci most zo zadnej strany analytického modulu.

. Odpojte most analytického/operacného modulu prepajajuci operacny a analyticky modul na zadnej strane analyzatora

QlAstat-Dx Analyzer 2.0.

. Odstrarite ochranné kryty z bo¢nej strany analytického modulu pomocou nastroja na odstranenie ochranného krytu.

. Pomocou nastroja na montéaz analytického-operacného modulu uvornite dve skrutky, ktoré upevriuju operaény modul k

analytickému modulu. Zabalte operacny modul do Skatule.

. Znova nasadte ochranné kryty na bo¢nu stranu analytického modulu. Zabalte analyticky modul s prislusnymi kiiskami

peny do Skatule.
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5. Spustenie testu a zobrazenie vysledkov

Poznamka: Obrazky uvedené v tejto pouzivatelskej prirucke su iba prikladmi a mézu sa liSit v zavislosti od testu.

5.1. Spustenie analyzatora QlAstat-Dx Analyzer 2.0

1. Stlacenim tlacidla ON/OFF (Zap./Vyp.) na prednej strane analyzatora QlAstat-Dx Analyzer 2.0 spustite jednotku
(obrazok 22).
Poznamka: Vypina¢ napajania na zadnej strane analytického modulu musi byt nastaveny do polohy ,I*. Indikatory

opera¢ného a analytického modulu sa v polohe I (tzn. zapnuté) rozsvietia namodro.

Obrazok 22. Stlacenim tlac¢idla ON/OFF (Zap./Vyp.) spustite pristroj.

2. Pockajte, kym sa zobrazi obrazovka Main (Hlavna obrazovka) a indikatory stavu analytického a operacného modulu
sa rozsvietia nazeleno a prestanu blikat.
Poznamka: Po instalacii sa zobrazi obrazovka Login (Prihlasenie). Dal$ie podrobnosti najdete v &asti 6.2.
Poznamka: Po Uspesnej prvej inStalacii analyzatora QlAstat-Dx Analyzer 2.0 sa musi spravca systému prihlasit a
softvér prvykrat nakonfigurovat. Pri prvom prihlaseni je ID pouzivatela ,administrator” a predvolené heslo je
»=administrator®. Po prvom prihlaseni sa musi heslo zmenit. Automaticky sa aktivuje User Access Control (Kontrola
pristupu pouzivatelov). Dérazne odporu¢ame vytvorit minimalne jeden pouzivatel'sky ucet bez role ,Administrator*

(Spravca).

5.2. Priprava testovacej kazety QlAstat-Dx

Vyberte testovaciu kazetu QlAstat-Dx z obalu. Podrobnosti o pridavani vzorky do testovacej kazety QlAstat-Dx a informacie
Specifické pre test, ktory sa ma vykonat, (napriklad ¢as stability vzorky po vlozeni do kazety) najdete v navode na pouzitie
konkrétneho testu (napr. QlAstat-Dx Respiratory Panel). Po pridani vzorky do testovacej kazety QlAstat-Dx sa vzdy uistite,

Ze obidve viecka na vzorky su pevne zatvorené.
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5.3. Postup na vykonanie testu

Pri stlaCani dotykového displeja analyzatora QlAstat-Dx Analyzer 2.0 by mali vSetci operatori pouzivat vhodné osobné
ochranné prostriedky, ako su rukavice.

1. Stlacte tlacidlo ° Run Test (Spustit' test) v pravom hornom rohu obrazovky Main (Hlavna obrazovka).

Poznamka: Ak je aktivovana externa kontrola (EK) a test EK sa ma ¢oskoro vykonat, zobrazi sa pripomienka na
spustenie testu so vzorkou EK. Dal$ie podrobnosti najdete v &asti 8.

Poznamka: Ak je EK aktivovana a posledny test EK vykonany pomocou vybraného modulu sa nepodaril, zobrazi sa
varovanie. Pouzivatelia si musia jasne vybrat, ¢i chcu napriek tomu test vykonat s vybranym modulom.

2. Po zobrazeni vyzvy naskenujte Ciarovy kéd s ID vzorky pomocou ¢itacky Ciarovych kédov integrovanej v operaénom
module (obrazok 23).
Poznamka: V zavislosti od konfiguracie analyzatora QlAstat-Dx Analyzer 2.0 méze byt tiezZ mozné zadat ID vzorky
pomocou virtualnej klavesnice na dotykovej obrazovke. Dal$ie podrobnosti najdete v asti 6.7.4.
Poznamka: V zavislosti od vybranej konfiguracie systému sa v tomto bode méze vyzadovat zadanie ID pacienta.
Dalsie podrobnosti najdete v &asti 6.7.4.

Poznamka: V zavislosti od konfiguracie EK sa zobrazi tlacidlo Test EK. Toto tlacidlo zostane vo vypnutej polohe

podas testovacieho cyklu. Dal$ie informacie o konfiguracii EK najdete v &asti 8.

administrator Run Test Module 1 12:59 2023-02-20

’I Ul administrator

TEST DATA

Sample ID

Assay Type

Sample Type

Cancel

Scan or type Sample ID

Obrazok 23. Skenovanie ¢iarového kédu s ID vzorky.

3. Po zobrazeni vyzvy naskenuijte Ciarovy kod testovacej kazety QlAstat-Dx, ktora sa méa pouzit. Analyzator QlAstat-Dx
Analyzer 2.0 automaticky rozpozna test, ktory sa ma spustit, na zaklade Ciarového kddu testovacej kazety QlAstat-Dx
(obrazok 24).

Poznamka: Analyzator QlAstat-Dx Analyzer 2.0 neprijima testovacie kazety QlAstat-Dx s uplynutymi datumami
exspiracie, predtym pouzivanymi kazetami alebo kazetami pre testy, ktoré nie su nainstalované v jednotke. V tychto
pripadoch sa zobrazi chybové hlasenie. Dalsie podrobnosti najdete v asti 10.2.

Poznamka: Pozrite si ¢ast 6.6.3, kde najdete pokyny na importovanie a pridanie testov do analyzatora QlAstat-Dx
Analyzer 2.0.
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Poznamka: Pouzite Ciarovy kéd na bo¢nej strane kazety (ako je znazornené na obrazku 24) a nie Ciarovy kod na
obale kaziet.

Poznamka: Ak je externa kontrola (EK) aktivovana a test EK sa ma €oskoro spustit’ alebo sa predchadzajuci vybrany
test na zvolenom module nepodaril, zobrazi sa varovanie. Pouzivatelia musia potvrdit, ¢i chcu pokracovat a zakladni
pouZivatelia nemoézu pokradovat s nastavenim testu. Dal$ie podrobnosti najdete v &asti 8.

administrator Run Test Module 1 12:59 2023-02-20

'] Ul administrator

TEST DATA

Sample ID

52859357 v

Assay Type

Sample Type

Cancel
Scan Cartridge Barcode

Obrazok 24. Skenovanie ¢iarového kédu testovacej kazety QlAstat-Dx.
4. V pripade potreby vyberte prislusny typ vzorky zo zoznamu (obrazok 25).

Poznamka: V niektorych zriedkavych pripadoch moze byt zoznam typov vzoriek prazdny. V takomto pripade sa
kazeta musi naskenovat znova.

administrator Run Test Module 1 12:59 2023-02-20

'I Ul administrator
RP

TEST DATA SAMPLE TYPE
Sample ID
52859357 v Swab
Assay Type UTM
RP v
Sample Type
Cancel
Select Sample Type

Obrazok 25. Vyber typu vzorky.
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5. Zobrazi sa obrazovka Confirm (Potvrdit). Skontrolujte zadané Udaje a vykonajte potrebné zmeny stlacenim
prislusnych poli na dotykovej obrazovke a Upravou informacii (obrazok 26).

administrator Run Test Module 1 13:00 2023-02-20

‘I Ul administrator
RP

TEST DATA

Sample ID
52859357 v

Assay Type
RP v

Sample Type
Swab v

Cancel

Module 1 | Confirm TEST DATA or click any field to edit

Obrazok 26. Obrazovka Potvrdit.

6. Ked st vetky zobrazené tidaje spravne, stladte tladidlo ‘@ Confirm (Potvrdit). Ak je to potrebné, stladenim
prislusného pola upravte jeho obsah, alebo stlacenim tladidla Cancel (Zrusit) zruste test.

7. Uistite sa, zZe obidve veka vzoriek v tampdnovom porte a hlavnom porte testovacej kazety QlAstat-Dx su pevne
zatvorené. Ked sa automaticky otvori vstupny port kazety vo vrchnej Casti analyzatora QlAstat-Dx Analyzer 2.0, vlozZte
testovaciu kazetu QlAstat-Dx tak, aby Ciarovy kod smeroval dolava a aby reakéné komory smerovali nadol
(obrazok 27).

Poznamka: Ked su k operaénému modulu pripojené viaceré analytické moduly, analyzator QlAstat-Dx Analyzer 2.0
automaticky vyberie analyticky modul, v ktorom sa ma test spustit.

Poznamka: Nie je potrebné zatlacit testovaciu kazetu QlAstat-Dx do analyzatora QlAstat-Dx Analyzer 2.0. Umiestnite
ho spravne do vstupného portu kazety a analyzator QlAstat-Dx Analyzer 2.0 automaticky presunie kazetu do
analytického modulu.

administrator Run Test Module 1 13:00 2023-02-20

F

'I Ul administrator
RP

TEST DATA

Sample ID

52859357

Assay Type
RP

Sample Type
Swab

Cancel
Module 1 | Insert Cartridge with S/N 180004016

Obrazok 27. Vlozenie testovacej kazety QlAstat-Dx do analyzatora QlAstat-Dx Analyzer 2.0.
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8. Po detegovani testovacej kazety QlAstat-Dx zariadenie QlAstat-Dx Analyzer 2.0 automaticky zatvori veko vstupného
portu kazety a spusti testovaci cyklus. Na spustenie cyklu sa nevyzaduje ziadna dalSia ¢innost’ obsluhy.

Poznamka: Analyzator QlAstat-Dx Analyzer 2.0 neakceptuje inu testovaciu kazetu QlAstat-Dx ako kazetu, ktora bola
pouzita a naskenovana pocas nastavenia testu. Ak je vlozena ina kazeta, nez je naskenovana kazeta, vygeneruje sa
chyba a kazeta sa automaticky vysunie.

Poznamka: AZ do tohto bodu je mozné test zrudit’ stlacenim tlaCidla Cancel (Zrusit) v pravom dolnom rohu obrazovky.
Poznamka: V zavislosti od konfiguracie systému méze byt obsluha poziadana o opatovné zadanie hesla pre
spustenie testu.

Poznamka: Veko vstupného portu kazety sa automaticky uzavrie po 30 sekundach, ak testovacia kazeta QlAstat-Dx
nie je umiestnena v porte. Ak k tomu déjde, zopakujte postup po€nuc krokom 5.

9. Pocas testovacieho cyklu sa na dotykovej obrazovke zobrazi zostavajuci ¢as cyklu (obrazok 28).

administrator Run Test Module 1 13:00 2023-02-20

F

1 Ul administrator
RP

TEST DATA

Sample ID
52859357

Assay Type
RP

Sample Type
Swab

Cancel

Module 1 | Checking Cartridge 10%

Obrazok 28. Vykonanie testu a zobrazenie zostavajuceho ¢asu cyklu.

10. Po dokoné&eni testovacieho cyklu sa zobrazi obrazovka Eject (Vysunut) (obrazok 29).

Stlacte @ Eject (Vysunut) na dotykovej obrazovke, vysurite testovaciu kazetu QlAstat-Dx a odstrante ju ako
biologicky nebezpecny odpad v sulade so vSetkymi narodnymi, Statnymi a miestnymi predpismi a zakonmi o ochrane
zdravia a bezpecnosti pri praci.

Poznamka: Testovacia kazeta QlAstat-Dx by sa mala odstranit, ked sa otvori vstupny port kazety a ked' sa vysunie
kazeta. Ak sa kazeta po 30 sekundach neodoberie, automaticky sa vrati spat do analyzatora QlAstat-Dx Analyzer 2.0
a veko vstupného portu kazety sa zatvori. Ak k tomu déjde, znova stlacte tlacidlo Eject (Vysunut), veko vstupného
portu kazety sa otvori a potom kazetu vyberte.

Poznamka: Pouzité testovacie kazety QlAstat-Dx sa musia zlikvidovat. Nie je mozné opéatovne pouzivat kazety pre

testy, pre ktoré sa uz spustil vykon testu, ale nasledne ich obsluha zruSila, alebo pri ktorych bola zistena chyba.
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administrator Run Test Module 1 13:00 2023-02-20

00:00
1 Ul administrator 2 3 4
RP Not installed Not installed Not installed

TEST DATA

Sample ID
52859357

Assay Type
RP

Sample Type
Swab

Cancel
Module 1 | Test Completed - Remove Cartridge

Obrazok 29. Zobrazenie obrazovky Eject (Vysunat).

11. Po vysunuti testovacej kazety QIAstat-Dx sa zobrazi obrazovka vysledkov Summary (Sthrn) (obrazok 30). DalSie
podrobnosti najdete v Casti 5.5.

administrator Summary 13:01 2023-02-20

F___

1 Available 2 Not installed 8 Not installed 4 Not installed °

. Run Test
TEST DATA QlAstat-Dx® Respiratory Panel
Sample ID Controls Passed
52859357 Detected e
Assay Type
Influenza B
RP e l View
Sample Type e Rhinovirus/Enterovirus Results
Swab @ ~denovirus
Equivocal @
None Options
Tested
@ influenzaB @
Bl summary |~ Amplification Cur. |\ Melting Curves & AMR Genes [E]l Test Details -
L — og Ou
Klﬂ) Support Package | @ Print Report | Igl Save Report | L,E_' Comment

Obrazok 30. Obrazovka Suhrn vysledkov.

Poznamka: Ak doslo pocas cyklu ku chybe na analytickom module, méze trvat nejaky ¢as, kym sa zobrazi suhrn
cyklu a cyklus bude viditelny v prehlade View Results (Zobrazit' vysledky).
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5.4. ZruSenie testovacieho cyklu
Ak uz prebieha test, stlacenim tlacidla Abort (Zrusit) sa vykonavanie testu zastavi (obrazok 31).

Poznamka: Pouzité testovacie kazety QlAstat-Dx sa musia zlikvidovat. Nie je mozné opatovne pouzivat kazety pre testy,
pre ktoré sa uz spustil vykon testu, ale nasledne ich obsluha zrusila, alebo pri ktorych bola zistena chyba.

administrator Run Test Module 1 13:22 2023-02-20

F___

1 Ul administrator 2 8 4
RP Not installed Not installed Not installed

Run Test
TEST DATA
Sample ID R\;Livrts
47283759
Assay Type @
RP

Options
Sample Type
Swab
EC Sample @
RP_EC_Sample_Pos1

Log Out

Module 1 | Remaining Time ----

Obrazok 31. ZruSenie testovacieho cyklu.

Po preruseni testu uz nie je mozné testovaciu kazetu QlAstat-Dx spracovat a nemozno ju opatovne pouzit. Po stlaéeni

tlacidla Abort (Zrusit) sa zobrazi dialdgové okno s vyzvou pre operatora, aby potvrdil, Ze sa ma test zrusit (obrazok 32).

Please confirm you wish
to cancel the test.

© Yes = X N

Obrazok 32. Dialogové okno potvrdenia zrusenia testovacieho cyklu.
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5.5.

Zobrazenie vysledkov

Analyzator QlAstat-Dx Analyzer 2.0 automaticky interpretuje a uklada vysledky testov. Po vysunuti testovacej kazety

QlAstat-

Dx sa automaticky zobrazi obrazovka vysledkov Summary (Suhrn) (obrazok 33).

Poznamka: Informacie o moznych vysledkoch a pokyny na interpretaciu vysledkov testov najdete v $pecifickych pokynoch

pre test.

administrator Summary 13:02 2023-02-20

F

1 Available °
. Run Test
TEST DATA QlAstat-Dx® Respiratory Panel
Sample ID Controls Passed
52859357 Detected e
Assay Type
Influenza B
RP e View
Sample Type @ Rhinovirus/Enterovirus Results
Swab @ ~denovirus
Equivacal
None Options
Tested
@ influenzaB @
Bl summary |~ Amplification Cur. |\ Metting Curves ¥ AMR Genes [l Test Details
_— Log Out
ﬁlﬂ: Support Package E Print Report E Save Report LE_| Comment

Obrazok 33. Obrazovka vysledkov Summary (Stihrn) zobrazujiica Test Data (Udaje testu) v Favom paneli a Summary (Suhrn) testu v hlavnom paneli.

Hlavna ¢ast obrazovky obsahuje nasledujlce tri zoznamy a na oznacenie vysledkov pouziva farebné znacenie a symboly:

Prvy zoznam obsahuje vSetky patogény vratane génov AMR (ak su podporované v ramci testu) zistené a
identifikované vo vzorke, pred ktorymi je znak 0 a su zafarbené nacerveno.

Druhy zoznam obsahuje vSetky nejednoznacéné patogény, pred ktorymi je otaznik &@ a su zafarbené nazlto.
Treti zoznam obsahuje vSetky patogény vratane génov AMR (ak su podporované v ramci testu) testované vo
vzorke. Patogénom zistenym a identifikovanym vo vzorke predchadza znacka (+] a su oznacené Cervenou
farbou. Pred patogénmi, ktoré boli testované, ale neboli detegované, sa nachadza znacka Q a su oznacené

zelenou farbou. Pred nejednoznaénymi patogénmi je uvedeny otaznik & 2 su zafarbené nazito.

Poznamka 1: Zistené a identifikované patogény vo vzorke su uvedené vo vSetkych zoznamoch.

Poznamka 2: Dalsie podrobnosti najdete v navode na pouzitiu ku konkrétnemu testu.

Ak sa test nepodarilo uspesSne dokoncit, zobrazi sa hlasenie ,Failed” (Zlyhanie), po ktorom nasleduje Specificky kod chyby.

Na lavej
o
.
o
.

strane obrazovky sa zobrazuju nasledujice Test Data (Udaje testu):
Sample ID (ID vzorky)

Patient ID (ID pacienta) (ak je k dispozicii)

Assay Type (Typ testu)

Sample Type (Typ vzorky)

LIS Upload Status (Stav nahravania LIS) (ak je dostupny)

Dalsie udaje o teste su dostupné v zavislosti od pristupovych prav operatora, prostrednictvom kariet v spodnej &asti

obrazovky (napr. amplifikacné grafy, krivky rozpustania a podrobnosti testu).
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Udaje o teste je mozné exportovat stladenim tlagidla Save Report (UloZit spravu) v spodnom paneli obrazovky.

Spravu je mozné odoslat do tlagiarne stlacenim tlacidla Print Report (Tlacit spravu) v spodnom paneli obrazovky.
Pomocny bali¢ek vybraného cyklu pre vsetky zlyhané cykly je mozné vytvorit stlacenim tlacidla Support Package
(Pomocny bali¢ek) na spodnej liste obrazovky (obrazok 34). Ak je potrebna pomoc, poslite pomocny bali¢ek technickému

servisu spolo¢nosti QIAGEN.

5.5.1. Zobrazenie amplifikacnych kriviek

Na zobrazenie amplifikaénych kriviek testu stlacte kartu |~ Amplification Curves (Amplifikacné krivky) (obrazok 34). Tato

funkcia nemusi byt k dispozicii pre vSetky testy.

Poznamka: Majte na pamati, ze amplifikacné krivky nie su ur€ené na interpretovanie vysledkov testu.

administrator Amplification Curves 13:02 2023-02-20
1 Available °
Run Test
PATHOGENS CONTROLS '
120,000
Detected
© Influenza B e
Ct34.1-EP 14,007 80,000 View
Rhinovirus/Enterovirus Results

° Ct34.2-EP 128,568

0,000

FLUORESCENCE

Adenovirus

g Ct37.1-EP 102,230 40,000 @
Equivocal 20000 Options
None ’.

) Adenovirus nterovirus
Not detected Lin " “ o
CYCLE
Infliianza A
Bl summary |~ Amplification Cur. |\ Melting Curves & AMR Genes [E]l Test Details
_— Log Out
Klﬂ) Support Package @ Print Report Igl Save Report L,E_' Comment

Obrazok 34. Obrazovka Amplification Curves (Amplifikaéné krivky) (karta PATHOGENS (PATOGENY)).

Podrobnosti o testovanych patogénoch a internych kontrolach st uvedené vlavo a amplifikaéné krivky su zobrazené v
strede.

Poznamka: Ak je aktivovana moznost User Access Control (Kontrola pristupu pouzivatelov) (pozrite si ¢ast 6.5) na
analyzatore QlAstat-Dx Analyzer 2.0, tak je obrazovka Amplification Curves (Amplifikacné krivky) k dispozicii len pre

operatorov s pristupovymi opravneniami.

Stlagte kartu PATHOGENS (PATOGENY) na lavej strane a zobrazite si grafy zodpovedajlce testovanym patogénom.
Stlacte nazov patogénu a vyberte, ktoré patogény su zobrazené na amplifikanom grafe. Je mozné vybrat jeden, viac alebo
ziadny patogén. Kazdému patogénu vo vybranom zozname bude priradena farba zodpovedajuca amplifikacnej krivke

prisluchajucej danému patogénu. Nevybrané patogény sa zobrazia sivou farbou.

Pod kazdym nazvom patogénu su uvedené zodpovedajuce hodnoty Ct a koncového bodu fluorescencie.
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Stlacenim karty CONTROLS (KONTROLY) na lavej strane zobrazite interné kontroly a vyberiete, ktoré interné kontroly sa
zobrazia v amplifikatnom grafe. Ak chcete vybrat alebo zrusit' internd kontrolu, stlaéte kruh vedla nazvu ovladaca
(obrazok 35).

administrator Amplification Curves 13:02 2023-02-20
1 Available °
Run Test
PATHOGENS CONTROLS @
200,000
Passed Controls e
e IC Ly 150,000
Ct31.9-EP 207,326 = View
w
Failed Controls 2 Results
o
None g 100,000
T
50,000
Options
0
% 10 20 30 .
Lin @
CYCLE
Bl summary |~ Amplification Cur. |\ Metting Curves ¥ AMR Genes [l Test Details
_— Log Out
ﬁlﬂ: Support Package E Print Report E Save Report LE_| Comment

Obrazok 35. Obrazovka Amplification Curves (Amplifikaéné krivky) (karta CONTROLS (KONTROLY)) zobrazujuca interné kontroly.

Amplifikacny graf zobrazuje datovu krivku pre vybrané patogény alebo interné kontroly. Na striedanie logaritmickej alebo
linearnej stupnice pre os Y stlacte tla¢idlo Lin alebo Log v lavom dolnom rohu grafu.

Stupnicu osi X a osi Y mozno nastavit pomocou . modrych voli¢ov na kazdej osi. Stlacte a podrzte modry voli¢ a potom
ho presurite na poZzadované miesto na osi. Presunutim modrého voli¢a na zaliatok osi sa vratite na predvolené hodnoty.

5.5.2. Zobrazenie kriviek rozpustania

Ak chcete zobrazit' krivky rozpustania testu, stlacte kartu Melting Curves (Krivky rozpustania).
Podrobnosti o testovanych patogénoch a internych kontrolach su uvedené viavo a krivky rozpustania su zobrazené v strede.

Poznamka: Karta Melting Curves (Krivky rozpustania) je k dispozicii iba pre testy, ktoré maju implementovanu analyzu
rozpustania.

Poznamka: Ak je aktivovana moznost User Access Control (Kontrola pristupu pouzivatelov) (pozrite si ¢ast 6.5) na
analyzatore QlAstat-Dx Analyzer 2.0, tak je obrazovka Melting Curves (Krivky rozpustania) k dispozicii len pre operatorov
s pristupovymi opravneniami.

Stlaéte kartu PATHOGENS (PATOGENY) na lavej strane na zobrazenie testovanych patogénov. Stladenim kruhu vedla
nazvu patogénu vyberte, ktora krivka rozpustania patogénov sa zobrazi. Je mozné vybrat jeden, viac alebo ziadny patogén.
Kazdému patogénu vo vybranom zozname bude priradena farba zodpovedajlca krivke rozpustania pridelenej k patogénu.

Nevybrané patogény sa zobrazia sivou farbou. Teplota rozpustania je uvedena pod kazdym nazvom patogénu.
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Stlacenim karty CONTROLS (KONTROLY) na lavej strane zobrazite interné kontroly a vyberiete, ktoré interné kontroly sa
zobrazia v grafe rozpustania. Ak chcete vybrat alebo zrusit’ kontrolu, stlacte kruh vedla nazvu kontroly.

Interné kontroly, ktoré presli analyzou, st zobrazené zelenou farbou a st oznadené ako ,Passed Controls® (Uspesné
kontroly), zatial o tie, ktoré zlyhali, si zobrazené Cervenou farbou a su oznacené ako ,Failed Controls“ (NelUspe$né
kontroly).

Stupnicu osi X a osi Y mozno nastavit pomocou . modrych voli€ov na kazdej osi. Stlacte a podrzte modry voli¢ a potom

ho presurite na poZadované miesto na osi. Presunutim modrého voli¢a na zaliatok osi sa vratite na predvolené hodnoty.

5.5.3. Zobrazenie génov AMR
Na zobrazenie génov AMR stlacte kartu AMR genes (Gény AMR).

Poznamka: Karta AMR Genes (Gény AMR) je k dispozicii len pre testy obsahujuce gény AMR.

Na lavej strane sa nachadza zoznam vSetkych zistenych génov AMR. Pri vybere jedného zo zistenych génov AMR sa v
strede zobrazi zoznam vsetkych suvisiacich patogénov. Patogénom zistenym a identifikovanym vo vzorke predchadza
znacka 0 a su oznacené Cervenou farbou. Pred patogénmi, ktoré boli testované, ale neboli detegované, sa nachadza

znacka 9 a su oznacené zelenou farbou obrazok 36).

L] - o X

administrator AMR Genes 09:07 2023-09-19

1 Available 2 Available 3 Available 4 Available °

Run Test
AMR GENES ASSOCIATED TARGETS

Detected @ Pathogen One e
e " e Pathogen Two

) View Results
e Pathogen Five

AMR9
e Pathogen Eleven
AMETA e Pathogen Thirteenth @
e Pathogen Seven Options
G Pathogen Nine
i O,
B summary |~ Amplification Cu... | |/ Melting Curves % AMR Genes [& Test Details
- Log Out
Eﬁ: g:gﬁ:ge [z Print Report E Save Report =] comment Iil Upload

Obrazok 36. Obrazovka Gény AMR.

Poznamka: Udaje znazornené na obrazku 36 su len ilustradné Udaje a nezobrazuju skutodné patogény.

Viac informacii o génoch AMR a kompletny prehlad vS§etkych suvislosti medzi génmi AMR a inymi cielmi najdete v navode

na pouzivanie prislusného testu.
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5.5.4. Zobrazenie podrobnosti o teste

Stlagenim & Test Details (Podrobnosti testu) mozete prehliadat’ podrobnejSie vysledky. Ak chcete zobrazit' Uplny prehlad,
posurite sa nadol.

V strede obrazovky sa zobrazia nasledujuce Test Details (Podrobnosti testu) (obrazok 37):

e User ID (ID pouzivatefa)

e  Cartridge SN (SN kazety) (sériové Cislo)

e Cartridge Expiration Date (Datum exspiracie kazety)

e Module SN (SN modulu) (sériové ¢islo)

e Test Status (Stav testu) (Completed (Dokonéené), Failed (Zlyhanie) alebo Canceled (Zrusené) operatorom)

e  Error Code (Kod chyby) (ak je to relevantné)

e  Error Message (Chybové hlasenie) (ak je to relevantné)

e Test Start Date and Time (Datum a €as zaciatku testu)

e Test Execution Time (Cas vykonania testu)

e Assay Name (Nazov testu)

e  External Control Test (Externy kontrolny test) (pozrite si Cast’ 8)

e TestID (ID testu)

e  Book Order ID (ID uzavretej objednavky) (Viditelné, len ak bola zapnuta kontrola objednavky, ked' sa test spustil).
Pozrite si Cast' 7)

e Order Time (Cas objednavky) (Viditelné, len ak bola zapnuta kontrola objednavky, ked sa test spustil. Pozrite si &ast’ 7)

e HIS/LIS Confirmation (Potvrdenie HIS/LIS) (Viditelné, len ak bola zapnuté kontrola objednavky, ked sa test spustil.
Pozrite si €ast' 7)

e Test Result (Vysledok testu) (pre kazdy analyt, celkovy vysledok testu: Positive (Pozitivny) [pos], Positive with Warning
(Pozitivny s varovanim) [pos*], (Negative (Negativny) [neg], Invalid (Neplatny) [inv], Failed (Zlyhanie) [fail] alebo
successful (Uspesny) [suc]. Podrobné informacie o moznych vysledkoch a ich interpretacii najdete v Specifickych
navodoch na pouZitie testov)

e List of analytes (Zoznam analytov) testovanych v teste (zoskupené podla Detected Pathogen (Detegovany patogén),
Equivocal (Nejednoznacny), Not Detected Pathogens (Nedetegované patogény), Invalid (Neplatny), Not Applicable
(Neuplatfiuje sa), Out of Range (Mimo rozsahu), Passed Controls (Uspesné kontroly) a Failed Controls (Netispe$né
kontroly)), s hodnotami Ct a koncového bodu fluorescencie a semikvantifikacnou hodnotou v cp/mL (kopie/mililiter) (ak
je k dispozicii pre dany test).

e Zoznam internych kontrol s hodnotami Ct a koncového bodu fluorescencie (ak je k dispozicii pre dany test)

administrator Summary 13:03 2023-02-20
1 Available °
Run Test
TEST DATA TEST DETAILS
Sample 1D User 1D administrator
52859357 Cartridge SN 180004016 e
/:;Fs’ay Tvpe Cartridge Expiration Date 2018-07-18 00:00 -
Module SN 1004 o
Sample Type
Swab Test Status Completed
Test Start Date and Time 2023-02-20 13:00
Test Execution Time 0 min 1 sec
Assay Name RP Options
External Control no
Test ID 202302201300250573
Bl summary |~ Amplification Cur. |\ Melting Curves & AMR Genes [l Test Details s
Log Out
Klﬂ) Support Package @ Print Report Igl Save Report L,E_' Comment

Obrazok 37. Priklad obrazovky Test Data (Udaje testu) zobrazenej v Favom paneli a Test Details (Podrobnosti testu) v hlavnhom paneli.
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5.5.5. Komentovanie vysledkov testu

V akejkolvek karte obrazovky Results (Vysledky) vyberte moznost Comment (Komentovat) na pridanie komentara k
vysledku testu. Pri pridavani komentara sa navySe ulozi pouzivatel, ktory komentoval vysledok, ako aj datum a Cas
komentara. Ulozi sa len posledny komentar, editor a datum a Cas, to znamena, Ze ak upravite existujuci komentar,
predchadzajuci komentar sa nezachova.

Komentar si mbzete pozriet v karte Test Details (Podrobnosti o teste) daného vysledku.

Komentare mbzu byt volitelne skryté v spravach vo formate PDF. Ak chcete skryt komentare v spravach vo formate PDF,

pozrite si Cast' 6.7.4.

Poznamka: Pridavanie, Uprava a odstrafiovanie komentarov nema ziadny vplyv na vysledok biologického testu.

Poznamka: Funkcia komentara nie je k dispozicii, ak sa pouziva aplikacia QlAstat-Dx Remote Results (pozrite si
Cast 6.7.3)

Poznamka: Komentar by nemal obsahovat Ziadne osobné udaje umoznujuce identifikaciu (Pll) alebo chranené zdravotné

informacie (PHI).
5.5.6. Vysledky prehliadania z predchadzajucich testov

Ak chcete zobrazit vysledky z predchadzajucich testov, ktoré su ulozené v Ulozisku vysledkov, v paneli s hlavnou ponukou
stlacte tlacidio @ View Results (Zobrazit vysledky) (obrazok 38).

administrator Test Results 13:03 2023-02-20
1 Available °
Run Test
° Sample ID Assay Operator ID EC Mod Date/Time Result
52859357 RP administr. 1 2023-02-2013:00 @ pos e
53647562 RP administr. 1 2023-02-20 12:53 e pos Vi
Results
02548164 RP administr... 1 2023-02-2011:28 e pos
32749367 RP administr. 1 2023-02-2011:27 0 pos @
54372658 GI-TEST administr. 1 2023-02-2011:26 e pos Options
97354758 G1-TEST administr... 1 2023-02-20 11:25 e pos
K < Page 1 of 2 > 3 @
Log Out
A Remove Filter E Print Report E Save Report p Search

Obrazok 38. Priklad obrazovky Zobrazit’ vysledky.

Pre kazdy vykonany test su k dispozicii nasledujice informacie (Obrazok 38):
e Sample ID (ID vzorky)
e Assay (Test) (nazov testu)
e  Operator ID (ID operatora)
e EC (EK) (ak sa uskutocnil test EK)
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e  Mod (Analyticky modul, na ktorom bol test vykonany)

e Upload status (Stav nahravania) (viditelny len vtedy, ak su aktivované nastavenia HIS/LIS)

e Date/Time (Datum/Cas) (datum a ¢as ukoncenia testu)

o Vysledok (zaver testu: pozitivny [pos], pozitivny s varovanim [pos*], negativny [neg], neplatny [nep], zlyhanie

[fail], uspesny [suc], EK presla [ecpass] alebo EK nepresla [ecfail])

Poznamka: Mozné zavery su Specifické pre test (t. j. niektoré zavery sa nemusia uplatiovat pre kazdy test). Pozrite si

navod na pouzitie Specificky pre test.

Poznamka: Ak je aktivovana moznost User Access Control (Kontrola pristupu pouzivatelov) (pozrite si ¢ast 6.5) na
analyzatore QlAstat-Dx Analyzer 2.0, udaje, pre ktoré pouzivatel nema pristupové opravnenia, budu skryté s hviezdickami.

Poznamka: Ak chcete zobrazit predchadzajuce testy, ktoré boli archivované bud manualne, alebo automaticky, pozrite si
Cast 6.12.2.

Vyberte jeden alebo viac vysledkov testu stlacenim Sedého kruzku viavo od ID vzorky. Vedla vybratych vysledkov sa
zobrazi policko zaciarknutia. Ak chcete zrusit vyber vysledkov testu, stlacte kvacku. Cely zoznam vysledkov je mozné

zvolit stlagenim tlagidla @ krazok so zagkrtnutim v hornom riadku (obrazok 39).

administrator Test Results 13:03 2023-02-20
1 Available °
Run Test
° Sample ID Assay Operator ID EC Mod Date/Time Result
@ 52859357 RP administr... 1 2023-02-2013:00 @) pos e
@ 53647562 RP administr. 1 2023-02-2012:53 @ pos View
Results
0 02548164 RP administr. 1 2023-02-2011:28 e pos
32749367 RP administr... 1 2023-02-2011:27 e pos @
54372658 GI-TEST administr. 1 2023-02-2011:26 e pos Options
97354758 G-TEST administr. 1 2023-02-20 11:25 e pos
K < Page 1 of 2 > | @
Log Out
A Remove Filter E Print Report E Save Report p Search

Obrazok 39. Priklad vyberu Test Results (Vysledky testov) na obrazovke View Results (Zobrazit’ vysledky).
Stlagenim lubovolného miesta v riadku testu zobrazite vysledok pre konkrétny test. Stlagenim nadpisu stipca (napr. Sample
ID (ID vzorky)) zoradite zoznam vzostupne alebo zostupne podla tohto parametra. Zoznam je mozné zoradit len podla

jedného vybraného stipca. Stipec Result (Vysledok) zobrazuje zavery jednotlivych testov (tabulka 1).

Poznamka: Mozné zavery su Specifické pre test (t. j. niektoré zavery sa nemusia uplatiovat pre kazdy test). Pozrite si

navod na pouzitie Specificky pre test.
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Tabulka 1. Popis vysledkov testov

Zaver Vysledok Popis

| Aspon jeden analyt je pozitivny, ale interna kontrola testu zlyhala
" pos*

Positive with warning
(Pozitivny s varovanim)

Negative (Negativny) Neboli zistené Ziadne analyty

Failed (Zlyhanie) Test sa nepodaril z dévodu vyskytu chyby, test zrusil pouzivatel alebo test EK sa nepodaril, ale

fail pouzivatel nema pristupové prava na prezeranie vysledkov testu.

Invalid (Neplatny) e Test je neplatny

Successful (Uspesny) Test je bud pozitivny, pozitivny s varovanim, negativny alebo EK pres$la, ale pouzivatel nema

suc pristupové prava na zobrazenie vysledkov testu

EC Passed (EK presla) Test EK bol Uspesny, ako napriklad ked' vSetky analyty splnili o€akavany vysledok.

EC Failed (EK zlyhala) Test EK sa nepodaril, €0 znamena, Ze minimalne jeden analyt nesplnil svoj o¢akavany vysledok.

ecfail

Poznamka: Podrobny popis vysledkov najdete v navode na pouZzitie pre test, ktory sa vykonava.

Skontrolujte, Ci je tlaciaren pripojena k analyzatoru QlAstat-Dx Analyzer 2.0, a Ci je nainStalovany spravny ovladac

(priloha 12.1). Stlac¢enim tlacidla Print Report (Tlacit spravu) vytlacte spravy pre vybrané vysledky.

Stlacenim tla¢idla Save Report (Ulozit spravu) uloZte spravy pre vybrané vysledky vo formate PDF na externé ulozné

zariadenie USB. Vyberte typ spravy: List of Tests (Zoznam testov) alebo Test Reports (Spravy testov).

Poznamka: Na kratkodobé uloZenie a prenos uUdajov sa odporuca pouzit dodané ulozné USB zariadenie. Pouzivanie
Ulozného zariadenia USB nepodlieha ziadnym obmedzeniam (napr. kapacita pamate alebo riziko prepisania), ktoré by sa

malo pred pouzitim zvazit.

Stlatenim Search (Hladat) vyhladate vysledky testu podla Sample ID (ID vzorky), Assay (Test) a Operator ID (ID
operatora). Pomocou virtualnej klavesnice zadajte hladany retazec a stlacenim klavesu Enter spustite vyhladavanie.
Vo vysledkoch vyhladavania sa zobrazia iba zaznamy obsahujuce hladany text. Ak je zoznam vysledkov filtrovany,

vyhladavanie sa bude vztahovat len na filtrovany zoznam.

Ak chcete filtrovat vysledky, stladenim a podrzanim nadpisu stipca moéZete pouzit filter zaloZzeny na tomto parametri. Pre
niektoré parametre, ako napriklad Sample ID (ID vzorky), sa zobrazi virtualna klavesnica, aby bolo mozné zadat’ hfadany
retazec pre filter. Pre iné parametre, ako napriklad Assay (Test), sa otvori dialdgové okno so zoznamom testov ulozenych

v Ulozisku. Vyberte jeden alebo viac testov na odfiltrovanie len tych testov, ktoré boli vykonané s vybranymi testami.

Symbol ‘T viavo od nadpisu stipca oznaduije, ze filter stipca je aktivny. Filter je mozné odstranit stladenim tlagidla Remove
Filter (Odstranit filter) v paneli podponuky.

5.5.7. Exportovanie vysledkov na jednotku USB

Na ktorejkolvek karte obrazovky View Results (Zobrazit vysledky) vyberte Save Report (Ulozit spravu), ak chcete
exportovat’ a ulozit' képiu vysledkov testu vo formate PDF na jednotku USB. Port USB sa nachadza na prednej strane
analyzatora QlAstat-Dx Analyzer 2.0 (obrazok 40).

Spravy mozno nakonfigurovat tak, aby sa amplifikaéné krivky resp. komentare mohli vylucit zo spravy. Na konfiguraciu tejto

moznosti si pozrite ¢ast 6.7 .4.
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Poznamka: Na kratkodobé ulozZenie a prenos udajov sa odporuca pouzit dodané ulozné USB zariadenie. Pouzivanie
Ulozného zariadenia USB nepodlieha ziadnym obmedzeniam (napr. kapacita paméate alebo riziko prepisania), ktoré by sa
malo pred pouzitim zvazit.

Obrazok 40. Umiestnenie portu USB.
5.5.8. Tla¢ vysledkov
Skontrolujte, ¢i je tlaciaren pripojena k analyzatoru QlAstat-Dx Analyzer 2.0 a &i je nainStalovany spravny ovladac (dalSie

informacie o instalacii ovladaca najdete v prilohe 11.1). Stla¢enim Print Report (Tlacit spravu) odoslete kopiu vysledkov
testu do tlaciarne.

Spravy mozno nakonfigurovat tak, aby sa amplifikacné krivky resp. komentare mohli vylugit z vytlacku. Na konfiguraciu tejto
moznosti si pozrite ¢ast 6.7 .4.

Poznamka: Pri niektorych tladiarfiach sa méze stat, Zze analyty vytlacené kurzivou budi mierne rozmazané. Spravu o teste

odporu¢ame exportovat vo formate PDF do jednotky USB podla popisu v €asti 5.5.7 a vytlacit dokument vo formate PDF.
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5.5.9. Vytvorenie balicka podpory

Ak je potrebna pomoc, je mozné vytvorit a poskytnut technickému servisu spolo¢nosti QIAGEN pomocny bali¢ek obsahujuci
vSetky potrebné informacie o chode, systémové subory a subory technickych protokolov. Na vytvorenie pomocného balic¢ka
kliknite na kartu Support Package (Pomocny bali¢ek). Zobrazi sa dialdgové okno a bude mozné vytvorit pomocny baliek
pre vybrany test alebo nevydarené testy (obrazok 41). Ulozte pomocny bali¢ek do pamatového zariadenia USB. Port USB

sa nachadza na prednej strane analyzatora QlAstat-Dx Analyzer 2.0 (obrazok 40).

SELECT RESULTS TO INCLUDE
Selected Test v

All Failed Tests

Eﬁh Create ® Cancel

Obrazok 41. Vytvorenie pomocného balicka.

Poznamka: Na kratkodobé uloZenie a prenos udajov sa odporuca pouzit dodané ulozné USB zariadenie. Pouzivanie
ulozného zariadenia USB nepodlieha ziadnym obmedzeniam (napr. kapacita paméate alebo riziko prepisania), ktoré by sa
malo pred pouzitim zvazit.

Poznamka: Ak je potrebna pomoc, uistite sa, ze sa kratko po vyskyte problému vytvori pomocny bali¢ek. Z dévodu
obmedzenej Uloznej kapacity a konfiguracie systému moze dojst’ pri pokracujucom pouzivani systému k automatickému

vymazaniu suborov protokolu systému a technickych suborov protokolu prislusného ¢asového intervalu.
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6. Funkcie a moznosti systemu

Tato Cast' poskytuje popis vSetkych dostupnych funkcii a moznosti analyzatora QlAstat-Dx Analyzer 2.0, ktoré umozniuju
prispdsobit nastavenia pristroja.

6.1. Hlavna obrazovka

Na obrazovke Main (Hlavna obrazovka) je mozné zobrazit stav analytickych modulov a prejst do réznych sekcii (Login
(Prihlasenie), Run Test (Spustit test), View Results (Zobrazit vysledky), Options (MozZnosti) a Log Out (Odhlasit))
pouzivatel'ského rozhrania (obrazok 42).

General status bar
Module status bar &

administrator 13:04 2023-02-20 .
UAEETNNIRERNRITE / Main Menu bar

1 Available
Run Test

View
Results

ekt e

Options

o)

Log Out

LY

Content area Submenu bar
Obrazok 42. Hlavna obrazovka dotykovej obrazovky analyzatora QlAstat-Dx Analyzer 2.0.

Main (Hlavna obrazovka) obsahuje nasledujuce prvky:
VSeobecny stavovy riadok

Stavovy riadok modulu

Panel hlavnej ponuky

Oblast s obsahom

Panel s kartami ponuk (volitelne zobrazené, zavisi od obrazovky)

Panel podponuky a panel s pokynmi (volitelne zobrazené, zavisi od obrazovky)

6.1.1. VSeobecny stavovy riadok

VSeobecny stavovy riadok poskytuje informacie o stave systému (obrézok 43). Na lavej strane sa zobrazi User ID (ID
pouzivatela) prihlaseného pouzivatela. V strede sa zobrazi nazov obrazovky a vpravo sa zobrazi systémovy datum a ¢as.

administrator 14:39 2017-03-30

Obrazok 43. VSeobecny stavovy riadok.
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6.1.2. Stavovy riadok modulu

Stavovy riadok modulu zobrazuje stav jednotlivych analytickych modulov (1 — 4) dostupnych v systéme v prislusnych
stavovych poliach (obrazok 44). Ak nie je pre tuto poziciu k dispozicii Ziadny analyticky modul, v poliach sa zobrazi ,Not

Installed“ (Nenainstalovane).

F

1 Available

Time puck
Progress bar
Line 1

m Line 2

Ul administrator

Resp_3018_19c¢c

Analytical Module number

Obrazok 44. Stavovy riadok modulu.

Kliknutim na poli¢ko zodpovedajuce konkrétnemu analytickému modulu ziskate pristup k podrobnej$im informaciam (pozrite
si stranu Strana so stavom modulu). Stavy modulu, ktoré sa mézu zobrazit v stavovom poli stavového riadku modulu, su

zobrazené v tabulke 2.

Taburlka 2. Stavy modulov, ktoré mézu byt zobrazené v stavovych poliach

Stav

Popis

Not installed (Nenainstalované)
Excluded (Vylu¢ené)
Error (Chyba)

Initializing (Inicializacia)

Available (Dostupné)

Test running (Prebiehajuci test)

T

Ul administrator
Resp_3018_19¢

Test completed (Dokonceny test)

Ul administrator
Resp Panel

Eject cartridge (Vysunut kazetu)

V tejto pozicii nie je nainstalovany Ziadny analyticky modul.
Analyticky modul bol vyli¢eny pouzivatelom prostrednictvom pouzivatel'skych nastaveni.

Analyticky modul oznamil zavaznu chybu.
Analyticky modul je mimo prevadzky.

Analyticky modul sa spusta a vykonava samocinny test.

Analyticky modul je k dispozicii pre novy test. V tomto analytickom module nie je spusteny Ziadny test, nie
je vlozena Ziadna testovacia kazeta QlAstat-Dx a veko vstupného portu kazety je zatvorené.

Pouzivatel' ,administrator” (spravca) v sti€asnosti spusta test Resp_3018_19c na analytickom module 1.
Na dokoncenie testu zostava 32 minut a 14 sekund.

Pouzivatel “administrator” (spravca) vykonal test Resp Panel na analytickom module 1.

Panel priebehu v poli zobrazuje stav testu:

TEST COMPLETED (Dokon&eny test): test bol Uspes$ne ukonéeny.

TEST FAILED (Test zlyhal): test bol dokon&eny, ale vyskytla sa chyba.

TEST CANCELED (Zru$eny test): pouzivatel zrusil test.

Po odstraneni testovacej kazety QlAstat-Dx a zatvoreni veka vstupného portu kazety bude analyticky
modul znova dostupny.

Analyticky modul obsahuje testovaciu kazetu QlAstat-Dx a veko vstupného portu kazety je zatvorené, ale
momentalne nie je spusteny ziadny test. K tomu méze déjst v nasledujucich situaciach:

Kazeta nebola odstranena po vysunuti z dévodu zruSeného alebo dokonéeného testu.

Systém bol vypnuty s kazetou vnutri analytického modulu.
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6.1.3. Strana so stavom modulu

Stavova strana modulu zobrazuje informacie, ako napriklad pozicia, sériové Cislo, revizia hardvéru a aktualna verzia
softvéru. Okrem toho sa tu zobrazuju chyby tykajuce sa vybraného analytického modulu ako aj informacie o softvérovych a
hardvérovych komponentoch (obrazok 45).

Na liste s pokynmi sa zobrazi tlacidlo reStartovania, ktoré je mozné pouzit na restartovanie vybraného modulu bez nutnosti
reStartovat’ celé zariadenie. Toto tlacidlo je aktivované len vtedy, ked je vybrany modul v chybovom stave alebo v stave
,mimo prevadzky*.

Poznamka: Tlacidlo Restart (Restart) méze byt po dokonceni testu na module tiez deaktivované, ak stale prebieha
dodato¢né spracovanie.

administrator Status Analytical Module 1 13:05 2023-02-20
1 Available °
Run Test
MODULE DATA
Position 1
Serial No 1004
HW Revision 0.0.0 e
Software Version 0.6.21 View

Results

MODULE ERROR

Error Code None @
COMPONENTS Options
qPCR Sensor

Serial No 2

HW Revision 0.0.1

Software Version 0.6.5

'_
o
(=]
o
c
=

@ Restart Analytical Module 1

Obrazok 45. Strana Modul.

Na stranu so stavom modulu sa mézete dostat kedykolvek okrem situacie, kedy je analyticky modul v stave ,Not installed
(Nenainstalovany)“, ,Not present (Nepritomny)“ alebo ,Initializing (Inicializuje sa)“. PoCas cyklu a ked je kazeta stale
vloZena, strana so stavom modulu sa nezobrazi, namiesto toho sa zobrazi stavovy riadok modulu (popisany v
predchadzajucej pod&asti).

6.1.4. Panel hlavnej ponuky

Tabulka 3 zobrazuje moznosti, ktoré ma pouzivatel k dispozicii na paneli hlavnej ponuky.

Tabulka 3. MozZnosti panela hlavnej ponuky

Nazov Tlacidlo Popis

Run Test ° Spusti sekvenciu testovacieho cyklu (pozrite si ¢ast 5.3). Softvér QlAstat-Dx automaticky vyberie dostupny analyticky
(Spustit’ test) modul a spusti sekvenciu pripravy testu.

View Results e Otvori obrazovku View Results (Zobrazit vysledky) (pozrite si ¢ast 5.5).

(Zobrazit'

vysledky)

Options 9 Zobrazi podponuku Options (MoZnosti) (pozrite si Gast 6.4).

(Moznosti)

Log Out @ Odhlasi pouzivatela (pozrite si Cast 6.2.1). Aktivne, len ak je aktivovana funkcia User Access Control (Kontrola

(Odhlasit) pristupu pouzivatelov).
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6.1.5. Oblast s obsahom

Informacie zobrazené v hlavnej oblasti s obsahom sa liSia v zavislosti od stavu pouzivatel'ského rozhrania. Po vstupe do
réznych rezimov a vybere poloziek z ponuky opisanej nizSie sa v tejto oblasti zobrazia vysledky, suhrny, konfiguracie a
nastavenia.

V zavislosti od obsahu mézu byt k dispozicii dalSie moznosti prostrednictvom panela s kartami ponuk a ponuky Options
(Moznosti). K podponuke Options (Moznosti) sa dostanete stlacenim tlacidla Options (Moznosti) (obrazok 46).

administrator 13:05 2023-02-20

1 Available

Run Test

View
Results
User Management Assay Management System Configuration Change Password Options

<K<

® © 0 ©

Notifications Print Queue External Control Archive Results Log Out

®

Obrazok 46. Pristup k podponuke Options (Moznosti).

6.2. Prihlasovacia obrazovka

Ak je aktivovana moznost User Access Control (Kontrola pristupu pouzivatelov) (pozrite si ¢ast 6.5), pouzivatelia sa musia
identifikovat’ prihlasenim, aby ziskali pristup k funkciam analyzatora QlAstat-Dx Analyzer 2.0.

Dolezité: Pri prvom prihlaseni je ID pouzivatela ,administrator” a predvolené heslo je ,administrator”. Po prvom prihlaseni
sa musi heslo zmenit.

Poznamka: Po Uspesnej prvej inStalacii analyzatora QlAstat-Dx Analyzer 2.0 sa musi automaticky aktivovat User Access
Control (Kontrola pristupu pouzivatelov).

Poznamka: Dorazne odporu¢ame vytvorit pri prvom prihlaseni minimalne jeden pouzivatel'sky tcet bez role
LAdministrator” (Spravca).

Oblast s obsahom na prihlasovacej obrazovke obsahuje textové pole na zadanie User ID (ID pouzivatela) (obrazok 47). Ak
je vybrana moznost Show previous user logins (Zobrazit' predtym prihlasenych pouzivatelov), zobrazi sa aj zoznam
predchadzajucich piatich pouzivatelov, ktori sa Uspesne prihlasili.

Poznamka: Prihlasovaciu ikonu servisného technika v pravom spodnom rohu obrazovky smua pouzivat iba pracovnici
autorizovani spoloénostou QIAGEN.
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No user Login 13:05 2023-02-20

User ID Password

labuser

administrator

Obrazok 47. Prihlasovacia obrazovka.

Zadajte meno pouzivatela kliknutim na jedno z mien dostupnych v zozname alebo kliknutim na textové pole User ID
(ID pouzivatela) a zadanim mena pomocou virtualnej klavesnice. Po zadani mena pouzivatela potvrdte stlacenim

zaciarkavacieho poli¢ka na virtualnej klavesnici (obrazok 48).

No user Log In 13:06 2023-02-20

User ID administratod Password

glwlel]lr|t]y]u i o | p | I ] -
a s d f g h i k I ) ' \
&z X c v b n m ; /
X space v

Obrazok 48. Virtualna klavesnica na dotykovej obrazovke.

Ak je vybrana moznost Require password (Pozadovat heslo) (pozrite si Cast 6.5), zobrazi sa textové pole pre heslo a
virtualna klavesnica na zadanie hesla. Ak sa nevyzaduje heslo, bude textové pole pre heslo sivé.

Ak pouzivatel zabudne svoje heslo, Administrator (Spravca) systému ho moze resetovat.

Poznamka: Ak spravca zabudne svoje heslo, m6ze ho resetovat iba technicky servis QIAGEN, pricom sa vyzaduje

navsteva servisného technika QIAGEN na mieste. Preto sa odporuc¢a vytvorit dalSi pouzivatelsky Ucet.
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Ak sa z bezpectnostnych dévodov trikrat zada nespravne heslo, systém sa na jednu minutu zablokuje, kym sa pouzivatel

bude méct znova prihlasit.

Poznamka: Dodrziavajte zasady kybernetickej bezpecnosti vasej organizacie pre uschovu povereni.

Poznamka: Dérazne odporu¢ame pouzit’ silné heslo v sulade so zasadami pre hesla vo vasej spolo¢nosti.

6.2.1. Odhlasenie

Ked je aktivovana moznost User Access Control (Kontrola pristupu pouzivatelov) (pozrite si ¢ast' 6.5), pouzivatelia sa
mozu kedykolvek odhlasit pomocou moznosti Log Out (Odhlasit) v paneli hlavnej ponuky. Dalsie informacie najdete

v Casti 6.1.4.

Pouzivatelia budu automaticky odhlaseni, ked uplynie ¢as automatického odhlasenia. Tento ¢as je mozné nakonfigurovat

v nastaveniach General (VSeobecné) v ponuke Options (Moznosti) (pozrite si Cast 6.7.4).

6.3. Setri¢ obrazovky

Setri¢ obrazovky analyzatora QlAstat-Dx Analyzer 2.0 sa zobrazi, ak podas vopred definovaného asového obdobia

neddjde k interakcii pouzivatela. Tento €as je mozné nakonfigurovat v ponuke Options (Moznosti) (pozrite si Cast 6.7.4).

Setri¢ obrazovky zobrazuje dostupnost analytickych modulov a zostavajici as do ukonéenia testu (obrazok 49).
Poznamka: PocCas operacii ako napriklad aktualizacia softvéru, zalohovanie, obnova, vytvaranie archivu a otvaranie archivu
sa mdze automaticky deaktivovat SetriC obrazovky a automatické odhlasenie. Z dévodov kybernetickej bezpeCnosti sa

odporuca nenechavat systém pocas tejto doby bez dozoru.

Obrazok 49. Setri¢ obrazovky zobrazujuci jeden dostupny analyticky modul.
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6.4. Ponuka Moznosti

Ponuka Options (Moznosti) je pristupna z hlavnej ponuky. Tabulka 4 zobrazuje moznosti, ktoré su dostupné pre

pouzivatela. Moznosti, ktoré nie su k dispozicii, budu sivé.

Tabulka 4. Ponuka MozZnosti

Nazov Tlag¢idlo  Popis Cast's
referenciami

User Management e K dispozicii pre pouzivatelov s pravami na spravu pouzivatelov a 6.5

(Sprava pouzivatelov) pouzivatelskych profilov.

Assay Management K dispozicii pre pouzivatelov s pravami na spravu testov. 6.6

(Sprava testov)

System Configuration e K dispozicii pre pouzivatelov s pravami na konfiguraciu systému. 6.7

(Konfiguracia systému)

Change Password e K dispozicii, ak je povolena moznost User Access Control (Kontrola pristupu 6.8

(Zmenit heslo) pouzivatelov).

Notifications (Oznamenia) @ K dispozicii pre vSetkych pouzivatelov na zobrazenie a potvrdenie ozndmeni a 6.9
prevzatie suborov.

Print Queue (Tladit front) @ Dostupné pre vSetkych pouzivatelov. 6.10.2

External Control @ K dispozicii pre pouzivatelov s pravami na spravu nastaveni externej kontroly. 8

(Externa kontrola)

6.5. Sprava pouzivatelov

Softvér aplikacie QlAstat-Dx je flexibilny, aby podporoval rézne scenare pouzivania. Pre spravu pouzivatelov a prav su k

dispozicii tieto rezimy:

® Rezim ,Single User* (Jeden pouzivatel): User Access Control (Kontrola pristupu pouzivatelov) je zakazana a
nevykonava sa ziadna kontrola pouzivatelov, ktori sa prihlasia do analyzatora QlAstat-Dx Analyzer 2.0. VSetky funkcie
a vlastnosti analyzatora QlAstat-Dx Analyzer 2.0 budu dostupné bez akychkolvek obmedzeni pre vSetkych
pouzivatelov.

® Rezim ,Multi-User* (Viac pouzivatelov): User Access Control (Kontrola pristupu pouzivatelov) je povolena a pred
vykonanim akejkolvek akcie na analyzatore QlAstat-Dx Analyzer 2.0 sa pouzivatelia musia prihlasit. Akcie, ktoré

mézu vykonavat, su obmedzené a definované podfa ich pouzivatel'skych profilov.

Poznamka: Moznost User Management (Sprava pouzivatelov) je k dispozicii len pouzivatelom s profilmi ,Administrator”
(Spravca) alebo ,Laboratory Supervisor” (Veduci laboratéria).

Poznamka: User Access Control (Kontrola pristupu pouzivatelov) je mozné povolit alebo zakazat v nastaveniach General
settings (VSeobecné nastavenia) v ¢asti System Configuration (Konfiguracia systému) v ponuke Options (Moznosti).

Moznost User Management (Sprava pouzivatelov) povoluje pouzivatelom s profilmi ,Administrator* (Spravca) a
,Laboratory Supervisor‘ (Veduci laboratdria) pridat novych pouzivatelov do systému, definovat ich opravnenia a
pouzivatel'ské profily a aktivovat alebo deaktivovat pouzivatelov.

User Management (Sprava pouzivatelov) sa mdze ovladat dialkovo prostrednictvom funkcie QIlAsphere, ak je tato
aktivovana v konfiguraciach systému. Dal$ie informéacie najdete v &asti 6.7.3.

Poznamka: Dérazne sa odporuca aktivovat moznost User Access Control (Kontrola pristupu pouzivatelov). V rezime
jedného pouzivatela ma tento pouzivatel vSetky administratorské prava bez ovladania pouzivatelov, ktori sa prihlasia do
analyzatora QlAstat-Dx Analyzer 2.0. V8etky funkcie a vlastnosti budu dostupné bez obmedzeni. Okrem toho dorazne
odporuc¢ame vytvorit pri prvom prihlaseni minimalne jeden pouzivatel'sky ucet bez role ,Administrator (Spravca). Ak

jediny pouzivatel analyzatora QlAstat-Dx Analyzer 2.0 v sebe spaja rézne pouzivatel'ské roly, vratane roly ,Administrator’
(Spravca), existuje velke riziko, ze pristup do softvéru sa uplne zablokuje v pripade, Ze tento pouzivatel zabudne heslo.
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Tabulka 5 zobrazuje pouzivatelské profily, ktoré su dostupné v analyzatore QlAstat-Dx Analyzer 2.0.

Tabulka 5. Pouzivatel'ské profily dostupné v analyzatore QlAstat-Dx Analyzer 2.0

Pouzivatel'sky
profil

Prava

Priklad

Administrator
(Spravca)

Laboratory
Supervisor
(Veduci

laboratoéria)

Advanced User
(Pokrogily
pouzivatel)

Basic User
(Zakladny
pouzivatel)

6.5.1.

Uplné

Pridanie novych pouzivatelov, zavedenie novych testov do odberu testov, spustenie testov
a zobrazenie vysledkov od vSetkych pouzivatelov vratane ulozenia a tlace sprav,
generovanie pomocnych bali¢kov, vytvorenie a otvorenie archivov, konfiguracia nastaveni
externej kontroly, spustenie testov externej kontroly, odstranenie tlacovych uloh,
zobrazenie a potvrdenie oznameni, preberanie suborov z rozhrania QlAsphere a
komentovanie vysledkov

Spustenie testov, zobrazenie podrobnych vysledkov vlastnych pouzivatelskych testov
(napr. amplifikacné grafy atd.) vratane uloZenia a tlae sprav, generovanie pomocnych
bali€kov, spustenie testov externej kontroly, odstranenie tlacovych uloh, zobrazenie a
potvrdenie oznameni, preberanie suborov z rozhrania QlAsphere a komentovanie
vysledkov

Spustenie testov, zobrazenie vysledkov vlastnych pouzivatelskych testov bez podrobnosti
(napr. pozitivne/negativne vysledky) vratane uloZenia a tlace sprav, generovanie
pomocnych bali¢kov, zobrazenie a potvrdenie oznameni a preberanie suborov z
rozhrania QlAsphere

Pristup a sprava zoznamu pouzivatelov

Zodpovednost za vybavenie/IT

Laboratory head (Riaditel laboratéria)

Mikrobiolég, laboratorny technik

Poskytovatel zdravotnej starostlivosti

(napr. zdravotna sestra, lekar,
prakticky lekar atd.)

Pri pristupe a spravovani pouzivatelov systému postupujte podla nizSie uvedenych krokov:

1. Stladte Options > User Management (MozZnosti > Sprava pouzivatelov) na konfiguraciu pouzivatelov. Obrazovka

User Management (Sprava pouzivatelov) sa zobrazi v oblasti s obsahom na displeji (obrazok 50).

administrator

User Management 13:06 2023-02-20

F

1 Available

USER

administrator

labuser

technician

Run Test

v

View
> Results

©

Options

Log Out

&o Add User

E Save

Obrazok 50. Obrazovka Sprava pouzivatelov.

® Cancel

2. Zo zoznamu v lavom stipci oblasti s obsahom vyberte pouzivatela, ktorého chcete spravovat (obrazok 51).
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administrator User Management 13:06 2023-02-20

F

1 Available °
Run Test
USER USER OPTIONS
administrator S e
B
View
|abFJS§7rr > Password Results
technician S @
S User Active
Options
Assign user profile >
Assign Assays > @
Assav Statistics > Log Out
&o Add User E Save ® Cancel

Obrazok 51. Vyber a sprava pouzivatel'ov.

3. Podla potreby vyberte a upravte nasledujuce moznosti:

® User Name (Meno pouzivatela): Umoziiuje zobrazit meno pouzivatela.

® Password (Heslo): Umozriuje zmenit heslo pre daného pouzivatela
Heslo musi obsahovat 6 — 15 znakov zahffajucich Cislice 0 — 9, pismena a — z, A — Z a nasledujuci $pecialny znak: _ [
;'\, /-=~1@#$ % "&*()+{}:"| <> ?,<medzera>.

® User Active (Aktivny pouzivatel) (yes/no (ano/nie)): Umoznuje zmenit, ¢i je pouzivatel aktivny alebo nie. Neaktivni
pouzivatelia nemaju povolené prihlasit’ sa alebo vykonavat akukolvek akciu v systéme.

® Assign User Profile (Pridelit pouzivatelsky profil): Umozriuje pridelit tomuto pouzivatelovi iny pouzivatelsky profil
(napr. Administrator (Spravca), Laboratory Supervisor (Veduci laboratéria), Advanced User (Pokrogily pouzivatel),
Basic User (Zakladny pouzivatel)). Vyberte prislusny pouzivatel'sky profil zo zoznamu v pravej Casti oblasti s obsahom
(obrazok 52).

administrator User Management 13:06 2023-02-20
1 Available °
Run Test
USER USER OPTIONS USER PROFILE
administrator > Administrator e
S Laboratory »
i lew
|abFJS(7§7I’7 > Password Supervisor Results
R Advanced User
technician S @
B , Basic U v
— User Active sl .
Options
Assign user profile >
Assign Assays > @
Assav Statistics > Log Out
&5 Add User E Save ® Cancel

Obrazok 52. Priradenie pouzivatel'skych profilov pouzivatelom.
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® Assign Assays (Pridelit testy): Umoznuje definovat testy z databazy testov, ktoré je pouzivatelovi povolené spustit’.

Vyberte testy zo zoznamu v pravej Casti oblasti s obsahom (obrazok 53)

administrator

F

User Management

1 Available
USER USER OPTIONS
administrator >
labuser > Password

tef:hTiia,n, . > User Active
Assign user profile >

>
>

Assign Assays
Assay Statistics

&9 Add User

Obrazok 53. Priradenie testov pouzivatelom.

Igl Save

11:09 2023-09-13

Run Test

e

RP SARS-CoV-2 (% . View Results

©

Options

)

Log Out

ASSAYS

Gl2

® Cancel

Assay Statistics (Statistiky testu): Zobrazuje po&et opakovani testu vybranym pouzivatelom (obrézok 54).

administrator

F

User Management

1 Available
USER USER OPTIONS
administrator S
labuser 5 Password

11:122023-09-13

Run Test
ASSAY STATISTICS
GI2

Executed tests
0

RP SARS-CoV-2

Executed tests

View Results

. 0
technician
IS > User Active @
Opti
Assign user profile > "
Assign Assays >
Assay Statistics > @
Log Out
&5 Add User E Save ® Cancel

Obrazok 54. Zobrazenie Statistik testu.

4. StlaCenim Save (Ulozit) a Confirm (Potvrdit) ulozte zmeny. Ak chcete zmeny zrusit, stlacte tlaCidlo Cancel (Zrusit) a

Confirm (Potvrdit).

6.5.2. Pridavanie pouzivatelov

Ak chcete pridat novych pouzivatefov do analyzatora QlAstat-Dx Analyzer 2.0, postupujte podla nasledujucich krokov:

1. Stlacte Options > User Management (MozZnosti > Sprava pouzivatelov) na konfiguraciu pouzivatelov. Obrazovka

User Management (Sprava pouzivatelov) sa zobrazi v oblasti s obsahom na displeji (obrazok 55).
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administrator User Management 13:07 2023-02-20

F

1 Available °
Run Test
USER USER OPTIONS
administrator S User Name e
S
View
Iabgsei > Password Results
technician >
e User Active @
Options
Assign user profile >
> (©)
> Log Out
&o Add User E Save ® Cancel

Obrazok 55. Pridanie nového pouzivatela.
2. Ak chcete pridat nového pouzivatela do systému, stlacte tlacidlo Add User (Pridat pouzivatela) v favej spodnej Casti
obrazovky.

3. Pomocou virtualnej klavesnice zadajte hodnoty do poli User Name (Meno pouzivatela) a Password (Heslo) pre
noveho pouzivatela.

Pouzivatelské meno musi pozostavat z 1 — 20 znakov zahffiajucich iba €Cislice 0 — 9, pismendaa—-z, A-Za
nasledujuce Specialne znaky: _, <medzera>.

Heslo musi pozostavat z 6 — 15 znakov a obsahovat Cislice 0 — 9, pismena a — z, A — Z a nasledujuce Specialne
znaky: _[1;'\,./-=~1@#$ % "&*()+{}:"]|<>7?,<medzera>.

4. Stlacte Assign User Profile (Pridelit pouzivatel'sky profil) a priradte novy pouzivatelsky profil (zo zoznamu vpravo od
oblasti s obsahom) novému pouzivatelovi (obrazok 56).

administrator User Management 13:07 2023-02-20
1 Available °
Run Test
USER USER OPTIONS USER PROFILE
administrator S User Name Administrator e
S newUser Laboratory
i View
Iabusgﬁrr > Password Supervisor B e
Advanced User v
technician >

©

E—— User Active Basic User

Assign user profile >

Options

A\
=
(o]

«Q
O@
c
=

&o Add User E Save ® Cancel

Obrazok 56. Priradenie pouzivatel'ského profilu novému pouzivatelovi.

5. Stlacte Assign Assays (Pridelit testy) a vyberte testy (zo zobrazeného zoznamu testov), ktoré méze pouzivatel
spustat.
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6. Stlacenim Save (Ulozit) a Confirm (Potvrdit) ulozte informacie. Novy pouzivatel bol nastaveny a okamzite ma

povolenie na prihlasenie do analyzatora QlAstat-Dx Analyzer 2.0.

6.6. Sprava testov

V ponuke Assay Management (Sprava testov) je mozné spravovat testy a pristupovat k informaciam a Statistikam

sUvisiacim s testom.

Poznamka: Moznost Assay Management (Sprava testov) je k dispozicii len pouzivatefom s profilmi ,Administrator”

(Spravca) alebo ,Laboratory Supervisor” (Veduci laboratéria).

6.6.1.

Sprava dostupnych testov

Ak chcete spravovat testy na analyzatore QlAstat-Dx Analyzer 2.0, postupuijte podfa nasledujucich krokov:

1. Stladte Options > Assay Management (Moznosti > Sprava testov) na pristup k obrazovke Assay Management

(Spréava testov). Dostupné testy st uvedené v prvom stipci v oblasti s obsahom (obrazok 57).

administrator

F

1 Available

AVAILABLE ASSAYS

Gl2

RP SARS-CoV-2

[& mport

>

Assay Management

RP SARS-CoV-2

Assay Active
Assay ID
04053228038870

Assay Description

QlAstat-Dx® Respiratory
SARS-CoV-2 Panel

Assay Version

LIS assay name >

Assay Notes >

Obrazok 57. Sprava dostupnych testov.

11:13 2023-09-13

Run Test

View Results

o
=]
=3
]
3
7]

Log Out

E Save ® Cancel

2. V lavom stipci v oblasti s obsahom stlaéte nazov testu, ktory chcete spravovat.

3. Vyberte jednu z moznosti uvedenych v tabufke 6.
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Tabulka 6. MoZnosti spravy testov

Moznost’ Popis

Assay Active (Aktivny test) Toto tlacidlo umozriuje nastavit' test na aktivny alebo neaktivny.
Poznamka: Testovacie kazety QlAstat-Dx je mozné testovat len v pripade, Ze je test aktivny.

Assay ID (ID testu) Poskytuje identifikacné Cislo testu.
Assay Description Poskytuje nazov testu.
(Popis testu)

Assay Version (Verzia testu)  Poskytuje verziu testu.

LIS assay name Poskytuje informacie o teste LIS.

(Nazov testu LIS)

Assay Notes Poskytuje dalSie informacie o teste.

(Poznamky k testu)

Type of Samples Poskytuje zoznam réznych typov vzoriek podporovanych testom.

(Typy vzoriek)

List of Analytes Poskytuje zoznam analytov, ktoré su detegované a identifikované testom.

(Zoznam analytov)

List of controls Poskytuje zoznam internych kontrolnych analytov, ktoré st implementované v teste.
(Zoznam kontrol)

Assay Statistics Poskytuje pocet testov, ktoré sa vykonali na analyzatore QlAstat-Dx Analyzer 2.0 pre vybrany test, ako aj pocet
(Statistiky testu) pozitivnych, negativnych, netspesnych a zruSenych testov.

Epidemiology report Poskytuje moznost vytvorit’ epidemiologickl spravu pre vybrany rozsah udajov.

(Epidemiologicka sprava)

6.6.2. Vytvorenie epidemiologickej spravy

Epidemiologicka sprava je sprava, v ktorej sa vypocitaju vysledky testu pre vybrany test a ¢asovy interval pre kazdy patogén
tohto testu.

Nasledujuce informacie sa zobrazia v zahlavi epidemiologickej spravy:

e Verzia testu

e  Zvoleny datum

e  Sériové Cislo kazdého OM v datovom subore

e  Sériové Cislo kazdého AM v datovom subore

o Velkost kohorty: celkovy pocCet jedineCnych ID pacienta v testoch vo zvolenom datovom subore. Ak pre
akykolvek vysledok vo zvolenom datovom subore chyba ID pacienta, bude udaj pre velkost kohorty ,n/a“
(nevztahuje sa)

e  Celkovy pocet vysledkov vo zvolenom datovom subore

e Pocet neuspednych alebo neplatnych vysledkov vo zvolenom datovom subore

Nasledujuce informacie sa zobrazia v hlavnej Casti epidemiologickej spravy:

e Nazov testu

e Zaznamenaneé vysledky: po€et zaznamenanych vysledkov vo zvolenom datovom subore pre dany analyt

e Nezaznamenané vysledky: pocet nezaznamenanych vysledkov vo zvolenom datovom subore pre dany analyt

e Nejednoznacné vysledky (ak je to relevantné): pocet nejednoznacénych vysledkov vo zvolenom datovom subore
pre dany analyt

e Iné vysledky (ak je to relevantné): pocet vSetkych ostatnych vysledkov vo zvolenom datovom subore pre dany
analyt

e  Stredna hodnota Ct: median vSetkych hodnét Ct daného analytu
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Poznamka: Vysledky, ktoré sa predtym archivovali a odstranili, sa nepoé&itaji do epidemiologickej spravy. Dal$ie informacie

o archivoch najdete v Casti 6.12.

Na vytvorenie epidemiologickej spravy postupujte nasledovne:

1. Postupujte podra krokov 1 az 3 v ¢asti Sprava dostupnych testov.

2. Rolujte na spodok zoznamu moznosti v tabulke 6 a kliknite na moznost’ Epidemiology Report (Epidemiologicka
sprava).

3. V poli From Date (Od datumu) vyberte pociatoény datum, od ktorého sa vysledky pocitaju, a v poli Until Date (Do
datumu) kone¢ny datum, do ktorého sa vysledky pocitaju.
Poznamka: Datum zaciatku a konca je zahrnuty do vypoctu.

4. Kliknite na moznost Save Report (Ulozit spravu).

5. Vyberte umiestnenie, kde chcete spravu uloZit.

6.6.3. Importovanie novych testov
Ak chcete importovat’ nové testy do analyzatora QlAstat-Dx Analyzer 2.0, postupujte podla nasledujucich krokov:

Ak chcete importovat’ novy test (testy) do analyzatora QlAstat-Dx Analyzer 2.0, mézete testy prevziat priamo z rozhrania
QlAsphere do pristroja (pozrite si €ast 6.9) alebo ich musite ulozit do hlavného prie€inka pamatového zariadenia USB.

1. Pri importovani testov z pamatového zariadenia USB vlozte pamatové zariadenie USB, ktoré obsahuje stubor(-y)
definicie testu na importovanie, do portu USB analyzatora QlAstat-Dx Analyzer 2.0.
Poznamka: Na kratkodobé uloZenie a prenos Udajov sa odporuc¢a pouzit dodané ulozné USB zariadenie. Pouzivanie
ulozného zariadenia USB nepodlieha Ziadnym obmedzeniam (napr. kapacita pamate alebo riziko prepisania), ktoré by
sa malo pred pouzitim zvazit.

2. Ak chcete importovat novy test (testy) do analyzatora QlAstat-Dx Analyzer 2.0, stlacte tlacidlo Options (Moznosti) a
potom tlac¢idlo Assay Management (Sprava testov). Obrazovka Assay Management (Sprava testov) sa zobrazi v
oblasti s obsahom na displeji (obrazok 58).

administrator Assay Management 11:13 2023-09-13

1 Available 5 °

Run Test
AVAILABLE ASSAYS

Gl2 >

RP SARS-CoV-2 >

View Results

©

Options

Log Out

E Import E Save ® Cancel

Obrazok 58. Obrazovka Sprava testov.
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3. Stlacte ikonu Import (Import) v lavej spodnej ¢asti obrazovky.

4. Z rozhrania QlAsphere alebo paméatového zariadenia USB vyberte subor definicie testu, ktory zodpoveda testu, ktory

sa ma importovat.

Poznamka: Vyber z rozhrania QlAsphere je momentalne mozny len vtedy, ak bolo akékolvek paméatové zariadenie

USB pripojené po poslednom spusteni pristroja.
5. Zobrazi sa dialégové okno na potvrdenie importovania suboru.
6. MOze sa zobrazit dialdgové okno na prepisanie aktualnej verzie novou. Stlacte yes (ano) na prepisanie.

Poznamka: Ak su vzorky externej kontroly (EK) spojené s testom, ktory sa prepiSe novou verziou, vzorka EK sa

resetuje a musi sa znova konfigurovat. Dal$ie informécie najdete v &asti 6.11.

7. Test sa aktivuje vyberom moznosti Assay Active (Test aktivny) (obrazok 59).

administrator Assay Management 11:14 2023-09-13
1 Available °
Run Test
AVAILABLE ASSAYS RP SARS-CoV-2
GI2 > Assay Active e
RP SARS-CoV-2 > Assay ID View Results
04053228038870

Assay Description
QlAstat-Dx® Respiratory
SARS-CoV-2 Panel

o
=
=]
®

Assay Version pti

LIS assay name >

-
(o]
«Q
o
=
=3

Assay Notes >
E Import E Save ® Cancel

Obrazok 59. Aktivacia testu.

6.7. Konfiguracia analyzatora QlAstat-Dx Analyzer 2.0

V ponuke System Configuration (Konfiguracia systému) je mozné spravovat systém QIAstat-Dx Analyzer 2.0 a definovat

parametre Specifické pre region.

6.7.1. Regionalne nastavenia

Ak chcete nakonfigurovat regionalne nastavenia na analyzatore QlAstat-Dx Analyzer 2.0, postupujte podla nasledujucich

krokov:

1. Stla¢te Options > System Configuration (Moznosti > Konfiguracia systému).

2. Vyberte moznost Regional (Regionalne) zo zoznamu Settings (Nastavenia) v lavom stipci. Podla potreby vyberte a

definujte nastavenia uvedené v tabulke 7.
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Tabulka 7. Dostupné regionalne nastavenia

Nastavenie  Popis

Date Definuje systémovy datum (rok, mesiac, den) (obrazok 60). Toto nastavenie sa synchronizuje automaticky, ked’ sa pomocka pripoji k

(Datum) rozhraniu QlAsphere Base.

Time (Cas) Definuje systémovy ¢as (hodiny, minuty). Toto nastavenie sa synchronizuje automaticky, ked sa pomécka pripoji k rozhraniu
QlAsphere Base.

Time Zone Definuje €asové pasmo systému. Toto nastavenie mozno bude potrebné upravit manuaine po vytvoreni pripojenia s rozhranim

(Casové QlAsphere Base, pretoze momentéalne sa nesynchronizuje automaticky.

pasmo)

Date format  Definuje format datumu. K dispozicii st nasledujuce moznosti (obrazok 61):

g':é‘:;"n:it) DD-MM-RRR, DD-MM-RR, MM-DD-RRRR, RRRR-MM-DD (predvolené) alebo RR-MM-DD

Date Definuje oddelova¢ datumu. K dispozicii su nasledujice moznosti (obrazok 63):

separator «

(Oddefovag ™, .

datumu) — (predvolené)
W

Time format  Definuje format ¢asu. K dispozicii su nasledujuce moznosti (obrédzok 63):

g:a‘;'l']";ét 24 hodin (hh:mm:ss) (predvolené) alebo 12 hodin (hh:mm:ss a.m./p.m.)

Language Definuje jazyk systému (obrazok 64).

(Jazyk)

administrator

Angli¢tina (predvoleny jazyk)

Spanieltina (zobrazena ako Espafiol)

Mexicka Spaniel€ina (zobrazena ako Espafiol de México)
Fincina (zobrazena ako Suomi)

Francuzstina (zobrazena ako Frangais)

Talian¢ina (zobrazena ako Italiano)

Néréina (zobrazuje sa ako Norsk)

Portugal€ina (zobrazena ako Portugués)

Brazilska portugalcina (zobrazena ako Portugués brasileiro)
Svédgina (zobrazena ako Svenska)

Zjednodu$ena ¢instina (zobrazena ako E{A$ )

Tradiéna gintina (zobrazena ako Ei237)

System Configuration 13:08 2023-02-20

F

1 Available °
Run Test
SETTINGS REGIONAL SETTINGS DATE
Regional > Date > e
HIS/LIS > Time > ° ° ° View
on Da Results
QlAsphere Base > Time Zone > 23 02 20
General > Date Format > ° ° ° @
Printer > Date Separator > EELEDs
Network > Time Format >
Network Share > Language > @
Log Out

E Save ® Cancel

Obrazok 60. Nastavenie systémového datumu.
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administrator System Configuration 13:08 2023-02-20

F

1 Available °

Run Test

SETTINGS REGIONAL SETTINGS DATE FORMAT

Regional > Date > DD-MM-YYYY e

HIS/LIS > Time > DD-MM-YY Ve
Results

QlAsphere Base > Time Zone > MM-DD-YYYY

General > Date Format > YYYY-MM-DD v @

Printer > Date Separator > YY-MM-DD Options

Network > Time Format >

Network Share > Language > @
Log Out

E Save ® Cancel

Obrazok 61. Nastavenie formatu systémového datumu.

administrator System Configuration 13:08 2023-02-20
‘I Available °
Run Test
SETTINGS REGIONAL SETTINGS DATE SEPARATOR
Regional > Date > 2023.02.20 e
HIS/LIS > Time > 2023-02-20 v Vidh
Results
QlAsphere Base > Time Zone > 2023_02_20
General > Date Format > 2023/02/20 @
Printer > Date Separator > 2023:02:20 Options
Network > Time Format >
Network Share > Language > @
Log Out

E Save ® Cancel

Obrazok 62. Nastavenie oddelovaca systémového datumu.
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administrator

F

System Configuration

13:08 2023-02-20

1 Available °
Run Test
SETTINGS REGIONAL SETTINGS TIME FORMAT
Regional Date > 24 hours v e
HIS/LIS > Time > 12 hours (am/pm) Bt
Results
QlAsphere Base > Time Zone >
General > Date Format > @
Printer > Date Separator > Options
Network > Time Format >
Network Share > Language > @
Log Out
E Save ® Cancel
Obrazok 63. Nastavenie formatu systémového casu.
administrator System Configuration 13:09 2023-02-20
1 Available °
Run Test
SETTINGS REGIONAL SETTINGS LANGUAGE
Regional Date English v e
HIS/LIS > Time > Espanol e
B L. Results
QlAsphere Base > Time Zone > Espafiol de México
General > Date Format > Suomi @
Printer > Date Separator > Francais Options
Network > Time Format > Italiano
Network Share > Language > Norsk @
Log Out
E Save ® Cancel

Obrazok 64. Nastavenie jazyka systému.

6.7.2. Nastavenia HIS/LIS

Pozrite si ast' 7.

6.7.3. Nastavenia rozhrania QlAsphere base

Systém QIlAsphere pripoji zakaznika so vSeobecnym digitalnym ekosystémom spolo¢nosti QIAGEN, aby mu poskytol
jedine¢nu pouzivatelsku skusenost a pomocou pripojenia zalozeného na cloude zlepSil laboratornu efektivnost a

bezpecénost. Systém QIAsphere sa sklada z tychto komponentov:
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® Pristroje pripravené pre systém QlAsphere od spolocnosti QIAGEN, ktoré sa mézu pripojit k rieSeniu QlAsphere

Aplikacia QlAsphere na monitorovanie pristroja dostupna pre mobilné zariadenia a webovy prehliada¢ na stolné

pouzitie

® Rozhranie QlAsphere Base, ktoré je branou loT (internet veci) pre bezpe&nu komunikaciu siete.

Viac informéacii najdete na stranke QIAGEN.com/QlAsphere.

Postupujte podla pokynov v pouzivatelskej prirucke QlAsphere a pripojte zariadenie QlAsphere Base k rovnakej miestnej
sieti, ku ktorej je pripojeny analyzator QlAstat-Dx Analyzer 2.0. Pocas tohto postupu dostane zariadenie QlAsphere Base

IP adresu, ktora je potrebna v tejto konfiguracii.

Potom na pripojenie analyzatora QlAstat-Dx Analyzer 2.0 k rozhraniu QIAsphere Base postupujte podla nizSie uvedenych

krokov. Ak sa chcete pripojit’ k rozhraniu QlAsphere Base, zaistite, aby boli obidve zariadenia pripojené k tej istej sieti.

1. Stlacte Options > System Configuration (Moznosti > Konfiguracia systému).

2. Vyberte moznost QlAsphere Base zo zoznamu nastaveni v lavom stipci (obrazok 65).

administrator System Configuration
1 Available
SETTINGS QlAsphere Base
Regional > Host
g Communication
HIS/LIS > Host Settings >
QlAsphere Base > Remote
Settings
General > QlAstat-Dx Remote >
Printer 3 Results Application
Network >
Network Share >

Host Settings

IP address / Host name

Host port
443

Password

Timeout (seconds)

5

Igl Save ® Cancel

Obrazok 65. Konfigurovanie pripojenia QlAsphere Base.

3. Vyberte a definujte moznosti v tabulke 8 podla pokynov spravcu siete.
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Tabulka 8. Nastavenia rozhrania QlAsphere base

Moznost’ Popis

Enable Host Communication ~ Povoli pripojenie k rozhraniu QlAsphere Base. Podponuka Host Settings (Nastavenia hostitela) je aktivna len vtedy,
(Povolenie hostitel'skej ak je povolena moznost' ,Host Communication” (Hostitelska komunikacia).

komunikacie) Poznamka: Hostitelsku komunikaciu aktivujte, len ak sa konfiguruju aj zostavajlice hostitelské nastavenia.

IP address/Host name Definuje IP adresu, na ktorej je mozné sa pripojit k rozhraniu QlAsphere Base.

(IP adresa/nazov hostitela)

Host port (Port hostitela) Definuje port hostitela, prostrednictvom ktorého je mozné pripojit sa k rozhraniu QlAsphere base.

Password (Heslo) Definuje heslo, ktoré je potrebné na pripojenie k rozhraniu QlAsphere Base.

Timeout (seconds) Definuje obdobie prerusenia v sekundach, po ktorom sa prerusi kontrola prepojitelnosti, ak nie je mozné sa k
(Prerusenie (sekundy)) rozhraniu QlAsphere Base pripojit.

Check connectivity Stlacenim tlacidla sa skontroluje, ¢i je mozné vytvorit pripojenie s rozhranim QlAsphere Base.

(Kontrola pripojenia)

Remote settings Aktivuje funkciu zmeny konfiguracie pristroja (nastavenia HIS/LIS, General (VSeobecné) a System Log (Systémovy
(Dialkové nastavenia) dennik)) a spravy pouzivatelov na dialku. Pristup k nastroju konfiguracie na dialku je mozny cez rozhranie QlAsphere.

Ak chcete upravovat nastavenia na dialku, musi v pristroji existovat pouzivatelsky uc¢et. Rovnaké pouzivatelské
opravnenia, ktoré platia priamo pre pristroj, platia aj pre vzdialené pracovisko.

Nastavenia zmenené na dialku nemaju vplyv na prebiehajlce testovacie cykly a zmeny sa zaznamenavaju do
systémového dennika.

Poznamka: Je mozné, Ze zmeny vykonané na dialku budu prepisané lokalnymi zmenami v pristrojmi a naopak.

QlAstat-Dx Remote Results Umoznuje pripojenie k aplikacii QlAstat-Dx Remote Results. Samotna aplikacia QlAstat-Dx Remote Results sa da
Application Communication aktivovat prostrednictvom servisu spolo¢nosti QIAGEN.

(Ko_m’ur_1ikécia [FeneEey Dalsie informéacie najdete v pouzivatelskej prirucke k aplikacii QlAstat-Dx Remote Results.
aplikacie QlAstat-Dx Remote ) L ) ) o ) X .
Results) Poznamka: Aktivaciou tejto funkcie sa deaktivuje funkcia komentara (pozrite si ¢ast 5.5.5).

Poznamka: Aktualny stav analyzatora QlAstat-Dx Analyzer 2.0 sa nemusi v aplikacii QlAsphere zobrazit okamzite.

Poznamka: Cas a datum zariadenia sa synchronizuje automaticky po vytvoreni pripojenia s rozhranim QIAsphere Base.

Casové pasmo je ale potrebné nastavit manuéline.

6.7.4. VVSeobecné nastavenia

Ak chcete nakonfigurovat vSeobecné nastavenia na analyzatore QlAstat-Dx Analyzer 2.0, postupujte podla nasledujucich

krokov:

1. Stlacte Options > System Configuration (MozZnosti > Konfiguracia systému).

2. Vyberte moznost General (V$eobecné) zo zoznamu Settings (Nastavenia) v favom stipci. Podla potreby vyberte a

definujte moznosti uvedené v tabulke 9.
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Nastavenie

Tabulka 9. Dostupné v§eobecné nastavenia

Popis

User Access Control
(Kontrola pristupu
pouzivatelov)

Automatic log-off time
(Cas automatického
odhlasenia)

Require password before
executing assay (Vyzadovat
heslo pred vykonanim testu)

Use Patient ID (Pouzit ID
pacienta)

Prefer Patient ID Bar Code
(Preferovat ¢iarovy kéd s ID
pacienta)

Patient ID Mandatory
(Povinné ID pacienta)

Sample ID Mandatory
(Povinné ID vzorky)

Prefer Sample ID Bar Code
(Preferovat ¢iarovy kod s ID
vzorky)

Exclude Modules
(Vylugit moduly)

Number of Results Per Page
(Pocet vysledkov na stranu)

Show Previously Logged-in
User IDs (Zobrazit predtym
prihlasené ID pouzivatelov)

Require Password to Log In
(Vyzadovat heslo na
prihlasenie)

Max. Number of Technical
Log files (Max. pocet
technickych stborov dennika)

Hide curves in PDF reports
(Skryt krivky v spravach PDF)

Hide comments in PDF
reports (Skryt komentare v
spravach PDF)

Restore Factory Default
(Obnovit predvolené vyrobné
nastavenia)

Povoluje moznost User Access Control (Kontrola pristupu pouzivatelov), ktoré vyzaduje, aby sa vSetci pouzivatelia
prihlasili do systému a obmedzuje pouzivatelom vykonavat iba tie akcie, ktoré su povolené v ich pouzivatelskom
profile.

Ak tato moznost nie je povolena, nie je mozné rozliSovat medzi pouzivatelmi. VSetky funkcie budu k dispozicii, ako
keby boli spustené v profile ,Administrator* (Spravca).

Tato moznost je predvolene povolena.
Aktivne iba ak je povolena moznost User Access Control (Kontrola pristupu pouzivatelov). Toto nastavenie definuje

¢asovy interval, po uplynuti ktorého sa pouzivatel automaticky odhlasi zo systému, pretoze analyzator QlAstat-Dx
Analyzer 2.0 neprijal vstup pouzivatela. Povoleny rozsah je 5 minut az 99:59 hodin. Predvolené: 30 minut.

Vstup pouzivatela, ako je pohyb kurzora, kliknutie kurzorom, stlacenie klavesu na externej klavesnici alebo dotyk na
dotykovom displeji, vynuluje ¢as automatického odhlasenia.

Ak pouzivatel zada udaje (napriklad na obrazovke Run Test (Spustit test)), ked déjde k automatickému odhlaseniu,
tieto udaje sa stratia.

Aktivne iba ak je povolena moznost User Access Control (Kontrola pristupu pouzivatelov). Ked je toto nastavenie
aktivované, vSetci pouzivatelia budi musiet zadat' heslo po stlaceni tlacidla Confirm (Potvrdit) pred vykonanim testu.

Ak je aktivovana moznost Use Patient ID (Pouzit' ID pacienta), softvér QlAstat-Dx poskytne pouzivatefom moznost
zadat' ID pacienta alebo naskenovat ID pacienta pri priprave testu (pozrite si ¢ast' 5.3).

Urcuje, ¢i budu pouzivatelia vyzvani na skenovanie Patient ID (ID pacienta) pomocou ¢itacky Ciarovych kédov.
Predvolené: Disabled (Zakazané).

Aktivne iba vtedy, ked je povolena moznost Use Patient ID (Pouzit ID pacienta). Ked je aktivované, pouzivatelia
budu musiet zadat' ID pacienta pred vykonanim testu. Ak nie je aktivované, pouzivatelia mézu ponechat’ tdajové
pole s ID pacienta prazdne.

Predvolené: Disabled (Zakazané).
Ked je aktivované, pouzivatelia budu musiet zadat ID vzorky pred vykonanim testu. Ak nie je aktivované,

pouzivatelia m6zu nechat (idajové pole Sample ID (ID vzorky) prazdne a analyzator QlAstat-Dx Analyzer 2.0
automaticky vygeneruje jedine¢né ID vzorky.

Predvolené: Disabled (Zakazané).

Urcuje, ¢i budl pouzivatelia vyzvani na skenovanie Sample ID (ID vzorky) pomocou &itacky Ciarovych kédov.
Predvolené: Disabled (Zakazané).

Umoziiuje vylucit zadané analytické moduly z prebiehajucich testov. MézZe to byt uzito¢né v pripade, Ze existuje
predpoklad na zlyhanie modulu.
Predvolené: Disabled (Zakazané).

Toto nastavenie definuje pocet vysledkov zobrazenych na strane na obrazovke View Results (Zobrazit vysledky).

Aktivne iba ak je povolena moznost User Access Control (Kontrola pristupu pouzivatelov). Ak je toto nastavenie
povolené, na prihlasovacej obrazovke sa zobrazi zoznam predtym prihlasenych pouzivatelov.

Predvolené: Enabled (Povolené).

Aktivne iba ak je povolena moznost User Access Control (Kontrola pristupu pouzivatelov). Ak je toto nastavenie
povolené, vSetci pouzivatelia musia pri prihlasovani zadat svoje heslo. Ak je tato moznost zakazana, na prihlasenie
sa bude vyzadovat iba ID pouzivatela.

Predvolené: Enabled (Povolené).

Pocet technickych suborov dennika méze zmenit pouzivatel.

Skryje amplifikacné krivky z ulozenych a vytlacenych sprav PDF.

Skryje komentare z uloZzenych a vytlaéenych sprav PDF.

Umoznuje resetovat systém spat' na vSetky predvolené vyrobné nastavenia.

6.7.5. Nastavenia tlaCiarne

Moznost nastavenia Printer (Tlaciaren) umozfuje vybrat systémovu tlaciaren. Analyzator QIlAstat-Dx Analyzer 2.0
umoznuje pouzivat sietové tlaciarne alebo tladiarne pripojené k operacnému modulu cez porty USB na zadnej strane
pristroja.
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Ak chcete upravit nastavenia tlaciarne na analyzatore QlAstat-Dx Analyzer 2.0, postupujte podla nasledujucich krokov:

1. Stlacte Options > System Configuration (Moznosti > Konfiguracia systému).
2. Vyberte moznost Printer (Tlagiarefi) zo zoznamu nastaveni v lavom stipci.

3. Vyberte tlaciarefi zo zoznamu dostupnych tlaciarni (obréazok 66).

administrator System Configuration 13:10 2023-02-20
1 Available o
Run Test
SETTINGS SELECT A PRINTER
Regional > Add new printer > e
HIS/LIS b Default B/W USB Viowi
Results
QlAsphere Base >
General b
Printer > Options
Network >

Network Share >

—
o
(=]
(o]
S
=

E Save ® Cancel

Obrazok 66. Vyber systémovej tlaciarne.

Informacie o inStalacii a odstraniovani tlaciarne pripojenej cez USB alebo siet najdete v prilohe 12.1.

6.7.6. Nastavenia siete

Moznost Network (Siet) umozniuje pripojit analyzator QlAstat-Dx Analyzer 2.0 k sieti, umozfiuje pristupovat k siefovym
tlaCiarnam a poskytuje pripojenie k HIS/LIS a QlAsphere Base. Podrobnosti o konfiguracii sietovych nastaveni vam
poskytne spravca siete.

Poznamka: Polas skuSobnej prevadzky nemerite nastavenia siete.

Ak chcete definovat nastavenia siete, postupuijte podla tychto krokov:
1. StlaCte Options > System Configuration (Moznosti > Konfiguracia systému).

2. Vyberte moznost Network (Siet) zo zoznamu nastaveni v lavom stipci (obrazok 67).
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administrator

F

1 Available
SETTINGS
Regional
HIS/LIS
QlAsphere Base

General

VvV VvV

Printer
Network >

Network Share >

System Configuration 13:10 2023-02-20

Run Test

NETWORK SETTINGS IPv4 SETTINGS

Automatic IP
IPv4 add
S =)
’ View
Enable IPv4 Subnet mask Results
255.255.255.0
IPv4 Settings > @
- Default gateway
Frable [Pve . e 192.168.1.1 Options
>

Preferred DNS server

®

Alternate DNS server

E Save ® Cancel

Log Out

Obrazok 67. Konfiguracia sietovych nastaveni.

3. Vyberte a definujte moznosti v tabulke 10 podfa pokynov spravcu siete.

Tabulka 10. Nastavenia siete

Moznost’

Popis

Automatic IP (DHCP)
(Automaticka IP adresa
(DHCP))

Obtain IPv4 DNS address
automatically (Automaticky
ziskat adresu IPv4 DNS)

Preferred IPv4 DNS Server
(Preferovany server IPv4 DNS)

Alternate IPv4 DNS Server
(Alternativny server IPv4 DNS)

Obtain IPv6 DNS address
automatically (Automaticky
ziskat adresu IPv6 DNS)

Preferred IPv6 DNS Server
(Preferovany server IPv6 DNS)

Alternate IPv6 DNS Server
(Alternativny server IPv6 DNS)

Use IPv4 (Pouzit IPv4)

IPv4 address (Adresa IPv4)
Subnet mask (Maska podsiete)

Default Gateway (Predvolena
brana)

Use IPv6 (Pouzit IPv6)

IPv6 address (Adresa IPv6)

Subnet prefix length (Dizka
predpony podsiete)

Enable Shell (Aktivovat
rozhranie ovladania systému)

Enable CUPS (Aktivovat
CUPS)

Umoziiuje jednotke ziskat adresu IP zo siete pomocou DHCP. Podponuka DNS Settings (Nastavenia DNS) je aktivna
len vtedy, ak je povolena moznost ,Automatic IP (DHCP)“ (Automatické IP (DHCP)).

Umoziiuje jednotke ziskat' konfiguraciu IPv4 DNS zo siete pomocou DHCP. Tato moznost je aktivna len vtedy, ak je
povolena moznost’ ,Automatic IP (DHCP)* (Automatické IP (DHCP)).

Definuje primarny server IPv4 DNS. Tuto mozZnost najdete bud v DNS Settings (Nastavenia DNS), alebo IPv4 Settings
(Nastavenia IPv4).

Definuje sekundarny server IPv4 DNS. Tuto moznost najdete bud v DNS Settings (Nastavenia DNS), alebo IPv4
Settings (Nastavenia IPv4).

Umozriuje jednotke ziskat' konfiguraciu IPv6 DNS zo siete pomocou DHCP. Tato moznost je aktivna len vtedy, ak je
povolena moznost ,Automatic IP (DHCP)" (Automatické IP (DHCP)).

Upozorfiujeme, Ze je mozné, Ze siet prideli si¢asne viacero adries IPv6.

Definuje primarny server IPv6 DNS. Tuto mozZnost najdete bud v DNS Settings (Nastavenia DNS), alebo IPv6 Settings
(Nastavenia IPv6).

Definuje sekundarny server IPv6 DNS. Tuto moznost najdete bud v DNS Settings (Nastavenia DNS), alebo IPv6
Settings (Nastavenia IPv6).

Aktivuje pouzitie protokolu IPv4. Tato moznost je aktivna len vtedy, ak je aktivovana moznost’ ,Automatic IP (DHCP)*
(Automatické IP adresa (DHCP)). Podponuka IPv4 Settings (Nastavenia IPv4) je aktivna len vtedy, ak je aktivovana
moznost' ,Use IPv4“ (Pouzit IPv4).

Definuje manualne nakonfigurovanu adresu IPv4 operac¢ného modulu.
Definuje masku podsiete IPv4.
Definuje predvolenu branu IPv4 alebo IPv6.

Aktivuje pouzitie protokolu IPv6. Tato moznost je aktivna len vtedy, ak je aktivovana moznost ,Automatic IP (DHCP)*
(Automaticka IP adresa (DHCP)). Podponuka IPv6 Settings (Nastavenia IPv6) je aktivna len vtedy, ak je aktivovana
moznost ,Use IPv6® (Pouzit IPv6).

Definuje manualne nakonfigurovanu adresu IPv6 opera¢ného modulu.
Definuje dizku predpony podsiete IPv6.

Aktivuje doCasné pripojenie k pristroju prostrednictvom rozhrania ovladania systému. Tato moznost je vyhradena len
pre servisnych technikov spolo¢nosti QIAGEN.

Aktivuje docasny pristup k webovému rozhraniu CUPS pristroja.
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6.7.7. Zdielany prostriedok

Moznost Network Share (Zdielany prostriedok) umoznuje vyber zdielanych prostriedkov. Analyzator QlAstat-Dx Analyzer
2.0 umoznuje pouzit zdielané prostriedky, ktoré bezia vo verzii 2 a 3 protokolu SMB. Informacie o tom, ¢i je tento protokol
podporovany vo vasej IT infrastruktire vam poskytne vas miestny IT tim. Zdielané prostriedky je mozné vybrat ako
umiestnenia na uloZenie zaloh a automatickych archivov.

Ak chcete pridat zdielany prostriedok do analyzatora QlAstat-Dx Analyzer 2.0, postupujte podla nasledujucich krokov:
1. Stlacte Options > System Configuration (MoZnosti > Konfiguracia systému).

2. Vyberte moznost Network Share (Zdielany prostriedok) zo zoznamu nastaveni v lavom stipci.
3. Stlacte Add new share (Pridat nové zdielanie) (obrazok 68).

administrator System Configuration 13:11 2023-02-20
1 Available °
Run Test
SETTINGS NETWORK SHARE SHARE SETTINGS
Regional > Add new share > Local alias
New Share
HIS/LIS > View
QlAsphere Base 5 IP address / Server name Results
General > @
Share name -
Printer > Options
Network >
Folder
Network Share >
Log Out
E Save ® Cancel
Obrazok 68. Pridanie zdielaného prostriedku.
4. Vyberte a definujte moznosti v tabulke 11 podla pokynov spravcu siete.
Tabulka 11. Nastavenia sietového zdielania
MozZnost’ Popis
Local Alias (Miestny alias) Definuje nazov zaznamu, pod ktorym je mozné prostriedok vybrat v inych ponukach aplikacie (napr. pri ukladani
zalohy).
IP address/Server name Definuje server alebo IP adresu, na ktorej sa nachadza zdielany prostriedok.
(IP adresa/nazov servera)
Share name (Nazov Definuje nazov zdielaného prostriedku.
prostriedku)
Folder (Priecinok) Definuje cestu ku konkrétnemu priec¢inku na zdielanom prostriedku. Cesta pouziva symbol ,/“ (bez Gvodzoviek) na

oddelenie nazvov priecinkov (napr. ,prie¢inok/podpriecinok®).
Domain name (Nazov domény)  Definuje nazov domény, ku ktorej je priradeny server, na ktorom sa nachadza zdielany prostriedok.

User Name (Meno pouzivatela)  Definuje meno pouzivatela, ktoré sa pouziva na pripojenie k zdiefanému prostriedku. Nezabudnite, Ze pouzivatel
musi mat prava na zapisovanie na zdielany prostriedok.

Password (Heslo) Definuje heslo, ktoré sa pouZiva na overenie mena pouzivatela.

Check connectivity Skontroluje, ¢i je mozné vytvorit pripojenie k zdielanému prostriedku. Zobrazi sa vyskakovacie okno s vysledkami
(Kontrola pripojenia) pokusu o pripojenie.

Remove Share (Odobrat Odoberie nakonfigurovany zdiefany prostriedok.

prostriedok) Poznamka: Toto tlacidlo je viditelné len pri editovani existujliceho zdiefaného prostriedku.

Poznamka: Ak niektoré Specialne znaky (napr. \ ) chybaju v aktualnom rozlozeni klavesnice, prepnite rozlozenie klavesnice
pomocou tlacidla ID v spodnej ¢asti na anglicku klavesnicu, kde najdete vSetky Specialne znaky.

Priklad konfiguracie zdielanej siete najdete v tabulke 12.

Priklad trasy pre zdielanu siet je nasledujuci: \\Server123.qgiagen.com\ExampleShare\FolderA\SubfolderB
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Tabulka 12. Priklad nastavenia zdielanej siete

Moznost’ Priklad

Local Alias (Miestny alias) NetworkShare1 (Zdielanie siete 1)

IP address/Server name Server123

(IP adresa/nazov servera)

Share name ExampleShare (Priklad prostriedku)

(Nazov prostriedku)

Folder (Priecinok) FolderA\SubfolderB (Priecinok A/Podpriecinok B)

Domain name (Nazov domény)  giagen.com
User Name (Meno pouzivatela)  pouzivatel
Password (Heslo) strongPassword (silné heslo)

6.7.8. Systémovy dennik

Systémovy dennik zaznamenava vSeobecné informacie o pouzivani prevadzkovych a analytickych modulov, ako napriklad
pridavanie a lebo odstrariovanie pouzivatelov alebo odstrafiovanie testov, prihlaseni, odhlaseni, zaciatkov testov, problémy
s pripojenim k QIAsphere Base atd. Stlacte tlaCidlo Options > System Configuration > System Log (Moznosti >
Konfiguracia systému > Systémovy dennik) pre pristup k informaciam systémového dennika. V strede obrazovky sa zobrazi
,System Log Capacity“ (Kapacita dennika systému), za ktorym nasleduje obsah dennika. Ak chcete exportovat obsah,
stlaCte Export Log File (Exportovat subor dennika) (obrazok 69).

administrator System Configuration 13:11 2023-02-20
1 Available °
Run Test
SETTINGS SYSTEM LOG
System Log Capacity
Network > 100 MByte Refresh e

Network Share >

View

2023-02-20T13:06:17.579+0100: user administrator logged in
Results

2023-02-20T13:05:47.326+0100: user labuser logged out
System Log >

2023-02-20T13:05:45.991+0100: user labuser logged in
2023-02-20T13:05:37.911+0100: user administrator logged out

Version Info >

2023-02-20T13:03:57.305+0100: results of test 5285935,

©

2023-02-20T13:03:29.203+0100: results of test 53647562 a

Software License > Options
2023-02-20T13:02:59.085+0100: results of test 5285935
Ag reement 2023-02-20T13:02:45.642+0100: results of test 5274963
SySTem Update > 2023-02-20T13:02:17.820+0100: results of test 52859357 accessed
System Backup > K < Page 1 of 21 > A @
Log Out

=> Export Log File

Obrazok 69. Pristup k systémovému denniku.

Poznamka: Na ziskanie Uplnych pomocnych informacii o teste alebo vSetkych nepodarenych testoch odpori¢ame namiesto
toho vyuzit funkciu pomocného balicka (pozrite si ¢ast 5.5.9).

6.7.9. Informacie o verzii

Stlacte tlacidlo Options > System Configuration > Version Info (MoZnosti > Konfiguracia systému > Informacie o verzii)

na zobrazenie verzie softvéru QlAstat-Dx, sériovych Cisel a verzii firmvéru pre nainStalované analytické moduly.
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6.7.10. Licen¢na zmluva pre softvéer

Stlacte tlacidlo Options > System Configuration > Software License Agreement (Moznosti > Konfiguracia systému >
Licengna zmluva na softvér) na zobrazenie softvérovej licenénej zmluvy aplikacie spustenej na QlAstat-Dx Analyzer 2.0

vratane licencii komponentov tretich stran.

6.7.11. Aktualizacia systéemu
DOLEZITE: Analyzator QlAstat-Dx Analyzer 2.0 sa dodava s verziou softvéru 1.6.

Aby sa zaistil ¢o najvy$si vykon, uistite sa, Ze pouzivate najnovsiu verziu softvéru. Kontaktujte technicky servis spolo¢nosti
QIAGEN na adrese support.giagen.com na ziskanie pomoci pri inovaciach softvéru.

Ak chcete do analyzatora QlAstat-Dx Analyzer 2.0 nainstalovat novu verziu softvéru, mozete si softvérové baliky prevziat

priamo z rozhrania QlAsphere do pristroja alebo ich musite ulozit do hlavného prie¢inka pamatového zariadenia USB.

1. Pri aktualizacii verzie softvéru z pamatového zariadenia USB vlozte pamatové zariadenie USB, ktoré obsahuje subor
.dup na importovanie, do portu USB analyzatora QlAstat-Dx Analyzer 2.0.
Poznamka: Na kratkodobé ulozenie a prenos udajov sa odporuca pouzit dodané ulozné USB zariadenie. Pouzivanie
ulozného zariadenia USB nepodlieha Ziadnemu obmedzeniu (napr. kapacita pamate alebo riziko prepisania), ktoré by
sa malo pred pouzitim zvazit.

2. Ak chcete aktualizovat' systém analyzatora QlAstat-Dx Analyzer 2.0, stlatte Options > System
Configuration>System Update (Moznosti > Konfiguracia systému > Aktualizacia systému).
V pripade, ze moznost System Update (Aktualizacia systému) nie je dostupna, pristroj je momentalne v stave, ked

aktualizacia nie je mozna. Skuste to znova neskor.

Objavi sa hlasenie, ktoré odporuca, aby sa najskér vykonalo zalohovanie systému (pozrite si ¢ast 6.7.12)
(obrazok 70).

Performing a backup is
recommended before
updating

@ Proceed ® Cancel

Obrazok 70. Vykonanie aktualizacie systému.
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3. Z rozhrania QlAsphere alebo pamatového zariadenia USB vyberte vhodny subor .dup, ktory zodpoveda novej verzii
softvéru.

Poznamka: Vyber z rozhrania QlAsphere je momentalne mozny len vtedy, ak bolo akékolvek pamatové zariadenie
USB pripojené po poslednom spusteni pristroja.

4. Po aktualizacii méze byt pouzivatel poziadany, aby vypol a znovu zapol analyzator QlAstat-Dx Analyzer 2.0.

Poznamka: Funkcia Setri¢a obrazovky je pocas aktualizacie systému neaktivna. Ak je povoleny rezim pristupu
pouzivatela, na overenie pouzivatela sa uz nevyzaduje opatovné prihlasenie. Odporuca sa nenechavat analyzator
QlAstat-Dx Analyzer 2.0 poCas aktualizacie systému bez dozoru. Po aktualizacii bude funkcia Setri¢a obrazovky znova
aktivna, takze sa moze stat, ze budu chybat informacie o Uspesnej alebo nelspesnej aktualizacii. V pripade
pochybnosti skontrolujte informacie o verzii (pozrite si Cast' 6.7.9).

Poznamka: Po aktualizacii systému odporu€¢ame analyzator QlAstat-Dx Analyzer 2.0 reStartovat. Ak chcete
analyzator QlAstat-Dx Analyzer 2.0 vypnut, vypnite pristroj pomocou hlavného vypinaca na zadnej strane analyzatora
QlAstat-Dx Analyzer 2.0. Potom pristroj znova zapnite tym istym vypinacom.

6.7.12. Zalohovanie systému

Ak chcete zalohovat’ systém analyzatora QlAstat-Dx Analyzer 2.0, stlate Options > System Configuration > System
Backup (Moznosti > Konfiguracia systému > Zaloha systému) (obrazok 71). Vlozte pamatové zariadenie USB do predného
portu USB alebo nakonfigurujte zdielanie v sieti (pozri ast 6.7.7).

administrator System Configuration 13:12 2023-02-20
1 Available o
Run Test
SETTINGS BACKUP
Network > Perform Backup > e
Network Share > Restore Backup > View
Results
System Log >
Version Info > @
Software License S Options

Agreement

System Update >

'_
(o]
(=]
o
c
=3

System Backup >

E Save ® Cancel

Obrazok 71. Vykonanie zalohovania systému.

Stlacte Perform Backup (Vytvorit zalohu). Vygeneruje sa subor s priponou .dbk s predvolenym nazvom suboru. Subor je
mozné ulozit bud na USB disk, alebo na zdielany prostriedok.

Ak chcete obnovit zalohu, stlacte Restore Backup (Obnovit zo zalohy) a vyberte prislusny subor zélohy s priponou .dbk z

pripojeného ulozného zariadenia USB. Zobrazi sa hlasenie s odporu¢anim, aby ste pred obnovenim vytvorili zalohu.

Poznamka: Doérazne sa odporuc¢a pravidelne systém zalohovat podla zasad vase spolo¢nosti, aby boli Udaje dostupné a
chranené pred stratou.
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Poznamka: Funkcia Setri¢a obrazovky je po¢as zalohovania systému neaktivna. Ak je povoleny rezim pristupu
pouzivatela, na overenie pouzivatela sa uz nevyzaduje opatovné prihlasenie. Odporuca sa nenechavat analyzator
QlAstat-Dx Analyzer 2.0 pocas vytvarania zalohy bez dozoru.

Poznamka: Na kratkodobé uloZenie a prenos udajov sa odporuca pouzit dodané ulozné USB zariadenie. Dérazne
odporu¢ame pouzit' na trvalé uloZzenie Udajov iné umiestnenie. Pouzivanie ulozného zariadenia USB nepodlieha Zziadnym

obmedzeniam (napr. kapacita pamate alebo riziko prepisania), ktoré by sa malo pred pouzitim zvazit.
6.8. Zmena hesiel

Ak chcete zmenit heslo pouzivatela, stlacte Options > Change Password (MozZnosti > Zmenit heslo), do textového pofa
zadajte aktualne heslo (obrazok 72) a potom zadajte nové heslo do pola New Password (Nové heslo). Znova zadajte nové

heslo do pola Confirm Password (Potvrdit heslo) (obrazok 73).

Heslo musi pozostavat z 6 — 15 znakov a obsahovat C&islice 0 — 9, pismena a — z, A — Z a nasledujuce Specialne znaky:
1N, =~ @#ES% N & () +{} Y| <> ?,<medzera>.

administrator Change Password 13:12 2023-02-20

User ID administrator Password l:|

g w e r t y u i o p [ 1 .
a s d f g h i k [ y ' \
4z X e v b n m . /
X space v

Obrazok 72. Zadanie aktualneho hesla.
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administrator Change Password 13:12 2023-02-20

New password Confirm password

q w e r t y u i 0 p [ ]
a s d f g h i k [ , ' \
&z X c v b n m , /
X space v

Obrazok 73. Zadanie a potvrdenie nového hesla.

Po troch neuspesSnych pokusoch o zadanie hesla sa pole na zadanie hesla na jednu minutu deaktivuje a zobrazi sa
dialégové okno s hlasenim ,Password failed, please wait 1 minute to try it again“ (Heslo zlyhalo, po¢kajte 1 mindtu a skuste

to znova).

Poznamka: Dérazne odporu¢ame pouzit silné heslo v sulade so zasadami pre hesla vo vasej spolo¢nosti.

6.9. Oznamenia

Centrum upozorneni zobrazuje délezité informacie. Pre pristup k upozorneniam stlacte Options > Notifications (MozZnosti
> Upozornenia). Ked je k dispozicii neprecitané upozornenie, tlacidlo Options (Moznosti) a tlacidlo Notifications

(Upozornenia) to indikuju, ako je znazornené na obrazku obrazok 74.

e © @ o0 @

User Management Assay Management System Configuration Change Password Options
Notifications Print Queue External Control Archive Results Log Out

Obrazok 74. Ponuka Options (Moznosti) a Notifications (Oznamenia) udavajica neprecitané oznamenia.

Existuju rézne typy oznameni. Prehlad je uvedeny v tabulke 13. Po vyrieSeni oznamenia (napr. po vymazani oznamenia)

dané oznamenie nebude viac dostupné.
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Tabulka 13. Typy a priklady oznameni
Typ oznamenia Popis

Information (Informacie) Tento typ oznamenia ma informac¢ny charakter.
Ak bolo napriklad vytvorenie automatického archivu netispesné.

Information to confirm Tento typ oznamenia vyZaduje potvrdenie zo strany pouzivatela o tom, ze si ho predital.

(Informacie na potvrdenie) Tento typ oznamenia je k dispozicii, len ak je analyzator QlAstat-Dx Analyzer 2.0 pripojeny k rozhraniu
QlAsphere (pozrite si ¢ast 6.7.3)

File IDown'Iq.a.d a\{ailable Tento typ oznamenia informuje o dostupnom prevzati stiborov priamo do pristroja.
(K dispozicii je stbor na Plati to pre prevzatie novej verzie testu alebo softvéru priamo z rozhrania QlAsphere.

revzatie
P ) Tento typ ozndmenia je k dispozicii, len ak je analyzator QlAstat-Dx Analyzer 2.0 pripojeny k rozhraniu
QlAsphere (pozrite si ¢ast' 6.7.3)

6.10. Funkcia tlaciarne
6.10.1. InStalacia a vymazanie tlaCiarne

InStalacia a vymazanie tlaiarne su opisané v prilohe 12.1.

6.10.2. Prezeranie tlacovych uloh

Front tladiarne zobrazuje aktivne tlacové ulohy na pristroji. Tu sa zobrazia spravy, ktoré boli zaradené do fronty na tlac.
Front tlaciarne je pristupny cez ponuku moznosti.

V tlaovom fronte sa zobrazi tabulka s nazvom tlaciarne, Cislom ulohy a datumom a €asom vytvorenia tlacovej ulohy
(obrazok 74).

administrator Print Queue 13:12 2023-02-20
1 Available °
Run Test
Printer Name Job Number Date
Default B/W USB 10 Wed Mar 23 17:42:00 2014
HP-IPP 11 Mon Mar 23 12:37:58 2021 e
View
Printer-BackOffice 12 Mon Mar 23 08:37:58 2021 Results
Network-Printer2 13 Mon Mar 23 09:37:58 2021 @
Printer-BackOffice 14 Mon Mar 23 10:37:58 2021
Options
Printer-BackOffice 15 Mon Mar 23 11:37:58 2021
Default B/W USB 19 Mon Mar 23 12:33:58 2021 @
Default B/W USB 20 Mon Mar 23 12:34:58 2021 Log Out
0 Refresh ﬁ‘ﬂ Delete All ® Cancel

Obrazok 75. Tla¢ fronty.

6.10.3. Vymazanie tlacovych uloh

Pouzivatelia s pravom vymazat tlacové ulohy moézu vymazat vSetky tlacové ulohy, aby frontu vymazali. Takto sa predide
tomu, aby sa vytladili vSetky spravy vo fronte. Ak tak chcete urobit, stlacte Delete All (Odstranit’ vSetko) v spodnej Casti
stranky (Obrazok 75).
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6.11. Nastavenia externej kontroly (EK)

Z ponuky externej kontroly je moZné aktivovat funkciu externej kontroly a nakonfigurovat jej moZnosti. Dal$ie informacie o
Externa kontrola (EK) (Externa kontrola (EK)) najdete v ¢asti 8.

Ak chcete tuto funkciu aktivovat a nastavit intervaly a vzorky pre jednotlivé testy, pokracujte podla krokov niZSie:

1. Stlac¢te Options (Moznosti) v Main Menu Bar (Panel hlavnej ponuky) a External Control (Externa kontrola).

2. Stlacenim prepinacieho tla¢idla Enable EC (Povolit EK) aktivujete tuto funkciu (obrazok 75).

administrator External Control 13:12 2023-02-20

1 Available °

Run Test
EXTERNAL CONTROL
Enable EC e
Due Dates > View
Results
Intervals >
EC Samples > @

Options

Log Out

Ig Save ® Cancel

Obrazok 76. Obrazovka Externa kontrola.

3. Ak chcete zistit, kedy bol vykonany posledny test externej kontroly na analyzu a analyticky modul a kedy sa ma vykonat
dalSi test externej kontroly, vyberte polozku Due Dates (Datumy dokoncenia) a potom test zo zoznamu (obrazok 76).

Poznamka: Ak nie su nain$talované Ziadne testy, nemézu sa zobrazit Ziadne datumy dokoncenia.

administrator External Control 11:15 2023-09-13
1 Available °
Run Test
EXTERNAL CONTROL EC DUE DATES RP SARS-CoV-2
Enable EC v G2 > LAST EC TESTS
Module 1: no EC test yet
RP SARS-CoV-2 > :

Due Dates > NEXT EC TESTS DUE View Results

Intervals S Module 1: now

EC Samples > @

Options

Log Out

E Save ® Cancel

Obrazok 77. Obrazovka Datumy dokonéenia externej kontroly.
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Tabulka 14. Datumy dokonéenia externej kontroly

Nastavenie Popis

Last EC runs Pre vybrany test a kazdy modul sa zobrazi datum, kedy sa vykonal posledny test EK.

(Posledné cykly EK)

Next EC runs due Pre vybrany test a kazdy modul sa zobrazi datum alebo pocet testov, po ktorych sa musi vykonat' test externej kontroly.
(DalSie planované Moznost Next EC runs (DalSie planované cykly EK) sa zobrazi len vtedy, ak je zapnuty prepina¢ Enable EC (Aktivovat EK).
cykly EK) Ak je typ intervalu pre test nastaveny na Sarzu kazety, nezobrazia sa dalSie cykly EK.

4. Vyberte moznost Intervals (Intervaly) a potom test zo zoznamu a interval nakonfigurujte. Zobrazi sa pripomienka,
ktora pouzivatelom pripomenie, zZe po uplynuti intervalu je potrebné vykonat test externej kontroly pre vybranu analyzu
(obrazok 77).

Poznamka: Ak nie su nainstalované Ziadne testy, intervaly nie je mozné konfigurovat.

administrator External Control 11:152023-09-13
1 Available °
Run Test
EXTERNAL CONTROL EC TEST INTERVAL RP SARS-CoV-2
Enable EC GI2 > Interval Type e
Days v
Due Dates > RP SARS-CoV-2 > View Results
Tests
Intervals >

Cartridge Lot

©

EC Samples >

Options
EC interval in days P

30

®

Log Out
E Save ® Cancel
Obrazok 78. Obrazovka Intervaly externej kontroly.
Tabulka 15. Nastavenia intervalov externej kontroly
Nastavenie Popis
Interval type (Typ intervalu) Typ intervalu uréuje, Ci sa test externej kontroly vykona po uréitom pocte dni, ¢i sa musi test vykonat po urcitom

pocte testov, alebo ¢i sa test musi vykonat s kazdou novou Sarzou kazety, ktora sa pouziva.

EC interval in days (Intervaly Definuje pocet dni, po ktorych sa musi vykonat test externej kontroly.

EKv dfioch) Tato moznost je aktivna len vtedy, ak je typ intervalu nastaveny na ,dni“.
EC interval in test (Intervaly Definuje pocet testov, po ktorych sa musi vykonat test externej kontroly.
EK v testoch)

Tato moznost je aktivna len vtedy, ak je typ intervalu nastaveny na ,testy”.

5. Vyberte moznost EC Samples (Vzorky EK) a pridajte alebo upravte vzorky, ktoré sa pouzivaju pri teste externej
kontroly. Ak chcete pridat novu vzorku EK, stlacte tlaCidlo Add new Sample (Pridat novu vzorku) a potom pokracujte
v konfigurécii v pravom stipci (obrazok 78). Na Gpravu vzorky EK vyberte zo stredného stipca existujicu vzorku a
pokradujte v konfiguracii v pravom stipci.
Poznamka: Odporuca sa uviest vhodny nazov vzorky EK, ktory obsahuje informacie o verzii vzorky EK alebo podobné
informacie, ktoré su vytlacené na prislusnej skumavke.
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administrator

F

1 Available
EXTERNAL CONTROL
Enable EC
Due Dates >
Intervals >
EC Samples >

External Control 13:13 2023-02-20

Run Test
EC SAMPLES SAMPLE DETAILS
Add New Sample > Sample Active e
RP_EC_Sample_Pc> Sample Name View
Results
RP_EC_Sample_N¢> GI_EC_Sample_Pos1
Assay @
GI-TEST
Options
Configure

Expected Result

®

Not considered

Meemiiem D Log Out

E Save ® Cancel

Obrazok 79. Obrazovka Vzorky externej kontroly EK.

Tabulka 16. Nastavenia vzoriek externej kontroly (EK)

Nastavenie

Popis

Sample Active (Aktivna
vzorka)

Sample Name (Nazov
vzorky)

Assay (Test)

Configure (Konfigurovat)

Aktivuje vzorku tak, aby bolo mozné ju vybrat v nastaveni testu externej kontroly.
Definuje nazov vzorky, ktory ju uréuje.
Vzorka EK je spojena s testom. Test je mozné vybrat zo zoznamu vSetkych nainstalovanych testov.

Po zvoleni testu sa nacitaju vSetky analyty spojené s tymto testom. Pre kazdy analyt sa méze nakonfigurovat, ¢i sa ma
alebo nema brat do Uvahy pri cykle externej kontroly, a ¢i sa o6akava, Ze analyt bude detegovany.

6. Vyberte Configure (Konfigurovat) na Upravu analytov v teste externej kontroly (obrazok 79). V konfiguracii vzorky

externej kontroly EK mozno ur¢it, ¢i sa analyt zohladriuje pre cyklus externej kontroly EK a i sa oCakava detekcia

(obrazok 80).

Poznamka: Na uloZenie konfiguraénych nastaveni je potrebné zohladnit aspori jeden analyt.

o Analyte Detection expected?

Q Norovirus Gll

° Rotavirus A

o Astrovirus

Q Norovirus Gl

D UUY
.xxx

@ Confirm ® Cancel

Obrazok 80. Obrazovka konfiguracie vzorky externej kontroly EK.
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Tabulka 17. Konfiguracie vzorky externej kontroly EK

Nastavenie Popis
Consideration of analyte Pre kazdy analyt sa méze nakonfigurovat, ¢i sa ma analyt brat do Uvahy pri cykle externej kontroly. Ak sa analyt berie do
(Zvazenie analytu) avahy, musi byt zaskrtnuté prislusné zaskrtavacie policko.

Len ak sa analyt berie do ivahy pri vzorke externej kontroly, bude zahrnuty do vypo¢tu vysledku externej kontroly
a porovnany s aktualnym vysledkom prislu$ného analytu.

Analyte (Analyt) Nacitaju sa vSetky analyty spojené s tymto testom.
Detection Expected Pre kazdy analyt, ktory sa berie do Uvahy, je mozné nakonfigurovat, ¢i sa o¢akava alebo neoCakava detekcia v cykle
(Ocakavana detekcia) externej kontroly. Ak sa ocakava detekcia analytu, musi sa prepina¢ zapnut.

6.12. Vysledky z archivu

Vybrané vysledky sa m6zu archivovat s naslednou moznostou odstranenia na uvolnenie pamate analyzatora QlAstat-Dx
Analyzer 2.0 alebo podporu zasad vasej organizacie tykajucich sa uchovavania udajov. Archivované subory obsahuju
vSetky dblezité udaje o priebehoch testu (napr. Udaje krivky, vysledky analyz, celkové Udaje vysledku atd.) a je mozné ich
kedykolvek zobrazit, ulozit’ a vytlaCit na kazdom pristroji QlAstat-Dx Analyzer 2.0 (pozrite si Cast 6.12.2).

Poznamka: Kupujuci analyzatora QlAstat-Dx Analyzer 2.0 je vyhradne zodpovedny za dodrziavanie zasad organizacie o
uchovani tdajov. Uchovanie udajov pri vyhradnom pouziti funkcie popisanej v tejto €asti nemusi byt dostato¢né na spinenie

zasad va$ej organizacie.

Funkcia archivu je pristupna cez ponuku Options (Moznosti). Je mozné vytvorit archivy s alebo bez moznosti odstranenia

alebo nacitania archivu (pozrite si ¢ast 6.12.1). Vysledky automaticky vytvorenych archivov sa vzdy vymazu.

Poznamka: Pri prezerani vysledkov testu archivu je dostupna len obmedzena funkcia (podrobnejSie informacie najdete v
Casti 6.12.2).

6.12.1. Vytvorenie archivu

Vytvorenie archivaéného suboru bez funkcie odstranenia

Na vytvorenie archivaéného suboru filtrujte vysledky, ktoré sa maju archivovat. Stlacte tlacidlo Create Archive (Vytvorit
archiv) a vyfiltrujte Zzelany datum zaciatku a konca. Na obrazovke sa zobrazi vybrany pocet vysledkov. V ramci jedného

archivacného suboru je mozné archivovat’ az 250 vysledkov.
Na vytvorenie archivaéného suboru moézete vybrat len uz nahraté HIS/LIS a exspirované vysledky. Podobne je mozné

vybrat’ len uz nacitany vysledok aplikacie QlAstat-Dx Remote Results na vytvorenie archivaéného suboru. Stlacte HIS/LIS

Uploaded (Nahrané HIS/LIS) na archivovanie tejto moznosti a stlacte Create Archive (Vytvorit archiv) (obrazok 80).
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Obrazok 81. Moznosti vytvorenia archivu.

Poznamka: Na kratkodobé uloZenie a prenos udajov sa odporuca pouzit dodané ulozné USB zariadenie. Dérazne
odporu¢ame pouzit' na trvalé ulozenie Udajov iné umiestnenie. Pouzivanie ulozného zariadenia USB nepodlieha Zziadnym
obmedzeniam (napr. kapacita pamate alebo riziko prepisania), ktoré by sa malo pred pouzitim zvazit.

Poznamka: Funkcia Setri€a obrazovky je pocas vytvarania archivu neaktivna. Ak je povoleny rezim pristupu pouzivatela,
na overenie pouzivatela sa uz nevyzaduje opatovné prihlasenie. Odporuca sa nenechavat analyzator QlAstat-Dx
Analyzer 2.0 po¢as vytvarania archivu bez dozoru.

Vytvorenie archivaéného suboru s funkciou odstranenia

DOLEZITE: Archivované a odstranené vysledky sa uZz nenachadzaju v analyzatore QlAstat-Dx Analyzer 2.0 a nebudu
sucastou zalohovacieho suboru systému. Dérazne sa odporuca vytvorit pred pokraCovanim vo vytvarani archivaéného
suboru pomocou funkcie odstranenia zalohu systému. Informacie tykajuce sa vytvarania zalohy systému najdete v Casti
6.7.12. Odstranené vysledky sa nezarataji do epidemiologickych sprav. Dal$ie informacie najdete v asti 6.6.2.

Ak sa vybrané vysledky archivuju a odstrania z analyzatora QlAstat-Dx Analyzer 2.0, vytvorte archiva¢ny subor podla popisu
nizSie a aktivujte funkciu odstranenia.

Stlacte Remove Results (Odstranit’ vysledky) a aktivujte odstranenie. Ak bolo vytvorenie archivaéného suboru Uspesné,
odstrania sa vybrané vysledky z analyzatora QlAstat-Dx Analyzer 2.0 automaticky (obrazok 81).

Pouzivatel'ska prirucka pre analyzator QlAstat-Dx Analyzer 2.0 09/2024 82



administrator Archive Results 13:14 2023-02-20

F

1 Available °
Run Test
ARCHIVING Create Archive Remove Results
: 2023-02-20 ’
Create Archive > Remove Results
. End Time S
Open Archive > Select to remove Vi
1313 corresponding results from Results
f ; this analyzer after archive
Automatic Archive > HIS/LIS Uploaded o Creayted_
uploaded only Warning: @
Removed Results can only
S be viewed on QlAstat-Dx Options
analyzers when loading a
all corresponding archive.
When viewing archived
Remove Results > results, they can no longer @
yes 9 Results Selected Log Out

E Create Archive ® Cancel

Obrazok 82. Obrazovka Moznosti odstranenia vysledkov.

Poznamka: Odstranené vysledky sa uz nenachadzaju v analyzatore QlAstat-Dx Analyzer 2.0. Nacitanie vysledkov
HIS/LIS a nacitanie vysledkov aplikacie QlAstat-Dx Remote Results nie je mozné po UspeSnom odstraneni.

Poznamka: Na kratkodobé uloZenie a prenos Udajov sa odporuc¢a pouzit dodané ulozné USB zariadenie. Dérazne
odporu¢ame pouzit' na trvalé ulozenie udajov iné umiestnenie. Pouzivanie ulozného zariadenia USB nepodlieha ziadnym
obmedzeniam (napr. kapacita pamate alebo riziko prepisania), ktoré by sa malo pred pouzitim zvazit.

Poznamka: Funkcia Setria obrazovky je pocas vytvarania archivu neaktivna. Ak je povoleny rezim pristupu pouzivatela,
na overenie pouzivatela sa uz nevyzaduje opatovné prihlasenie. Odporuca sa nenechavat analyzator QlAstat-Dx

Analyzer 2.0 po¢as vytvarania archivu bez dozoru.

6.12.2. Otvorenie archivu

Subory archivu so softvérom aplikacie QlAstat-Dx je mozné otvorit len na prehliadanie, ulozenie a tla¢ vysledkov. Archivy
je mozné otvorit z USB uloZznych médii, ako aj predkonfigurovanych zdielanych prostriedkov. Stlacte Open Archive (Otvorit
archiv) a nacitajte zelany archivacny subor. Po uspesnom nacitani archivu stlacte View Archive (Prezerat archiv). PoCas
prezerania vysledkov z archivu nie je mozné spustit Ziadne nové cykly. Archivaény subor zatvorte tlacidlom Close Archive
(Zatvorit archiv) a ziskajte znova beznu funkénost (obrazok 82).
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Obrazok 83. Obrazovka Otvorit’ archiv.

Poznamka: Na kratkodobé ulozenie a prenos udajov sa odporuca pouzit dodané ulozné USB zariadenie. Dbérazne
odporu€ame pouzit na trvalé uloZenie Udajov iné umiestnenie. Pouzivanie Ulozného zariadenia USB nepodlieha Ziadnym

obmedzeniam (napr. kapacita pamate alebo riziko prepisania), ktoré by sa malo pred pouzitim zvazit.

6.12.3. Automaticky archiv

Délezité: Automaticky archivované vysledky sa odstrania a uz sa nenachadzaju v analyzatore QlAstat-Dx Analyzer 2.0 a
nebudu sucastou zalohovacieho suboru systému. Pozrite si ¢ast 6.7.12 s informaciami o vytvoreni zalohy systému.

Odstranené vysledky sa nezarataji do epidemiologickych sprav. Dal$ie informacie najdete v &asti 6.6.2.

Poznamka: Pred aktivovanim automatického vytvorenia archivaéného suboru sa odporuca overit’ celkovy pocet vysledkov
ulozenych v analyzatore QIlAstat-Dx Analyzer 2.0. Ak sa ulozi vysoky pocet vysledkov testov, odporuca sa najskor

postupovat podla pokynov v ¢asti 6.12.1 a znizit poCet vysledkov testov.

Na automatické vytvorenie archivacného suboru sa na pristroji archivuju najstarsie vysledky. Postupujte podla krokov nizSie
a nakonfigurujte automaticky proces archivacie:

1. Stlacte > Archive Results (Archivovat vysledky).
2. Stlacte Automatic Archive (Automatickd archivacia) a povolte tuto funkciu (obrazok 84).

3. Vyberte moznost Start Time (Cas spustenia). V tomto &ase prebieha automaticka archivacia kazdy def, ak je spinena
podmienka Archive Configuration (Konfiguracia archivacie) (krok 4).

Dolezité: Dorazne sa odporuca nakonfigurovat’ ¢as spustenia mimo prevadzkovych hodin pristroja. Vytvorenie
automatického archivu bezi na pozadi a méze spomalovat softvér.

4. Vyberte moznost Archive Configuration (Konfiguracia archivu). Pocet vysledkov na spustenie archivovania odkazuje
na celkovy pocet vysledkov uloZzenych v pristroji. PoCet vysledkov v archive odkazuje na pocet vysledkov, ktoré sa
archivuju, pricom najstarsie vysledky sa archivuju ako prvé. V ramci jedného archivacného suboru je mozné
archivovat az 250 vysledkov.

Poznamka: Pri konfiguracii archivu sa odporuca pouzit automatické nastavenia. Zvacsenie velkosti archivu

ovplyviiuje mnozstvo €asu, ktoré zaberie vytvorenie automatického archivu.
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5. Na vytvorenie archivaéného suboru mézete vybrat len uz nahraté HIS/LIS a exspirované vysledky. Stlacte moznost
HIS/LIS Uploaded (Nahrané HIS/LIS) a tuto funkciu aktivujte.

6. Je mozné vybrat len uz nacitané vysledky aplikacie QlAstat-Dx Remote Results na vytvorenie archivaéného suboru.
Stlacte moznost QlAstat-Dx Remote Results Application Uploaded (Nacitané vysledky aplikacie QUIstat-DX
Remote Results) na aktivaciu tejto funkcie.

7. Vyberte moznost Storage Location (Umiestnenie pre uloZenie). V pripade automatického archivu je potrebné vybrat

predkonfigurovany zdielany prostriedok. DalSie informacie o konfiguracii zdielania cez siet najdete v &asti 6.7.7.
Poznamka: Pre automaticky archiv nie je mozné zvolit USB pamatové médium ako umiestnenie pre ulozenie.
8. StlaCenim Save (Ulozit) a Confirm (Potvrdit) ulozte konfiguraciu.

9. Vyberte moznost Last archive creation (Vytvorenie posledného archivu) a pozrite si, kedy bol vytvoreny posledny
archiv a ¢i sa predchadzajuce vytvaranie podarilo.
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Obrazok 84. Moznosti automatického archivu.

6.13. Stav systému QlAstat-Dx Analyzer 2.0

Stav operacnych a analytickych modulov je indikovany farbou stavovych indikatorov (LED) na prednej strane analyzatora
QlAstat-Dx Analyzer 2.0.

Operacny modul dokaze zobrazit' ktorukolvek z nasledujucich farieb:

V tabulke 18 su vysvetlené stavové svetla, ktoré sa mézu zobrazit na operacnych a analytickych moduloch.

Tabulka 18. Popis stavovych svetiel
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Modul Stavové svetlo Popis

Operacény VYPNUTE Analyzator QlAstat-Dx Analyzer 2.0 je vypnuty
Modra Analyzator QlAstat-Dx Analyzer 2.0 je v pohotovostnom rezime
Zelena Analyzator QlAstat-Dx Analyzer 2.0 je spusteny

Analyticky VYPNUTE Analyzator QlAstat-Dx Analyzer 2.0 je vypnuty
Modra Analyzator QlAstat-Dx Analyzer 2.0 je v pohotovostnom rezime
Zelena (blika) Analyzator QlAstat-Dx Analyzer 2.0 sa spusta
Zelena Analyticky modul je v prevadzke
Cervena Porucha analytického modulu

6.14. Vypinanie analyzatora QlAstat-Dx Analyzer 2.0

Analyzator QlAstat-Dx Analyzer 2.0 je navrhnuty tak, aby pracoval nepretrzite. Ak sa jednotka nebude pouzivat kratky ¢as
(menej ako jeden deri), odporu¢ame umiestnit analyzator QlAstat-Dx Analyzer 2.0 do pohotovostného rezimu stlacenim
tlacidla ON/OFF (Zap./Vyp.) na prednej strane pristroja. Ak chcete analyzator QlAstat-Dx Analyzer 2.0 vypnut na dlhSi ¢as,
vypnite pristroj pomocou hlavného vypina¢a na zadnej strane analyzatora QlAstat-Dx Analyzer 2.0.

Ak sa pouzivatel pokusi uviest analyzatora QlAstat-Dx Analyzer 2.0 do pohotovostného rezimu, ked analyticky modul

vykonava test, zobrazi sa dialdgové okno s upozornenim, Zze vypnutie nie je v su€asnosti mozné. Nechajte pristroj dokonéit

prebiehajuci test(-y) a po dokoncéeni ho vypnite.
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7. Pripojenie HIS/LIS

Této Cast popisuje prepojenie analyzatora QlAstat-Dx Analyzer 2.0 s HIS/LIS.

Konfiguracia HIS/LIS umoziuje pripojit analyzator QlAstat-Dx Analyzer 2.0 k systému HIS/LIS na poskytovanie
nasledujucich funkcii:

e Aktivacia a konfiguracia komunikacie s HIS/LIS

e Konfiguracia testu na odosielanie vysledkov a poziadanie o uzavretie objednavok

e Spustenie testu na zaklade uzavretej objednavky

e  Odoslanie vysledku testu

Poznamka: Odporucame dodrziavat bezpecnostné opatrenia a zasady vaSej organizacie platné pre lokalny intranet,

kedze komunikacia so systémom HIS/LIS nie je Sifrovana.

7.1.  Aktivacia a konfiguracia komunikacie s HIS/LIS

1. Stlaéte Options > System Configuration (Moznosti > Konfiguracia systému).
2. Vyberte moznost HIS/LIS zo zoznamu Settings (Nastavenia) v favom stipci. Podla potreby vyberte a definujte
nastavenia uvedené v tabulke 19:
Tabulka 19. Nastavenia HIS/LIS

Nastavenie Popis

Host Communication
(Komunikacia hostitela)

Umozniuje pripojenie HIS/LIS.
Tato moznost je predvolene zakazana.

Host Settings
(Nastavenie hostitela)

Aktivne iba vtedy, ked je povolend moznost Host Communication (Komunikacia hostitela). Toto nastavenie definuje
adresu hostitela a port hostitela. Adresa hostitela povoluje IP aj hodnotu nazvu hostitela. Hodnota IP musi mat 4 cisla
(N.N.N.N) a N musi byt od 0 do 255.

Prenosovy protokol je v su¢asnosti kompatibilny s HL7
Hospital name (Nazov nemocnice) je vyluény nazov na definovanie DMS alebo LIS.

Predvoleny Timeout (Casovy limit) je nakonfigurovany na 5 sekind a mozno ho predizit aZ na 60 sekind. Toto je
maximalny ¢as, pocas ktorého analyzator QlAstat-Dx Analyzer 2.0 ¢aka na spravu od hostitela.

Messages queued (Spravy vo fronte) je indikatorom poctu sprav ¢akajucich vo fronte.

Tlac¢idlo Check connectivity (Skontrolovat pripojenie) potvrdzuje spojenie medzi analyzatorom QlAstat-Dx Analyzer 2.0 a
hostitelom s vyplnenou adresou IP a portom.

Result Upload
(Nahrat vysledok)

Results Upload Settings
(Nastavenia nahravania
vysledkov)

Test Orders
(Objednavky testovania)

Order Settings
(Nastavenia objednavky)

Debug Logging
(Dennik ladenia)

Aktivuje funkciu odosielania vysledkov z analyzatora QlAstat-Dx Analyzer 2.0 hostitelovi.
Tato moznost je predvolene zakdzana.

Aktivne iba vtedy, ked je povolend moznost Result Upload (Nahrat vysledok).

Nahravanie vysledkov je mozné vykonat v dvoch rezimoch: automatickom a manualnom. Ked je povoleny automaticky
rezim, hned' po dokonceni testu sa vysledky odos$lu hostitelovi. Ak je automaticky rezim zakazany, vysledky sa mézu
odoslat' manualne stlacenim tlacidla Upload (Nahrat) na obrazovkach Result Summary (Suhrn vysledkov) a View
Results (Zobrazit' vysledky). Automaticky rezim je predvolene deaktivovany.

PDF report upload (Nahranie PDF spravy) umozriuje nahratie sprav spolu s vysledkom.

Expire Time (Cas exspiracie) je podet dni, potas ktorych moze byt test odoslany hostitelovi. Ked je nastaveny na nulovt
hodnotu, tato moznost je zakazana, takze vysledky nikdy neexspiruju.

Reset Uploading (Resetovat’ nahravanie) vymaze front sprav ¢akajlcich na odoslanie. Tato moznost méze byt uzito¢na,
ked bolo odoslanych mnoho vysledkov, ale z réznych dévodov je potrebné prenos zrusit.

Retry (Opakovat) znova odoSle vysledky, ktoré maju stav nacitavania ,Error* (Chyba).

Authorization (Autorizacia) moze byt nastavena na rolu na povolenie nahravania vysledkov. Predvolene je tato
autorizacia povolena len pre rolu Administrator (Spravca).

Povoluje funkciu spustenia testu na zaklade uzavretej objednavky vytvorenej v HIS/LIS.

Tato moznost je predvolene zakazana.

Aktivne iba vtedy, ked je povolena moznost Test Orders (Objednavky testovania).

Force Order (Vynutenie objednavky) umozriuje spustit test aj v pripade, ak nie je k dispozicii komunikacia s hostitefom,
alebo ak k zadanému ID vzorky nie je priradena uzavreta objednavka. Moznost Force Order (Vynutenie objednavky) je
predvolene zakazana.

Dennik ladenia moze aktivovat/deaktivovat pouzivatel s pravami spravcu alebo servisny technik. Umozriuje
zaznamenanie $pecifickych hlaseni ladenia HL7 pre nahravanie HIS/LIS.

Poznamka: Dérazne sa odportc¢a zapnut zaznamenavanie len pre analyzy pocas instalacie a potom ho vypnut.
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7.2. Konfiguracia nazvu testu

Zobrazeny nazov testu v HIS/LIS sa mdze liSit od zobrazeného nazvu testu v analyzatore QlAstat-Dx Analyzer 2.0. Pred
pouzitim funkcii HIS/LIS sa musi vykonat' nasledujuci postup na potvrdenie/opravu nazvov testov.

1. Stlacte Options > Assay Management (Moznosti > Sprava testov) na pristup k obrazovke Assay Management

(Spréava testov). Dostupné testy st uvedené v prvom stipci v oblasti s obsahom.

2. Vyberte test z ponuky Available Assays (Dostupné testy).

3. Vyberte moznost LIS assay name (Nazov testu LIS). Standardne by mal byt nazov testu rovnaky pre analyzator
QlAstat-Dx Analyzer 2.0 a HIS/LIS. Ak je nazov testu v HIS/LIS odliSny, musi sa opravit, aby zodpovedal nazvu testu

analyzatora QlAstat-Dx Analyzer 2.0. Nazov testu opravte pomocou vstupného textového pola LIS assay name
(Nazov testu LIS) a potom stlacte Save (Ulozit).

7.3. Vytvorenie objednavky testovania s pripojenim hostitela

Ked su povolené moznosti Host Communication (Komunikacia hostitela) a Test Orders (Objednavky testovania),
objednavky testovania je mozné stiahnut z hostitela pred spustenim testu. Skenovanim alebo zadavanim ID vzorky
automaticky sa ziska objednavka testu od hostitela.

7.3.1. Konfiguracia analyzatora QlAstat-Dx Analyzer 2.0 s pripojenim hostitela

1. Stlacte Options > System Configuration (Moznosti > Konfiguracia systému).
2. Vyberte moznost HIS/LIS zo zoznamu Settings (Nastavenia) v lavom stipci.

3. Povolte moznost Host Communication (Komunikéacia hostitela) a nakonfigurujte Host Settings (Nastavenia
hostitela) s podrobnostami o hostitefovi. Stlacenim tlacidla Check connectivity (Skontrolovat pripojenie) potvrdte
pripojenie.

4. Povolte moznost Test Orders (Objednavky testovania) a nakonfigurujte Order Settings (Nastavenia objednavky).

K dispozicii st dva rezimy prace s objednavkami testovania, pri povolenej alebo zakazanej moznosti Force Order
(Vynutenie objednavky). Ked je povolena moznost Force Order (Vynutenie objednavky) a objednavka testovania nie
je uspesne nacitana z hostitela, pouzivatel nesmie pokracovat vo vykonavani testu. Ked je moznost Force Order
(Vynutenie objednavky) zakazana, aj ked objednavka testovania nie je nacitana alebo neexistuje na hostitefovi,
pouzivatel méze pokracovat v teste, priom sa zobrazi vyskakovacie okno, ktoré upozornuje pouzivatela.

7.3.2. Spustenie testu na zaklade objednavky testovania

1. Stlacte tlacidlo ° Run Test (Spustit' test) v pravom hornom rohu obrazovky Main (Hlavna obrazovka).

2. Po zobrazeni vyzvy naskenujte Ciarovy kéd s ID vzorky pomocou €itacky Ciarovych kédov integrovanej v operaénom
module (obrazok 85).

Poznamka: V zavislosti od konfiguracie analyzatora QlAstat-Dx Analyzer 2.0 m6ze byt tiez mozné zadat’ ID vzorky
pomocou virtualnej klavesnice na dotykovej obrazovke. Dal$ie podrobnosti najdete v asti 6.7.4.
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Cancel
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Obrazok 85. Skenovanie ¢iarového kédu s ID vzorky.

3. ID vzorky bude odoslané hostitelovi a kym analyzator QlAstat-Dx Analyzer 2.0 ¢aka na objednavku testovania, zobrazi
sa sprava ,Getting order...“ (Ziskavanie objednavky...) (obrazok 86).
Poznamka: Ak objednavka testovania nie je UspeSne nacitana z hostitela a ak je povolena moznost Force Order
(Vynutenie objednavky), pouzivatel nesmie pokracovat v testovani. Ak je moznost Force Order (Vynutenie
objednavky) zakazana, aj ked objednavka testovania nie je nacitana, pouzivatel méze pokracovat v teste (zobrazi sa
dialégové okno s varovnym hlasenim). DalSie informacie o varovaniach a chybach najdete v &asti 10.2.

administrator Run Test Module 1 13:17 2023-02-20
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Sample ID
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ne
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Cancel
Getting order...

Obrazok 86. Zobrazenie poc¢as nacitavania objednavky testovania.

4. Ked bola objednavka testovania Uspesne prijata od hostitela, zobrazi sa ,Scan cartridge for assay <assay_name> and
book order <order_number>* (Naskenujte kazetu pre test <nazov_testu> a objednavku testovania
<Cislo_objednavky>). Naskenujte Ciarovy koéd Specifikovanej testovacej kazety QlAstat-Dx (obrazok 87).

Poznamka: Ak hostitel vrati viac ako jednu objednavku testovania pre ID vzorky, zobrazi sa hlasenie ,Scan cartridge
for book order <order_number>“ (Naskenujte kazetu pre uzavretu objednavku <¢&islo_objednavky>). Ak naskenovana
testovacia kazeta QlAstat-Dx nezodpovedd uzavretej objednavke, testovaci cyklus neméze pokraCovat a zobrazi sa

chyba. Dal$ie informacie o varovaniach a chybach najdete v &asti 10.2.
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administrator Run Test Module 1 13:18 2023-02-20

’1 Ul administrator
RP

TEST DATA

Sample ID
37492746 v

Assay Type

Sample Type

Cancel

Scan Cartridge Barcode

Obrazok 87. Skenovanie ¢iarového kédu testovacej kazety QlAstat-Dx.
5. Pole Assay Type (Typ testu) bude automaticky vyplnené a v pripade potreby musi byt zo zoznamu ruéne vybrany
vhodny Sample Type (Typ vzorky) (obrazok 88).

administrator Run Test Module 1 13:18 2023-02-20

'I Ul administrator
RP

TEST DATA SAMPLE TYPE
Sample ID

37492746 v Swab

Assay Type UTM

RP v

Sample Type

Cancel

Select Sample Type

Obrazok 88. Vyber typu vzorky.

6. Pozrite si Cast' 5.3 a dokoncite kroky 5 — 11.
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7.4. Nahranie vysledku testu hostitefovi

Ked su povolené moznosti Result Upload (Nahrat vysledok) a Results Upload Settings (Nastavenia nahravania
vysledkov), vysledky testov mozno do hostitela nahrat automaticky alebo manualine.

7.4.1. Konfiguracia analyzatora QlAstat-Dx Analyzer 2.0 pre automatické nahravanie vysledku testu do
hostitela

1. Stlacte Options > System Configuration (Moznosti > Konfiguracia systému).
2. Vyberte moznost HIS/LIS zo zoznamu Settings (Nastavenia) v lavom stipci.

3. Povolte moznost Host Communication (Komunikacia hostitela) a nakonfigurujte Host Settings (Nastavenia

hostitela) s podrobnostami o hostitelovi. Stlacenim Check connectivity (Kontrola pripojenia) potvrdte pripojenie.

4. Povolte moznost Result Upload (Nahrat vysledok) a nakonfigurujte Result Upload Settings (Nastavenia nahravania
vysledkov). Povolte moznost Automatic upload (Automatické nahravanie).

7.4.2. Automatické nahravanie vysledku testu do hostitela

Po dokongeni testu sa vysledok automaticky nahra. Stav nahravania sa zobrazuje v &asti Test Data (Udaje testu) na

obrazovke vysledkov Summary (Suhrn) a v stipci & Upload (Nahrat) na obrazovke View Results (Zobrazit vysledky)
(obrazok 89).

administrator Summary 13:18 2023-02-20

TEST COMPLETED

1 Ul administrator
RP

. Run Test
TEST DATA QlAstat-Dx® Respiratory Panel
Sample ID Controls Passed
37492746 Detected e
Assay Type
v e Influenza B
RP View
Sample Type @ Rhinovirus/Enterovirus Results
Swab @ ~denovirus
LIS Upload Status ) @
Pending Equivacal
None Options
Tested
@ influenzaB @
Bl summary |~ Amplification Cur. |\ Metting Curves ¥ AMR Genes [l Test Details
_— Log Out
E'F Support Package E Print Report E Save Report LE_| Comment |1| Upload

Obrazok 89. Obrazovka Suhrn vysledkov.
Ak chcete zobrazit’ stav nahravania z predchadzajucich testov, ktoré su uloZzené v uloZisku vysledkov, v paneli s hlavnou

ponukou stlacte tlacidlo 9View Results (Zobrazit vysledky). V stipci & Upload (Nahrat) sa zobrazuje Upload Status
(Nahrat stav) (obrazok 90).
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administrator Test Results 13:19 2023-02-20

F

1 Available °
Run Test
° Sample ID Assay Operator ID EC Mod Iil Date/Time Result
37492746 RP administr.. 1 (¥)2023-02-2013:18 @) pos e
52859357 RP administr 1 () 202302201300 @ pos Vi
Results
53647562 RP administr 1 () 202302201253 @ pos
02548164 RP administ... 1 (8) 202302201128 @ pos @
32749367 RP administr 1 (3) 202302201127 @ pos REEs
54372658 G- TEST administr 1 (3) 202302201126 @ pos
K < Page 1 of 2 > ! @
Log Out
A Remove Filter E Print Report E Save Report p Search IL Upload

Obrazok 90. Obrazovka Zobrazenie vysledkov.

MozZné zobrazené stavy nahravania su popisané v tabulke 20. Stav nahravania zobrazuje vysledok nahravania, na
obrazovke vysledkov Summary (Suhrn) sa zobrazuje nazov a na obrazovke View Results (Zobrazit vysledky) sa
zobrazuje ikona.

Tabulka 20. Popis stavov nahravania

Nazov Ikona Popis

Pending (Cakajlce) Vysledok zatial nebol nahrany.

Uploading (Nahravanie) Vysledok sa nahrava.

Uploaded (timestamp)
(Nahrané (¢asova znacka))

Vysledok bol uspesne nahrany s datumom a ¢asom nahrania.

@O ®

Error (Chyba) Chyba pri odovzdavani vysledku (€asovy limit,...).

Re-Uploading (Opakované nahravanie) Vysledok sa posiela znova.

<] @ [-)ﬂ

Expired (previously uploaded)
(Exspirované (predtym nahrané))

Vysledok uz nie je mozné nahrat. Aspon raz bol Uspesne odoslany.

Expired (never uploaded) Vysledok uz nie je mozné nahrat. Nebol nikdy odoslany
(Exspirované (nikdy nenahrané))

7.4.3. Konfiguracia analyzatora QlAstat-Dx Analyzer 2.0 manualne nahravanie vysledku testu do hostitefa

1. Stladte Options > System Configuration (MozZnosti > Konfiguracia systému).
2. Vyberte moznost HIS/LIS zo zoznamu Settings (Nastavenia) v lavom stipci.

3. Povolte moznost Host Communication (Komunikacia hostitela) a nakonfigurujte Host Settings (Nastavenia
hostitela) s podrobnostami o hostitelovi. Stlacenim tlacidla Check connectivity (Skontrolovat pripojenie) potvrdte
pripojenie.

4. Povolte mozZnost Result Upload (Nahrat vysledok) a nakonfigurujte Result Upload Settings (Nastavenia nahravania

vysledkov). Zakazte moznost Automatic upload (Automatické nahravanie).
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7.4.4. Manualne nahravanie vysledku testu do hostitefa

Po dokonéeni testu mézete vysledok nahrat manualne z obrazovky vysledkov Summary (Suhrn) alebo z obrazovky View
Results (Zobrazit vysledky).

Ak chcete nahrat’ vysledok z obrazovky vysledkov Summary (Suhrn), stlacte tlacidlo Ty Upload Upload (Nahrat).

Ak chcete nahrat vysledok z obrazovky View Results (Zobrazit' vysledky), vyberte jeden alebo viac vysledkov testu
stlacenim Sedého krazku vlavo od ID vzorky. Vedla vybratych vysledkov sa zobrazi poli€ko za€iarknutia. Ak chcete zrusit
vyber vysledkov testu, stlacte kvacku. Cely zoznam vysledkov je mozné zvolit’ stlaCenim tlacidla @ krizok so zagiarknutim

v hornom riadku. Po vybere vysledkov nahravania stlacte tlacidlo ', Uploa Upload (Nahrat) (obrazok 91).

administrator Test Results 13:19 2023-02-20

1 Available °

Run Test
° Sample ID Assay Operator ID EC Mod Iil Date/Time Result
@ 37492746 RP administr.. 1 (¥)2023-02-2013:18 @) pos e
52859357 RP administr 1 () 202302201300 @ pos Vi
Results
@ 53647562 RP administr 1 () 202302201253 @ pos
@ 02548164 RP administ... 1 (8) 202302201128 @ pos @
32749367 RP administr 1 (3) 202302201127 @ pos REEs
54372658 G- TEST administr 1 (3) 202302201126 @ pos
K < Page 1 of 2 > ! @
Log Out
A Remove Filter E Print Report E Save Report p Search |1| Upload

Obrazok 91. Obrazovka Zobrazenie vysledkov.

7.5. RieSenie problémov s pripojenim hostitela

RieSenie problémov s pripojenim hostitela je popisané v ¢asti 10.1.

Pouzivatel'ska prirucka pre analyzator QlAstat-Dx Analyzer 2.0 09/2024 93



8. Externa kontrola (EK)

Softvér analyzatora QlAstat-Dx Analyzer 2.0 je mozné konfigurovat tak, aby pomohol pri postupoch kontroly kvality na
zaklade externych kontrol v laboratériach. Ciefom takychto postupov je overit, budu vystupom spracovania znamej vzorky
oCakavané vysledky na urovni patogénu. Postupujte podla zasad vasej organizacie, aby ste zaistili, Ze su vytvorené vhodné

postupy nezavisle od pouzitia funkcii popisanych v tejto Casti.

Ak je funkcia aktivovana, umoznuje konfiguraciu intervalov, po ktorych sa musi vykonat test EK podla testu a modulu. Ak
je test EK potrebné vykonat' pre nastavenim testu, uvidia pouzivatelia pripomienku.

Ak sa test EK vykonal, vyberie sa vzorka EK pri nastavovani cyklu. Vzorka EK urCuje, aké su oakavané vysledky pre kazdy
analyt testovaného testu. Ak sa oCakavané vysledky konfigurované vo vzorke EK zhoduju so skutoénymi vysledkami z testu,
bude test EK Uspesny. Ak aspon jeden analyt nesplni oakavany vysledok, test EK sa nepodari. Pouzivatel je pred
nastavenim testu upozorneny, ak sa pouziva modul, pre ktory predchadzajuci test EK zlyhal.

8.1. Konfiguracie externej kontroly

Pozrite si ¢ast 6.11, kde najdete dalSie informacie o povoleni a konfiguracii funkcie EK.

8.2. Postup na vykonanie testu EK

Pri stlaCani dotykového displeja analyzatora QlAstat-Dx Analyzer 2.0 by mali vSetci operatori pouzivat vhodné osobné
ochranné prostriedky, ako su rukavice.
1. Stlacte tlacidlo ° Run Test (Spustit test) v pravom hornom rohu obrazovky Main (Hlavna obrazovka).

Poznamka: Ak je aktivovana externa kontrola (EK) a test EK sa ma €oskoro vykonat, zobrazi sa pripomienka na
spustenie testu so vzorkou EK. Pouzivatelia si mézu vybrat vykonanie testu EK alebo pripomienku zamietnut.
Poznamka: Ak je EK aktivovana a posledny test EK vykonany pomocou vybraného modulu sa nepodaril, zobrazi sa
varovanie. Pouzivatelia si musia jasne vybrat, €i chcu napriek tomu test vykonat’ s vybranym modulom.

2. Zapnite prepinacie tlacidlo testu EK (obrazok 92).

administrator Run Test Module 1 13:21 2023-02-20

'I Ul administrator

TEST DATA

EC TEST [~ @)

Sample ID
Assay Type

Sample Type

EC Sample e

Cancel

Scan or type Sample ID

Obrazok 92. Zapnutie prepinaca testu EK na aktivaciu testu EK.
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3. Po zobrazeni vyzvy naskenujte ¢iarovy kod s ID vzorky pomocou ¢itacky Ciarovych kédov integrovanej v operaénom
module (obrazok 92)
Poznamka: V zavislosti od konfiguracie analyzatora QlAstat-Dx Analyzer 2.0 m6ze byt tiez mozné zadat’ ID vzorky
pomocou virtualnej klavesnice na dotykovej obrazovke. Dal$ie podrobnosti najdete v asti 6.7.4.

4. Po zobrazeni vyzvy naskenujte Ciarovy kéd testovacej kazety QlAstat-Dx, ktora sa mé pouzit. Analyzator QlAstat-Dx

Analyzer 2.0 automaticky rozpozna test, ktory sa ma spustit, na zaklade Ciarového kddu testovacej kazety QlAstat-Dx

(obrazok 93).

Poznamka: Analyzator QlAstat-Dx Analyzer 2.0 neprijima testovacie kazety QlAstat-Dx s uplynutymi datumami

exspiracie, predtym pouzivanymi kazetami alebo kazetami pre testy, ktoré nie su nainStalované v jednotke. V tychto

pripadoch sa zobrazi chybové hlasenie. Dalsie podrobnosti najdete v asti 10.2.
Poznamka: Pozrite si ¢ast 6.6.3, kde najdete pokyny na importovanie a pridanie testov do analyzatora QlAstat-Dx

Analyzer 2.0.

administrator Run Test Module 1 13:21 2023-02-20

’I Ul administrator

TEST DATA

EC TEST &
Sample ID

47283759 v
Assay Type

Sample Type

EC Sample 6

Cancel

Scan Cartridge Barcode

Obrazok 93. Skenovanie ¢iarového kédu testovacej kazety QlAstat-Dx.

5. V pripade potreby vyberte prislusny typ vzorky zo zoznamu (obrazok 94).

Poznamka: V niektorych zriedkavych pripadoch méze byt zoznam vzorovych typov prazdny. V takom pripade je
potrebné kazetu znova naskenovat.
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administrator

‘I Ul administrator
RP

TEST DATA

EC TEST

Sample ID
47283759 v

Assay Type
RP v

Sample Type

EC Sample

Obrazok 94. Vyber typu vzorky.

Run Test Module 1

SAMPLE TYPE

Swab

UTM

Select Sample Type

13:21 2023-02-20

Cancel

6. Vyberte vhodny typ vzorky EK zo zoznamu. Zobrazia sa len vzorky EK pre vybrany typ testu (obrazok 95).

Ak nie su pre vybrany test nakonfigurované ziadne vzorky EK, bude zoznam vzoriek EK prazdny a nebude mozné

spustit’ cyklus testu EK.

Poznamka: Pokyny na konfiguraciu vzoriek EK najdete v Casti 6.11.

edrmareatiaee

| administrator
| RP

TEST DATA

EC TEST &

47283759 -

RP -l
Swab -

Obrazok 95. Vyber vzorky EK.

Frun Tesq hodale 1

EC SAMPLE

RP_EC_Sample Posl

RP_EC_Sample_Meqg

Select EC Sample

1321 20T-02-20

Cancel

7. Zobrazi sa obrazovka Confirm (Potvrdit). Skontrolujte zadané Gdaje a vykonajte potrebné zmeny stlatenim

prislusnych poli na dotykovej obrazovke a Upravou informacii (obrazok 96).
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administrator Run Test Module 1 13:21 2023-02-20

‘I Ul administrator
RP

TEST DATA

EC TEST

Sample ID

47283759 v

Assay Type

RP v

Sample Type

Swab v

EC Sample e
RP_EC_Sample_F +

Cancel

Module 1 | Confirm TEST DATA or click any field to edit
Obrazok 96. Obrazovka Potvrdit.

8. Ked st vietky zobrazené Uidaje spravne, stladte tladidlo ‘@ Confirm (Potvrdit). Ak je to potrebné, stladenim
prislusného pola upravte jeho obsah, alebo stlacenim tladidla Cancel (ZruSit) zruste test.

9. Uistite sa, Ze obidve veka vzoriek v tampdnovom porte a hlavnom porte testovacej kazety QlAstat-Dx su pevne
zatvorené. Ked sa automaticky otvori vstupny port kazety vo vrchnej €asti analyzatora QlAstat-Dx Analyzer 2.0, vlozte
testovaciu kazetu QlAstat-Dx tak, aby Ciarovy kod smeroval dofava a aby reakéné komory smerovali nadol
(obrazok 97).

Poznamka: Ked su k operaénému modulu pripojené viaceré analytické moduly, analyzator QlAstat-Dx Analyzer 2.0
automaticky vyberie analyticky modul, v ktorom sa ma test spustit.

Poznamka: Nie je potrebné zatlacit testovaciu kazetu QlAstat-Dx do analyzatora QlAstat-Dx Analyzer 2.0. Umiestnite
ho spravne do vstupného portu kazety a analyzator QlAstat-Dx Analyzer 2.0 automaticky presunie kazetu do
analytického modulu.

administrator Run Test Module 1 13:22 2023-02-20

F

'I Ul administrator
RP

TEST DATA

Sample ID
47283759

Assay Type

RP

Sample Type

Swab

EC Sample e
RP_EC_Sample_Pos1

Cancel

Module 1 | Insert Cartridge with S/N 180004016
Obrazok 97. Vlozenie testovacej kazety QlAstat-Dx do analyzatora QlAstat-Dx Analyzer 2.0.
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10. Po detegovani testovacej kazety QlAstat-Dx zariadenie QlAstat-Dx Analyzer 2.0 automaticky zatvori veko vstupného
portu kazety a spusti testovaci cyklus. Nevyzaduje sa ziadna dal$ia ¢innost’ obsluhy. Pocas testovacieho cyklu sa na
dotykovej obrazovke zobrazi zostavajuci ¢as cyklu (obrazok 98).

Poznamka: Analyzator QlAstat-Dx Analyzer 2.0 neakceptuje inu testovaciu kazetu QlAstat-Dx ako kazetu, ktora bola
pouzita a naskenovana pocas nastavenia testu. Ak je vloZzena ina kazeta, nez je naskenovana kazeta, vygeneruje sa
chyba a kazeta sa automaticky vysunie.

Poznamka: AZ do tohto bodu je mozné test zrusit’ stlacenim tlacidla Cancel (ZrusSit) v pravom dolnom rohu dotykovej
obrazovky.

Poznamka: V zavislosti od konfiguracie systému moze byt obsluha poziadana o opatovné zadanie pouzivatel'ského
hesla pre spustenie testu.

Poznamka: Veko vstupného portu kazety sa automaticky uzavrie po 30 sekundach, ak testovacia kazeta QlAstat-Dx
nie je umiestnena v porte. Ak k tomu ddjde, zopakujte postup po€nuc krokom 7.

administrator Run Test Module 1 13:22 2023-02-20

F

1 Ul administrator
RP

Run Test
TEST DATA
Sample ID R\élsetms
47283759
Assay Type
RP

Options
Sample Type
Swab
EC Sample

RP_EC_Sample_Pos1

—
o
(=]
(@]
c
=1

Module 1 | Remaining Time ——
Obrazok 98. Vykonanie testu a zobrazenie zostavajuceho ¢asu cyklu.

11. Po dokonceni testovacieho cyklu sa zobrazi obrazovka Eject (Vysunut) (obrazok 99). Stlacte @ Eject (Vysunut) na
dotykovej obrazovke, vysurite testovaciu kazetu QlAstat-Dx a odstrante ju ako biologicky nebezpecny odpad v sulade
so vSetkymi narodnymi, Statnymi a miestnymi predpismi a zakonmi o ochrane zdravia a bezpecnosti pri praci.
Poznamka: Testovacia kazeta QlAstat-Dx by sa mala odstranit, ked sa otvori vstupny port kazety a ked sa vysunie
kazeta. Ak sa kazeta po 30 sekundach neodoberie, automaticky sa vrati spat do analyzatora QlAstat-Dx Analyzer 2.0
a veko vstupného portu kazety sa zatvori. Ak k tomu déjde, znova stlacte tlacidlo Eject (Vysunut), veko vstupného
portu kazety sa otvori a potom kazetu vyberte.

Poznamka: PouZité testovacie kazety QlAstat-Dx sa musia zlikvidovat. Nie je mozné opatovne pouzivat kazety pre

testy, pre ktoré sa uz spustil vykon testu, ale nasledne ich obsluha zrusila, alebo pri ktorych bola zistena chyba.
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administrator Run Test Module 1 13:22 2023-02-20

00:00

1 Ul administrator 2 8 4
RP Not installed Not installed Not installed

TEST DATA

Sample ID
47283759

Assay Type
RP

Sample Type
Swab

EC Sample e
RP_EC_Sample_Pos1

Cancel

Module 1 | Test Completed - Remove Cartridge
Obrazok 99. Zobrazenie obrazovky Eject (Vysunuat).

12. Po vysunuti testovacej kazety QlAstat-Dx sa zobrazi obrazovka vysledkov Summary (Stuhrn) (obrazok 100). Dalsie
podrobnosti najdete v ¢asti 8.3.

administrator Summary 13:22 2023-02-20

'I Ul administrator 2 8 4
RP Not installed Not installed Not installed

. Run Test
TEST DATA QlAstat-Dx® Respiratory Panel
Sample ID Controls Passed
47283759 FCTest @ EC Passed e
Assay Type
v EC Failed
RP None View
Sample Type Results
Swab EC Passed
EC Sample e Influenza A @
RP_EC_Sample_Pos1
P e Influenza B Options
e Influenza A HINT pdm09
e Coronavirus 229E @
Bl summary |~ Amplification Cur. |\ Metting Curves ¥ AMR Genes [El| Test Details i
_— og Ou

ﬁlﬂ: Support Package | E Print Report | E Save Report | LE_| Comment
Obrazok 100. Obrazovka Vysledky suhrnu EK.

Poznamka: Ak sa pocas cyklu vyskytla chyba analytického modulu, méze trvat urcity ¢as, kym sa zobrazia vysledky cyklu
a kym dojde k jeho zobrazeniu v prehlade View Results (Zobrazit' vysledky).

8.3. Zobrazenie vysledkov testu EK

Analyzator QlAstat-Dx Analyzer 2.0 automaticky interpretuje a uklada vysledky testov. Po vysunuti testovacej kazety
QlAstat-Dx sa automaticky zobrazi obrazovka vysledkov Summary (Suhrn) (obrazok 101).

Poznamka: Informacie o moznych vysledkoch a pokyny na interpretaciu vysledkov testov najdete v Specifickych pokynoch
pre test.
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administrator Summary 13:22 2023-02-20

F

1 Available °
Run Test
TEST DATA QlAstat-Dx® Respiratory Panel
Sample ID Controls Passed
47283759 FCTest @ EC Passed e
Assay T
v EC Failed
RP None ke
Sample Type Results
Swab EC Passed
EC Sample e Influenza A @
P_EC_Sample_Pos1
P e Influenza B Options

e Influenza A HINT pdm09
e Coronavirus 229E

®

Bl summary |~ Amplification Cur. |\ Metting Curves ¥ AMR Genes [l Test Details
_— Log Out

ﬁlﬂ: Support Package E Print Report E Save Report LE_| Comment
Obrazok 101. Obrazovka Vysledky suhrnu EK.

V hlavnej ¢asti obrazovky sa zobrazuje celkovy vysledok EK (t. j. EK presla alebo EK zlyhala) a tieto tri zoznamy:

e  Prvy zoznam obsahuje vSetky patogény testované vo vzorke, kde sa o¢akavany vysledok nezhoduje so
skutoénym vysledkom testu, t. j. EK zlyhala. Zahrnuté su len analyty, ktoré sa maju brat' do uvahy vo vzorke EK.
Patogénom zistenym a identifikovanym vo vzorke predchadza znacka 0 a su oznacené Cervenou farbou. Pred
patogénmi, ktoré boli testované, ale neboli detegované, sa nachadza znacka 9 a sl oznacené zelenou farbou.
Pred nejednoznaénymi patogénmi je uvedeny otaznik @ a su zafarbené nazlto.

e Druhy zoznam obsahuje vetky patogény testované vo vzorke, pri ktorych sa o€akavany vysledok
nakonfigurovany vo vzorke EK zhoduje so skuto¢nym vysledkom testu, t. j. EC passed (EK presla). Zahrnuté su
len analyty, ktoré sa maju brat do uvahy vo vzorke EK.

Patogénom zistenym a identifikovanym vo vzorke predchadza znacka 0 a su oznacené Cervenou farbou. Pred
patogénmi, ktoré boli testované, ale neboli detegované, sa nachadza znacka 9 a su oznacené zelenou farbou.

e Treti zoznam obsahuje vSetky patogény testované vo vzorke. Patogénom zistenym a identifikovanym vo vzorke
predchadza znacka 0 a su oznacené Cervenou farbou. Pred patogénmi, ktoré boli testované, ale neboli
detegované, sa nachadza znacka Q a su oznacené zelenou farbou. Pred nejednoznaénymi patogénmi je
uvedeny otaznik € 2 su zafarbené nazito.

e Ak sa test nepodarilo Uspesne dokoncit, zobrazi sa hlasenie ,Failed” (ZIyhanie), po ktorom nasleduje Specificky
kod chyby.

Na lavej strane obrazovky sa zobrazuji nasledujice Test Data (Udaje testu):
e Sample ID (ID vzorky)
e Assay Type (Typ testu)
e Sample Type (Typ vzorky)
o EC sample (Vzorka EK)
e LIS Upload Status (Stav nahravania LIS) (ak je dostupny)

Dalsie Udaje o teste st dostupné v zavislosti od pristupovych prav operatora, prostrednictvom kariet v spodnej &asti
obrazovky (napr. amplifikacné grafy, krivky rozpustania a podrobnosti testu).

Udaje o teste je mozné exportovat stladenim tlagidla Save Report (UloZit spravu) v spodnom paneli obrazovky.
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Spravu je mozné odoslat do tlagiarne stlacenim tlacidla Print Report (Tlacit spravu) v spodnom paneli obrazovky.

Pomocny bali¢ek vybraného cyklu pre vSetky zlyhané cykly je mozné vytvorit stlatenim tlacidla Support Package
(Pomocny bali¢ek) na spodnej liSte obrazovky. Ak je potrebna pomoc, poslite pomocny bali¢ek technickému servisu
spolo¢nosti QIAGEN.

8.3.1. Prezeranie amplifikaCnych kriviek EK

Interpretacia amplifikadnych kriviek sa neliéi od testov bez EK. Dal$ie informécie najdete v &asti 5.5.1.

8.3.2. Prezeranie kriviek rozpustania EK

Interpretacia kriviek rozpustania sa nelisi od testov bez EK. Dal$ie informéacie najdete v &asti 5.5.2.

8.3.3. Zobrazenie génov AMR

Zobrazenie génov AMR sa neli§i od testov bez EK. Dal$ie informéacie najdete v asti 5.5.3.

8.3.4. Zobrazenie podrobnosti o teste EC

Pri prezerani vysledku testu EK stlacte moznost Bl Test Details (Podrobnosti o teste) a zobrazte detailnejSie vysledky EK.

Ak chcete zobrazit Uplny prehlad, posurite sa nadol.

Na obrazovke sa zobrazia nasledujuce Test Details (Podrobnosti testu):

e User ID (ID pouzivatela)

e Cartridge SN (SN kazety) (sériové Cislo)

e Cartridge Expiration Date (Datum exspiracie kazety)

e  Module SN (SN modulu) (sériové €islo)

e Test Status (Stav testu) (Completed (Dokoncené), Failed (Zlyhanie) alebo Canceled (ZruSené) operatorom)

e Test Start Date and Time (Datum a ¢as zaciatku testu)

e Test Execution Time (Cas vykonania testu)

e Assay Name (Nazov testu)

e External Control Test (Test externej kontroly)

e TestID (ID testu)

e Book Order ID (ID uzavretej objednavky) (Viditelné, len ak bola zapnuté kontrola objednavky, ked sa test spustil).
Pozrite si Cast 6.13)

e Order Time (Cas objednavky) (Viditelné, len ak bola zapnuta kontrola objednavky, ked sa test spustil. Pozrite si
Cast' 6.13)

e HIS/LIS Confirmation (Potvrdenie HIS/LIS) (Viditelné, len ak bola zapnuta kontrola objednavky, ked' sa test
spustil. Pozrite si ¢ast' 6.13)

e EC Sample (Vzorka EK)

o Test Result (Vysledok testu) (pre kazdy analyt, celkovy vysledok testu: EK preSla [ecpass] a EK zlyhala [ecfail]).

e  Error Code (Kdd chyby) (ak je to relevantné)

e  Error Message (Chybové hlasenie) (ak je to relevantné)

e Last Comment Editor (Editor posledného komentara) (ak je to relevantné, pozrite si ¢ast 5.5.5)

e Comment Date and Time (Datum a ¢as komentara) (ak je to relevantné, pozrite si ¢ast 5.5.5)

e Comment (Komentar) (ak je to relevantné, pozrite si ¢ast 5.5.5)
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e Ak sa test EK podaril, zhoduju sa o¢akavané vysledky pre kazdy patogén so zistenymi vysledkami.

o List of analytes (Zoznam analytov) testovanych v teste (zoskupené podla Detected Pathogen (Detegovany
patogén), Equivocal (Nejednoznaény), Not Detected Pathogens (Nedetegované patogény), Invalid (Neplatny),
Not Applicable (Neuplatfiuje sa), Out of Range (Mimo rozsahu), Passed Controls (Uspe$né ovladage) a Failed
Controls (Neuspesné ovladace)), s fluorescenciou CT a koncového bodu (ak je k dispozicii pre test).

e Vedla kazdého analytu je zobrazeny o&akavany vysledok a vysledok EK v samostatnych stipcoch. Ak sa v ramci
cyklu EK analyt neberie do Uvahy, nezobrazi sa ziadny oCakavany vysledok ani vysledok EK.

e Stipec s ogakavanym vysledkom je uréeny podia konfiguracie vzorky EK vybranej po¢as nastavenia testu

e Stipec s vysledkom EK je porovnanim medzi skuto&nym vysledkom analytu a oéakavanym vysledkom analytov,
ktoré sa beru do uvahy. Vysledok uspedného testu EK, ak je skuto€ny a oCakavany vysledok rovnaky. Vysledok
neuspesného testu EK, ak nie je skutocny a ocakavany vysledok rovnaky (pozrite si ¢ast' 8.3). Analyty, ktoré sa
neberu do uvahy v ramci cyklu EK, sa neporovnavaju s aktualnym vysledkom.
Poznamka: Oc¢akavané vysledky su zalozené na konfiguracii vzorky EK v ¢ase spustenia testu.

e Zoznam internych kontrol s hodnotami Ct a koncového bodu fluorescencie (ak je k dispozicii pre dany test)

administrator Summary 13:24 2023-02-20
1 Available °
Run Test
TEST DATA TEST DETAILS
Sample ID Test Result ecpass
47283759 Error Code None
Assay Type
RP Deftlected Expected Result  EC Result View
Influenza B Results
Sample Type CL34.1-EP 14007 e Passed
Swab Rhinovirus/Enterovirus e Passed
EC Sample Ct34.2-EP 128,568
P_EC_Sample_Pos1 Adenovirus
Ct37.1-EP 102,230 © Passed  ghions
Equivocal
None @
Bl summary |~ Amplification Cur. |\ Metting Curves ¥ AMR Genes [l Test Details
Log Out
ﬁlﬂ: Support Package E Print Report E Save Report LE_| Comment

Obrazok 102. Obrazovka podrobnosti o teste EK.
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9. Udrzba

Tato Cast’ popisuje ulohy udrzby vyzadované pre analyzator QlAstat-Dx Analyzer 2.0.

9.1.  Ulohy udrzby

Tabulka 21 obsahuje zoznam uloh udrzby, ktoré sa maju vykonat' na analyzatore QlAstat-Dx Analyzer 2.0.

Tabulka 21. Popisy Gloh tdrzby

Uloha Frekvencia

Cistenie alebo dekontaminacia povrchu Vykonava sa, ak sa na povrch QlAstat-Dx Analyzer 2.0 rozliali kvapaliny, chemikalie alebo
analyzatora QlAstat-Dx Analyzer 2.0 biologické vzorky (potencialne infekéné)

Vymena vzduchového filtra Vykonava sa raz ro¢ne

9.2. Cistenie povrchu analyzatora QlAstat-Dx Analyzer 2.0

VAROVANIE/
UPOZORNENIE

A

Nebezpecéenstvo poranenia os6b a materialnych skéd

Pri Cisteni pristroja pouzivajte ochranné okuliare, laboratorny plast a rukavice, aby ste predisli

biologickym a chemickym rizikam.

VAROVANIE/
UPOZORNENIE

A

Nebezpecéenstvo poranenia os6b a materialnych s§kéd

Pred Cistenim odpojte analyzator QlAstat--Dx Analyzer 2.0 z elektrickej zasuvky.

UPOZORNENIE

A

Nebezpecéenstvo poskodenia analyzatora QlAstat-Dx Analyzer 2.0
Zabrarite rozliatiu chemikalii alebo inych kvapalin do alebo z analyzatora QlAstat-Dx Analyzer

2.0. Poskodenie sposobené rozliatim kvapaliny zrusi platnost’ zaruky.

UPOZORNENIE

A

Nebezpecéenstvo poskodenia analyzatora QlAstat-Dx Analyzer 2.0

Zabrante rozliatiu tekutin alebo navlihnutiu dotykovej obrazovky. Na vycistenie dotykovej
obrazovky pouzite semiSovu tkaninu na obrazovku dodavanu s analyzatorom QIlAstat-Dx
Analyzer 2.0.
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Na Cistenie povrchu analyzatora QlAstat-Dx Analyzer 2.0 pouzivajte nasledujuce materialy:

e Jemny Cistiaci prostriedok
e Papierové utierky
e Destilovana voda

Pri Cisteni povrchu analyzatora QlAstat-Dx Analyzer 2.0 postupujte podla nizSie uvedenych krokov:

1. Pouzivajte laboratorne rukavice, plast a ochranné okuliare.

2. Navlh¢ite papierovu utierku v jemnom Cistiacom prostriedku a utrite povrch analyzatora QlAstat-Dx Analyzer 2.0, ako
aj okolie pracovného stola. Dbajte na to, aby ste nenavlh¢ili dotykovu obrazovku. Na vy istenie dotykovej obrazovky
pouzite semiSovu tkaninu na obrazovku dodavanu s analyzatorom QlAstat-Dx Analyzer 2.0.

3. Opakujte krok 2 trikrat s novymi papierovymi utierkami.

4. Navlhcite papierovu utierku v destilovanej vode a povrch analyzatora QlAstat-Dx Analyzer 2.0 utrite, aby sa odstranil
zvySny Cistiaci prostriedok. Opakujte dvakrat.

5. Povrch analyzatora QlAstat-Dx Analyzer 2.0 vysuSte novou papierovou utierkou.

9.3. Dekontaminacia povrchu analyzatora QlAstat-Dx Analyzer 2.0

Nebezpecéenstvo poranenia os6b a materialnych skéd
VAROVANIE/

Pri Cisteni pristroja pouzivajte ochranné okuliare, laboratorny plast a rukavice, aby ste predisli
UPOZORNENIE

biologickym a chemickym rizikam.

A Bielidlo je drazdivé pre oci a pokozku a mbze uvolfovat nebezpeéné plyny (chlér). Pouzivajte

vhodné osobné ochranné prostriedky.

VAROVANIE/
UPOZORNENIE | Nebezpeéenstvo poranenia oséb a materialnych $kéd
A Pred Cistenim odpojte analyzator QlAstat--Dx Analyzer 2.0 z elektrickej zasuvky.

UPOZORNENIE | Nebezpecenstvo posSkodenia analyzatora QlAstat-Dx Analyzer 2.0

Zabrarite rozliatiu chemikalii alebo inych kvapalin do alebo z analyzatora QlAstat-Dx Analyzer
& 2.0. Poskodenie spbsobené rozliatim kvapaliny zrusi platnost zaruky.

UPOZORNENIE Nebezpecenstvo poskodenia analyzatora QlAstat-Dx Analyzer 2.0

Zabrante rozliatiu tekutin alebo navlihnutiu dotykovej obrazovky. Na vycistenie dotykovej
A obrazovky pouzite semiSovu tkaninu na obrazovku dodavanu s analyzatorom QlAstat-Dx
Analyzer 2.0.
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Na dekontaminaciu povrchu analyzatora QlAstat-Dx Analyzer 2.0 pouzivajte nasledujice materialy:
o 10 % roztok bielidla
e  Papierové utierky
e Destilovana voda

Pri dekontaminacii povrchu analyzatora QlAstat-Dx Analyzer 2.0 postupujte podla nizSie uvedenych krokov:

1. Pouzivajte laboratdrne rukavice, plast a ochranné okuliare.

2. Navlh¢ite papierovu utierku v 10 % roztoku bielidla a utrite povrch analyzatora QlAstat-Dx Analyzer 2.0, ako aj okolie
pracovného stola. Dbajte na to, aby ste nenavlhéili dotykovu obrazovku. Pockajte aspon tri minuty, aby bieliaci roztok
zreagoval s kontaminantmi.

3. Dajte si nové rukavice.

4. Opakujte kroky 2 a 3 este dvakrat s novymi papierovymi utierkami.

5. Navlh¢ite papierovu utierku v destilovanej vode a povrch analyzatora QlAstat-Dx Analyzer 2.0 utrite, aby sa odstranilo
zvy$né bielidlo. Opakujte dvakrat.

6. Povrch analyzatora QlAstat-Dx Analyzer 2.0 vysuste novou papierovou utierkou.

9.4. Vymena vzduchového filtra

Vzduchovy filter sa musi vymenit kazdy rok, aby sa zabezpecila primerana rychlost pradenia vzduchu vnutri jednotky.

Vzduchovy filter sa nachadza pod analyzatorom QlAstat-Dx Analyzer 2.0 a je pouzivatelovi pristupny z prednej strany
pristroja.

Ako nahrada sa musia pouzivat vzduchové filtre od spolo€nosti QIAGEN. Katalégové Cislo tohto materialu je: 9026189
zasobnik vzduchového filtra

Pri vymene vzduchového filtra postupuijte nasledovne:

1. Analyzator QlAstat-Dx Analyzer 2.0 nastavte do pohotovostného rezimu stlacenim tlacidla ON/OFF (Zap./Vyp.) na
prednej strane pristroja.

2. Umiestnite ruku pod zasuvku vzduchového filtra na prednej strane analyzatora QlAstat-Dx Analyzer 2.0 a prstami
jemne zatlacte nahor.

3. Potiahnite vzduchovy filter dozadu, az kym sa zasuvka filtra Uplne neodstrani. Stary vzduchovy filter zlikvidujte.

4. Vyberte novu zasuvku vzduchového filtra z ochranného vrecka.

5. Vlozte novu zasuvku vzduchového filtra do analyzatora QlAstat-Dx Analyzer 2.0. Zariadenie je teraz pripravené na

pouzitie.

UPOZORNENIE | Nebezpeéenstvo poskodenia analyzatora QlAstat-Dx Analyzer 2.0
f Pouzivajte iba originalne diely od spolo¢nosti QIAGEN. Pouzitie nepovolenych dielov méze mat
za nasledok poSkodenie zariadenia a zruSenie zaruky.

9.5. Oprava analyzatora QlAstat-Dx Analyzer 2.0

Opravu analyzatora QlAstat-Dx Analyzer 2.0 smu vykonavat' len zastupcovia autorizovani spolo¢nostou QIAGEN. Ak
analyzator QlAstat-Dx Analyzer 2.0 nefunguje podfa oCakavania, obratte sa na technicky servis spolocnosti QIAGEN

pouzitim kontaktnych udajov uvedenych v Casti 10.
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Nebezpeéenstvo poranenia os6b a materialnych skod
VAROVANIE/ | Neotvérajte kryt analyzatora QlAstat-Dx Analyzer 2.0. Nepokusajte sa opravovat alebo
UPOZORNENIE | upravovat analyzator QlAstat-Dx Analyzer 2.0.

Neodbornym otvorenim krytu alebo Upravou analyzatora QlAstat-Dx Analyzer 2.0 méze dojst k
poraneniu pouzivatela a poskodeniu analyzatora QlAstat-Dx Analyzer 2.0 a zruSeniu platnosti

zaruky.
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10. RieSenie problémov

Tato Cast' poskytuje informacie o niektorych problémoch, ktoré sa mézu vyskytnut v suvislosti s analyzatorom QIlAstat-Dx
Analyzer 2.0, spolu s moznymi pric¢inami a rieSeniami. Informacie su Specifické pre dany pristroj. Informacie o rieSeni
problémov tykajucich sa testovacej kazety QlAstat-Dx najdete v navode na pouzitie prisludnej kazety.

Ak je potrebna dalSia pomoc, obratte sa na technicky servis spolo¢nosti QIAGEN pomocou nizsie uvedenych kontaktnych
informacii:

Webova stranka: support.qiagen.com

Pri kontaktovani technického servisu spolo¢nosti QIAGEN z dévodu chyby tykajucej sa analyzatora QlAstat-Dx Analyzer
2.0 majte na pamati kroky veduce k chybe a vSetky informacie, ktoré sa zobrazuju v dialégovych oknach. Tieto informacie
pomé&zu oddeleniu technického servisu spolo€nosti QIAGEN problém vyriesit.

Pri kontaktovani technického servisu spolo¢nosti QIAGEN v suvislosti s chybami si pripravte nasledujiuce informécie:

sérioveé Cislo, typ, verzia softvéru a nainstalované subory definicie testu analyzatora QlAstat-Dx Analyzer 2.0
kod chyby (ak je to relevantné),

okamih, kedy sa chyba vyskytla prvykrat,

frekvencia vyskytu chyb (t. j. ob&asna alebo trvala chyba),

fotografia chyby, ak je to mozné,

pomocny balicek.

10.1. Chyby hardvéru a softveru

Chyba Mozna pri¢ina Komentare a navrhy

The QlAstat - Dx Analyzer  Analyzator QlAstat-Dx Analyzer 2.0 nie  Skontrolujte, ¢i je analyzator QlAstat-Dx Analyzer 2.0 pripojeny k elektrickému
2.0 does not start. je pripojeny k elektrickej zasuvke. napajaniu.

(Analyzator QIAstat - DX pjayng vypinaé na zadnej strane Zapnite zariadenie pomocou hlavného vypinaga na zadnej strane analyzatora
Analyzer 2.0 sa nespust.)  analyzatora QIAstat-Dx Analyzer 2.0 nie  QlAstat-Dx Analyzer 2.0.
je zapnuty.
Analyzator QlAstat-Dx Analyzer 2.0 je v Stlaenim tlacidla ON/OFF (Zap./Vyp.), zruste pohotovostny rezim analyzatora
pohotovostnom rezime. QlAstat-Dx Analyzer 2.0.
Nastal kratky vypadok napajania. Pred opatovnym zapnutim analyzatora QlAstat-Dx Analyzer 2.0 pockajte niekolko

sekund. Ak nenechate pristroj pred zapnutim niekolko sekund necinny, spustenie
systému sa nemusi podarit.

Analytical Module not Most analytického/operaéného modulu  Skontrolujte, i je most medzi operaénym modulom a analytickym modulom spravne
detected. (Analyticky nie je spravne pripojeny. pripojeny.

modul nebol

zaznamenany.)

The Analytical Module Chyba hardvéru. Pokuste sa restartovat analyticky modul na stranke stavu modulu (pozrite si ast’
status indicator is red. 6.1.3)

(Indikator stavu ) Ak problém pretrvava, obratte sa na technicky servis spoloénosti QIAGEN.
analytického modulu je

cerveny.)

The touchscreen does not  Analyzator QlAstat-Dx Analyzer 2.0 je v Stlacte tlacidlo ON/OFF (Zap./Vyp.) na operaénom module.

respond. (Dotykova pohotovostnom rezime (indikator stavu Kontaktujte technicky servis spolonosti QIAGEN.

obrazovka nereaguje.) je modry).

Chyba hardvéru.
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Chyba

Mozna pric¢ina

Komentare a navrhy

Bar code reader does not
scan. (Citacka ¢iarovych
kédov neskenuje.)

The QlAstat - Dx assay
cartridge is stuck inside the
QlAstat - Dx Analyzer 2.0.
(Testovacia kazeta QlAstat -
Dx sa zasekla v analyzatore
QlAstat - Dx Analyzer 2.0.)

Lid of the cartridge
entrance port does not
open. (Veko vstupného
portu kazety sa neotvara.)

The Run Test button is
not active. (Tlacidlo Run
Test (Spustit test) nie je
aktivne.)

Assay does not run. (Test
sa nespusti.)

Result upload status is
“Error”. (Stav nacitania
vysledku je ,Error”
(Chyba).)

A result cannot be
uploaded. (Vysledok nie je
mozné nahrat.)

Cannot run a test because
there is no test order.
(Test nie je mozné spustit,
pretoZe neexistuje Ziadna
objednavka testovania.)

Printer is not setup
correctly, or test reports
cannot be printed.
(Tlagiaren nie je spravne
nastavena alebo nie je
mozné vytlacit spravy o
teste.)

Time zone change is not
applied. (Nie je pouzita
zmena ¢asového pasma.)
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Funkcia ¢iarového kédu pre ID vzorky
nie je povolena.

Citagka &iarovych kédov ma hardvérovy
alebo softvérovy problém.

Mechanicka porucha modulu.

Mechanicka porucha modulu.

Testovacia kazeta QlAstat-Dx je stéle v
analyzatore QlAstat-Dx Analyzer 2.0 a
musi sa vysunut eSte predtym, ako
analyzator QlAstat-Dx Analyzer 2.0
umozni vykonanie nového testu.

Modul nie je k dispozicii.

Pouzivatel nema prava na spustenie
testu.

Test nie je nainstalovany v analyzatore
QlAstat-Dx Analyzer 2.0.

Pripojenie s hostitefom sa stratilo.

Komunikacia s hostitefom vyprsala.

Sprava bola odmietnuta hostitefom.

Stav vysledku exspiroval.

Pre ID vzorky neexistuje Ziadna
objednavka testovania a v nastaveniach
HIS/LIS je povolena moznost Force
Order (Vynutenie objednavky).

Problém s pripojenim LIS a v
nastaveniach HIS/LIS je povolena
moznost Force Order (Vynutenie
objednavky).

Existuju rozne pri¢iny poruchy tlaciarne.

Zariadenie nerozpoznalo vybrané
casové pasmo.

Ak chcete nakonfigurovat funkciu ¢iarového kédu na analyzatore QlAstat-Dx
Analyzer 2.0, obratte sa na veduceho laboratdria alebo na spravcu pristroja.

Kontaktujte technicky servis spolo¢nosti QIAGEN.

Kontaktujte technicky servis spolo¢nosti QIAGEN.

Kontaktujte technicky servis spolo¢nosti QIAGEN.

Stavové pole modulu v stavovom riadku modulu by malo zobrazovat text ,Eject
cartridge” (Vysunut kazetu). Stlacte stavové pole modulu a potom stlacte tlacidlo
Eject (Vysunut).

Skontroluijte, ¢i je most medzi operaénym modulom a analytickym modulom spravne
pripojeny.
Obratte sa na veduceho laboratéria alebo spravcu pristroja.

Test sa musi nainstalovat. Obratte sa na veduceho laboratdria alebo spravcu
pristroja.

Obrétte sa na veduceho laboratéria alebo spravcu pristroja, aby skontroloval
podrobnosti pripojenia a otestoval pripojenie.

Obrétte sa na veduceho laboratéria alebo spravcu pristroja, aby skontroloval
hodnotu nastavenia Timeout (Casovy limit), ktory sa méze zvysit na maximalnu
hodnotu 60 sekund. Ak je uz nastavena maximalna hodnota, mal by sa skontrolovat
vykon siete.

Hostitel' z nejakého dévodu odmietol spravu (test nebol rozpoznany, sémantické
problémy atd.). Kontaktujte technicky servis spoloénosti QIAGEN.

Obratte sa na veduceho laboratdria alebo spravcu pristroja, aby skontroloval Expire
Time (Cas exspiracie) v nastaveniach HIS/LIS.

Obrétte sa na spravcu LIS a skontrolujte, &i v LIS existuje objednavka pre
$pecifikovany ID vzorky.

Obratte sa na veduceho laboratéria alebo spravcu pristroja, aby skontroloval
pripojenie s hostitelom.

Ak chcete spustit' test bez objednavky testovania, zakazte moznost Force Order
(Vynutenie objednavky) v nastaveniach HIS/LIS.

Navstivte stranku QIAGEN.com/QlAstat-Dx_PrinterSetup, kde najdete ¢asto
kladené otazky tykajuce sa rieSenia problémov s nastavenim tlaciarne a
odporuéania, ako sa vyhnut beznym problémom s tlaciarfiou.

Vyberte iné ¢asové pasmo s rovnakou odchylkou.
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10.2. Chyboveé kdédy a varovné hlasenia

Chybovy kéd (kody)
0x00000001
0x00000002
0x00000003

0x00000004

0x00000005
0x00000006

0x00000013
0x0000010A

0x0000010D

0x00000303

0x00000304
0x00000305
0x00000306
0x00000307
0x00000308

0x00000309

0x00000310

0x00000311

0x00000312

0x00000401
0x00000402
0x00000403

0x00000404

0x00000405

0x00000406
0x00000424

0x00000431
0x00000433

0x00000490
0x000004F0
0x000004F1

0x00000510
0x00000511

0x00000516
0x00000517
0x0000051A
0x0000051B

Chybové hlasenie
Analytical Module <Number> Problem with lid. (Analyticky modul <€islo> Problém s vekom.)
Analytical Module <Number> Error by closing lid. (Analyticky modul <&islo> Chyba pri zatvoreni veka.)

Analytical Module <Number> Barcode reading failed. (Analyticky modul <€islo> Nacitanie ¢iarového kédu
neuspesné.)

Analytical Module <Number> Downloading test failed (Crc) (Analyticky modul <Cislo> Prevzatie testu
zlyhalo (Crc))

Analytical Module <Number> AAF parse error (Analyticky modul <&islo> Chyba analyzy AAF)

Analytical Module <Number> Downloading AAF failed. (Analyticky modul <¢islo> Preberanie AAF
zlyhalo.)

Analytical Module <Number> AAF too long (Analyticky modul <¢€islo> Prili§ dlhé AAF)

Cannot create archive due to existing archives stored on USB device. (Neda sa vytvorit archiv z dévodu
existujucich archivov uloZzenych v zariadeni USB.) Remove archives from USB device or use different
USB device. (Odstrarite archivy zo zariadenia USB alebo pouzite iné USB zariadenie.)

The selected file: <File Name> , is not supported. (Zvoleny subor: <Nazov suboru> nie je podporovany.)
Please select a file of type: <File type> (Vyberte typ suboru: <Typ suboru>)

Assay <assay name> requires version <required version>, actual <actual version>. (Test <nazov testu>
vyzaduje verziu <pozZadovana verzia>, aktualne <aktualna verzia>.)

Assay <assay name> already imported. (Test <nazov testu> je uz importovany.)

Importing <assay name> failed. (Importovanie <nazov testu> zlyhalo.)

Invalid sample type definition found. (Nas$la sa neplatna definicia typu vzorky.)

Invalid error code detected in file <file name>. (V subore <nazov suboru> sa zistil neplatny chybovy kod.)

Error loading the assay <assay name>. (Chyba pri nacitani testu <nazov testu>.) Please eject the
cartridge and insert it again. (Vysurite a znova zasurite kazetu.)

Invalid flex data detected in the file <file name>. (V subore <nazov suboru> sa zistili neplatné flexibilné
udaje.)

Invalid AMR Gene definition in the file <file name>. (Neplatna definicia génu AMR v subore <nazov
suboru>.)

Invalid flag for showing Plots and CT/EP values for AMR genes <analyte names>. (Neplatny znak na
zobrazovanie grafov a hodnét CT/EP pre gény AMR <nazvy analytov>.)

Invalid Semi-Quantification data detected in the file <file name>. (Neplatné semikvantifikacné tdaje
zistené v subore <nazov suboru>.)

Assay <assay name> not available. (Test <nazov testu> nie je dostupny.)
Assay <assay name> not active. (Test <nazov testu> nie je aktivny.)

This user does not have permission to execute this assay. (Tento pouzivatel nema povolenie na
vykonavanie tohto testu.)

Assay <assay name> requires version <version number>. (Test <nazov testu> vyzaduje verziu <¢islo
verzie>.)

Analytical Module <Number>: (Analyticky modul <¢islo>:) Assay <assay name> requires version
<version number>. (Test <ndazov testu> vyzaduje verziu <&islo verzie>.)

A newer version of the assay is required. (Vyzaduje sa novsia verzia testu.)

Analytical Module <Number>: (Analyticky modul <€islo>:) Eject not possible, cartridge is too hot.
(Vysunutie nie je mozné, kazeta je prilis horuca.)

Failed to scan barcode. (Nepodarilo sa naskenovat ¢iarovy kéd.)

Analytical Module <Number>: (Analyticky modul <&islo>:) Different cartridge inserted (Je vlozena ina
kazeta.)

The processing module is not valid. (Modul na spracovanie nie je platny.)
Cartridge already used. (Kazeta uz bola pouzita.)

Cartridge expired. (Kazeta exspirovala.)

Transmitting barcode failed (Crc) (Prenos ¢iarového kédu zlyhal (Znak))
Transmitting barcode failed (Length) (Prenos &iarového kédu zlyhal (Dizka))
Invalid identification data (Crc) (Neplatné identifikacné udaje (Znak))

Invalid identification data (Length) (Neplatné identifikaéné udaje (Dizka))
Invalid calibration data (Crc) (Neplatné kalibra¢né udaje (Znak))

Invalid calibration data (Length) (Neplatné kalibraéné tdaje (Dizka))
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Chybovy kod (kody)
0x0000051C

0x0000051D

0x0000051E

0x0000051F

0x00000520

0x00000521

0x00000522

0x00000601
0x00000607
0x00000608
0x00000609

0x00000602
0x00000603
0x00000604
0x00000605
0x00000606
0x0000060A

0x0000060B
0x00000805

0x00000902

0x00001001
0x00001002
0x00001003

0x00001020
0x00001021
0x00001022
0x00001023
0x00001024
0x00001030

0x00001031
0x00001032

0x00001033
0x00001034
0x00001035
0x00001036
0x00001037
0x00001064
0x00001065
0x00001066
0x00001067
0x00001068
0x000010C8
0x000010C9
0x000010CA
0x000010CB
0x000010CC
0x000010CD

Chybové hlasenie

Analytical Module <Number>: (Analyticky modul <¢&islo>:) Calibration Parameters Crc Error (Chyba
znakov parametrov kalibracie)

Analytical Module <Number>: (Analyticky modul <€islo>:) Calibration Parameters Length Error (Chyba
dizky parametrov kalibracie)

Calibration of Analytical Module <Number> required in <number> days. (Kalibracia analytického modulu
<¢islo> sa vyzaduje za <pocet> dni.)

Maintenance of Analytical Module <Number> required in <number> days. (Udrzba analytického modulu
<¢&islo> sa vyZaduje za <pocet> dni.)

Analytical Module <Number>: (Analyticky modul <€islo>:) Test record rejected - test start time is older
than 90 minutes. (Zaznam o teste zamietnuty — ¢as zaciatku testu je viac ako 90 minut.)

Analytical Module <Number>: (Analyticky modul <gislo>:) Test result data lost. (Udaje vysledku testu sa
stratili.)

No free module available. (Nie je k dispozicii ziadny volny modul.)

Assay invalid CRC (Neplatné znaky testu)

User data invalid CRC (Neplatné znaky udajov pouzivatela)
Udaje profilu pouzivatela neplatné CRC

Test record invalid CRC (Neplatné znaky zaznamu o teste)
Database not found. (Databaza sa nenasla.)

Database is not compatible. (Databaza nie je kompatibilna.)

An unexpected data base exception happened. (Nastala neo¢akavana vynimka databazy.) Device will
restart. (Zariadenie sa restartuje.)

Failed to rename Database (Nepodarilo sa premenovat databazu)

An error occurred during the deletion of <printer name>. (Pocas odstrariovania tlaciarne <nazov
tlaciarne> nastala chyba.)

Error downloading the file <file name> from network share. (Chyba pri preberani stiboru <nazov suboru>
zo zdielanej siete.)

No connection to HIS/LIS. (Ziadne pripojenie k HIS/LIS.)

Message type mismatch. (Nesulad typu hlasenia.)

Processing ID mismatch. (Nesulad ID spracovania.)

Protocol version mismatch. (Nesulad verzie protokolu.)

Message control id mismatch. (Nesulad kontrolného ID hlasenia.)
Parse error. (Chyba analyzy.)

Wrong query tag. (Nespravna znacka poziadavky.)

Order not found. (Objednavka sa nenasla.)

Sample ID mismatch. (Nesulad ID vzorky.)

Ordered assay not installed. (Objednany test nie je nainstalovany.)
Unknown sample type. (Neznamy typ vzorky.)

Assay not in order list (Test nie je v zozname objednavok)

Sample type mismatch (Nesulad typu vzorky)

Message segments not in proper order. (Segmenty s hlaseniami nie su v spravnom poradi.)
Required field is missing. (Chyba poZadované pole.)

Wrong data type. (Nespravny typ tdajov.)

Field data identifier mismatch. (Nesulad identifikatora datového pola.)
HIS/LIS internal error. (Interna chyba HIS/LIS.)

Unsupported message type. (Nepodporovany typ hlasenia.)
Unsupported event code. (Nepodporovany kéd udalosti.)
Unsupported processing ID. (Nepodporované ID spracovania.)
Unsupported version ID. (Nepodporované ID verzie.)

ID not found. (ID sa nenaslo.)

Order already in process. (Objednavka sa uz spracuva.)
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Chybovy kod (kody)
0x000010CE
0x000010CF
0x00002101
0x0000F001
0x0000F002

0x0000F004

0x0067
0x0068

0x0069

0x00EF
0x00F1

0x00F2
0x00F3
0x00F4
0x00F5
0x00F6
0x00F7
0x00F8
0x00F9
0x00FD
0x00FE
0x00FF

0x01008000
0x01008001

0x01008002
0x01008003
0x01008004
0x01008005
0x01008006
0x0100800B
0x0100800D
0x0100800E
0x01008010
0x01008011

0x01008012
0x01008013
0x01008014
0x01008015
0x01008016
0x01008017
0x01008021

0x01008022
0x01008023

0x01008007

0x01008008

0x01008009

0x0100800A

0x0100800C

0x0100800F
0x0100801A
0x0100801B
0x0100801C
0x0100801D
0x0100801E
0x0100801F
0x01008020

Chybové hlasenie

Server not available. (Server nie je dostupny.)

HIS/LIS internal error. (Interné chyba HIS/LIS.)

The system was not shut down properly last time. (Systém nebol naposledy vypnuty spravne.)
Unexpected AM found (Zistilo sa neo¢akavané AM)

Unexpected behavior of Analytical Module <Number>. (Neo¢akavané spravanie analytického modulu
<¢&islo>.)

A Process Module error occurred. (Nastala chyba procesného modulu.) Please see system log for more
information. (Viac informacii najdete v systémovom denniku.)

Failure on cartridge clamping. (Zlyhanie upevnenia kazety.) Please retry. (Skuste to znova.) If this error
persists please contact QIAGEN Technical Services (Ak tato chyba pretrvava, kontaktujte technicky
servis spolo¢nosti QIAGEN)

Atmospheric pressure is out of the analyzer operational range. (Atmosféricky tlak je mimo prevadzkového
rozsahu analyzatora.) Please contact QIAGEN Technical Services (Kontaktujte technicky servis
spolo¢nosti QIAGEN)

Failure on PCR readings. (Zlyhanie pri ¢itani PCR.) Please repeat with another cartridge. (Zopakujte s
inou kazetou.) If this error persists please contact QIAGEN Technical Services (Ak tato chyba pretrvava,
kontaktujte technicky servis spolo¢nosti QIAGEN)

Switch off the analyzer and restart it again. (Vypnite a znovu zapnite analyzator.) If this error persists
please contact QIAGEN Technical Services (Ak tato chyba pretrvava, kontaktujte technicky servis
spolo¢nosti QIAGEN)

Analyzer internal temperature below working temperature range. (Vnutorna teplota analyzatora je pod
rozsahom pracovnej teploty.) Wait for the analyzer to warm up and then restart the unit. (Pockajte, kym
sa analyzator zahreje, a potom jednotku znova spustte.) If the error persists please contact QIAGEN
Technical Services (Ak chyba pretrvava, kontaktujte technicky servis spolo¢nosti QIAGEN)

Analyzer internal temperature above working temperature range. (Vnutorna teplota analyzatora je nad
rozsahom pracovnej teploty.) Verify analyzer placement. (Skontrolujte umiestnenie analyzatora.) Check
'Site Requirements' section in the User manual (Pozrite si €ast’ ,PoZiadavky na pracovisko” v navode na
pouzitie)

Temperature during assay execution too high. (Teplota je po¢as vykonavania testu prili§ vysoka.) Verify
analyzer placement. (Skontrolujte umiestnenie analyzatora.) Check 'Site Requirements' section in the
User manual (Pozrite si ¢ast' ,Poziadavky na pracovisko® v navode na pouzitie)

Analyzer tilted. (Analyzator je nakloneny.) Verify placement. (Skontrolujte umiestnenie.) Check 'Site
Requirements' section in the user manual (Pozrite si ¢ast' ,PoZiadavky na pracovisko” v navode na
pouzitie)

Firmware update needed. (Je potrebna aktualizacia firmvéru.) Search on QIAGEN website the most
recent software version (Na webovej stranke spolo¢nosti QIAGEN vyhladajte najnovsiu verziu softvéru)

Analyzer failure. (Porucha analyzatora.) Please contact QIAGEN Technical Services (Kontaktujte
technicky servis spolo¢nosti QIAGEN)
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Chybovy kod (kody) Chybové hlasenie
0x01008025
0x01008026
0x01008027
0x01008028
0x01008029
0x0100802A
0x0100802B
0x0100802C
0x0100802E
0x0100807F
0x01008080
0x010080FF
0x01008100
0x01008101
0x01008102
0x01008103
0x01008104
0x01008105
0x01008106
0x01008107
0x0100813F
0x01008140
0x01008141
0x0100817F
0x01008180
0x01008181
0x010081FF
0x01008200
0x01008201
0x01008202
0x01008203
0x01008204
0x01008205
0x01008206
0x01008207
0x01008208
0x01008209
0x0100820A
0x0100820B
0x0100822F
0x01008230
0x01008235
0x01008250
0x01008251
0x01008252
0x01008253
0x01008254
0x01008255
0x010082A0
0x010082A1
0x010082A2
0x010082A3
0x010082FF
0x01008300
0x010083FF
0x01008400
0x01008401
0x01008402
0x01008403
0x01008404
0x01008405
0x01008406
0x01008407
0x01008408
0x01008409
0x0100840A
0x0100840B
0x0100840C
0x0100841F
0x01008500
0x01008501
0x01008502
0x01008504
0x01008508
0x01008510
0x01008520
0x01008540
0x01008580
0x01008581
0x0100858F
0x01008605
0x01008606
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Chybovy kod (kody)
0x01008607
0x01008608
0x01008609
0x0100860A
0x0100860B
0x0100860C
0x0100860D
0x0100860E
0x0100860F
0x01008610
0x01008611
0x01008612
0x01008613
0x01008614
0x01008615
0x01008616
0x01008617
0x01008618
0x01008619
0x0100861A
0x0100861B
0x010086EF
0x010086F0
0x010086FF
0x01008700
0x01008701
0x01008783
0x01008800
0x01008801
0x01008802
0x01008803
0x01008804
0x01008805
0x01008806
0x01008807
0x01008808
0x01008809
0x0100880A
0x0100880B
0x0100880C
0x0100880D
0x0100880E
0x0100881F

0x01008018
0x01008410
0x01008411
0x01008412
0x01008413
0x01008414
0x01008417
0x01008418

0x01008019

0x01008024

0x01008081

0x01008231
0x01008232
0x01008236
0x01008233
0x01008237

0x01008231
0x01008232
0x01008236
0x01008233
0x01008237

0x01008234
0x01008238

0x01008301

0x01008306
0x0100830B
0x01008310
0x01008315
0x0100831A
0x0100831F

Chybové hlasenie

Retry cartridge insertion. (Skuste znova vlozit kazetu.) If this error persists please contact QIAGEN
Technical Services (Ak tato chyba pretrvava, kontaktujte technicky servis spolo¢nosti QIAGEN)

Software update failure. (Aktualizacia softvéru zlyhala.) Please contact QIAGEN Technical Services
(Kontaktujte technicky servis spolo¢nosti QIAGEN)

Filter tray not properly closed. (Zasobnik filtra nie je spravne zavrety.) Ensure filter tray is correctly closed
and switch off/on the Operational Module power button (Uistite sa, Ze zasobnik filtra je spravne zavrety a
vypnite/zapnite hlavny vypina¢ opera¢ného modulu)

Assay execution failure. (Vykonanie testu zlyhalo.) Please contact QIAGEN Technical Services
(Kontaktujte technicky servis spolo¢nosti QIAGEN)

gPCR stage failure. (Chyba fazy qPCR.) Please contact QIAGEN Technical Services (Kontaktujte
technicky servis spolo¢nosti QIAGEN)

Syringe positioning failure. (Chyba umiestnenia striekacky.) Please contact QIAGEN Technical Services
(Kontaktujte technicky servis spolo¢nosti QIAGEN)

Failure thermal unit motor positioning. (Chyba umiestnenia motora termalnej jednotky.) Please contact
QIAGEN Technical Services (Kontaktujte technicky servis spolo¢nosti QIAGEN)

Motor failure (TC1). (Porucha motora (TC1).) Please contact QIAGEN Technical Services (Kontaktujte
technicky servis spolo¢nosti QIAGEN)
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Chybovy kod (kody) Chybové hlasenie
0x01008324
0x01008329
0x0100832E
0x01008333
0x01008338
0x0100833D
0x01008342
0x01008347
0x0100834C
0x01008351
0x01008356
0x0100835B
0x01008360
0x01008365
0x0100836A
0x0100836F
0x01008374
0x01008379
0x0100837E

0x01008302 Motor failure (TC2). (Porucha motora (TC2).) Please contact QIAGEN Technical Services (Kontaktujte

0x01008307 technicky servis spolo€nosti QIAGEN)
0x0100830C
0x01008311
0x01008316
0x0100831B
0x01008320
0x01008325
0x0100832A
0x0100832F
0x01008334
0x01008339
0x0100833E
0x01008343
0x01008348
0x0100834D
0x01008352
0x01008357
0x0100835C
0x01008361
0x01008366
0x0100836B
0x01008370
0x01008375
0x0100837A
0x0100837F

0x01008303 Motor failure (CC). (Porucha motora (CC).) Please contact QIAGEN Technical Services (Kontaktujte
0x01008308 technicky servis spolo¢nosti QIAGEN)
0x0100830D
0x01008312
0x01008317
0x0100831C
0x01008321
0x01008326
0x0100832B
0x01008330
0x01008335
0x0100833A
0x0100833F
0x01008344
0x01008349
0x0100834E
0x01008353
0x01008358
0x0100835D
0x01008362
0x01008367
0x0100836C
0x01008371
0x01008376
0x0100837B
0x01008380

0x01008304 Motor failure (BB). (Porucha motora (BB).) Please contact QIAGEN Technical Services (Kontaktujte
0x01008309 technicky servis spolo¢nosti QIAGEN)

0x0100830E

0x01008313

0x01008318

0x0100831D

0x01008322

0x01008327

0x0100832C
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Chybovy kod (kody) Chybové hlasenie
0x01008331
0x01008336
0x0100833B
0x01008340
0x01008345
0x0100834A
0x0100834F
0x01008354
0x01008359
0x0100835E
0x01008363
0x01008368
0x0100836D
0x01008372
0x01008377
0x0100837C
0x01008381
0x01008383
0x01008384
0x01008387

0x01008305 Motor failure (Lid). (Porucha motora (Veko).) Please contact QIAGEN Technical Services (Kontaktujte

0x0100830A technicky servis spolo¢nosti QIAGEN)
0x0100830F
0x01008314
0x01008319
0x0100831E
0x01008323
0x01008328
0x0100832D
0x01008332
0x01008337
0x0100833C
0x01008341
0x01008346
0x0100834B
0x01008350
0x01008355
0x0100835A
0x0100835F
0x01008364
0x01008369
0x0100836E
0x01008373
0x01008378
0x0100837D
0x01008382

0x01008420 Failure on thermal unit. (Porucha na termalnej jednotke.) Please contact QIAGEN Technical Services
0x01008421 (Kontaktujte technicky servis spolo¢nosti QIAGEN)
0x01008422
0x01008423
0x01008424
0x01008425
0x01008426
0x01008427
0x01008428
0x01008429
0x0100842A
0x0100842B
0x0100842C
0x0100842D
0x0100842E
0x0100842F
0x01008430
0x01008431
0x01008432
0x01008433
0x01008434
0x01008435
0x01008436
0x01008437
0x01008438
0x01008439
0x0100843A
0x0100843B
0x0100843C
0x0100843D
0x0100843E
0x0100843F
0x01008440
0x01008441
0x01008442
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Chybovy kod (kody) Chybové hlasenie
0x01008443
0x01008444
0x01008445
0x01008446
0x01008447
0x01008448
0x01008449
0x0100844A
0x0100844B
0x0100844C
0x0100844D
0x0100844E
0x0100844F
0x01008450
0x01008451
0x01008452
0x01008453
0x01008454
0x01008455
0x01008456
0x01008457
0x01008458
0x01008459
0x0100845A
0x0100845B
0x01008460
0x01008461
0x01008462
0x01008463
0x01008464
0x01008465
0x01008466
0x01008467
0x01008468
0x01008469
0x0100846A
0x01008470
0x01008471
0x01008472
0x01008473
0x01008474
0x01008475
0x01008476
0x01008477
0x01008478
0x01008479
0x0100847A
0x0100847B
0x0100847C
0x01008480
0x01008481
0x01008482
0x01008483
0x01008484
0x01008485
0x01008486
0x01008487
0x01008488
0x01008489
0x0100848A
0x0100848B
0x0100848C
0x01008490
0x01008491
0x01008492
0x01008493
0x01008494
0x01008495
0x01008496
0x01008497
0x01008498
0x01008499
0x0100849A
0x0100849B
0x0100849C
0x0100849D
0x0100849E
0x0100849F
0x010084A0
0x010084A1
0x010084A2
0x010084A3
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Chybovy kod (kody) Chybové hlasenie

0x010084A4
0x010084A5
0x010084A6
0x010084B0
0x010084B1

0x010084B2
0x010084B3
0x010084B4
0x010084B5
0x010084B6
0x010084B7
0x010084B8
0x010084B9
0x010084BA
0x010084BB
0x010084BC
0x010084BD
0x010084BE
0x010084BF
0x010084C0
0x010084C1

0x010084C2
0x010084C3
0x010084C4
0x010084C5
0x010084C6
0x010084C7
0x010084C8
0x010084D0
0x010084D1

0x010084D2
0x010084D3
0x010084D4
0x010084E0
0x010084E1

0x010084E2
0x010084E3
0x010084E4
0x010084E5
0x010084E6
0x010084E7
0x010084E8
0x010084E9
0x010084EA
0x010084EB
0x010084FF

0x01008702 Failure on TRF module. (Porucha na module TRF.) Please contact QIAGEN Technical Services
0x01008703 (Kontaktujte technicky servis spolo¢nosti QIAGEN)
0x01008704

0x01008705

0x01008706

0x01008707

0x01008708

0x01008709

0x0100870A

0x0100870B

0x0100870C

0x0100870D

0x0100877F

0x01008780 Failure on gPCR module. (Porucha na module gPCR.) Please contact QIAGEN Technical Services
0x01008781 (Kontaktujte technicky servis spolo¢nosti QIAGEN)
0x01008782
0x01008784
0x01008785
0x01008786
0x01008787
0x01008788
0x01008789
0x0100878A
0x0100878B
0x0100878C
0x0100878D
0x0100878E
0x0100878F
0x01008790
0x01008791
0x01008792
0x01008793
0x01008794
0x01008795
0x01008796
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Chybovy kod (kody) Chybové hlasenie
0x01008797
0x01008798
0x01008799
0x0100879A
0x0100879B
0x0100879C
0x0100879D
0x0100879E
0x0100879F
0x010087FF

0x012E Cartridge execution failure. (Zlyhanie vykonania testu kazety.) Please repeat with another cartridge
0x0137 (Zopakujte s inou kazetou)
0x0138
0x0139
0x0154
0x016D
0x016E
0x016F
0x0170
0x0171
0x019C
0x01B8
0x01F6
0x01FF
0x0200
0x021C
0x025A
0x0264
0x0265
0x0280
0x028A
0x028B
0x028C
0x0290
0x0291
0x0292
0x02BE
0x02C7
0x02C8
0x0322
0x032B
0x032C
0x0386
0x038F
0x0390
0x0391
0x03EA
0x03F3
0x03F4
0x044E
0x0457
0x0458
0x04B2
0x04BB
0x04BC
0x04BD
0x0516
0x051F
0x0520
0x0521
0x057A
0x0583
0x0585
0x0586
0x058A
0x05DE
0x05EE
0x0642
0x064B
0x064C
0x064D
0x06A6
0x06AF
0x06B0
0x06B1
0x076E
0x0777
0x07D2
0x07DB
0x07DC
0x07E1
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Chybovy kod (kody)
0x07F8
0x0816
0x0817
0x0819
0x081F
0x0836
0x083F
0x087E
0x087F
0x0880
0x0881
0x0882
0x08A3
0x08DE
0x08E8
0x08E9
0x0907
0x0942
0x096B
0x096C
0x0988
0x09B0
0x09CF
0x09EC
0x0A1E

0x019B

0x019D
0x0201

0x0263

0x02C9
0x032D
0x0459
0x045A
0x04BF
0x0524
0x058B
0x05E9
0x0778
0x077D

0x0818

0x08EF
0x08F0
0x094D
0x094E
0x094F
0x0950
0x0951

0x0952
0x0953

O0x0A1F
0x0A20
0x0A21
0x0A22
0x0A23
0x0A24
0x0A25

O0x0AAA
0x0AAB
0x0AAC
0x0AAD
O0x0AAE
O0x0AAF
0x0ABO
0x0AB1
0x0AB2
0x0B18
0x0B72
0x0B73
0x0B74

Chybové hlasenie

Cartridge execution failure. (Zlyhanie vykonania testu kazety.) Please repeat with another cartridge and
verify that the Swab lid is correctly closed (Zopakuijte s inou kazetou a skontrolujte, ¢i je tamponové veko
spravne zavreté)

Cartridge execution failure. (Zlyhanie vykonania testu kazety.) Please repeat with another cartridge and if
sample type is Swab follow the IFU for proper swab use and insertion (Zopakujte s inou kazetou, a ak je
typ vzorky Tampon, postupujte podla pokynov v navode na pouzitie v suvislosti so spravnym pouzivanim
a vkladanim tamponov)

Cartridge execution failure. (Zlyhanie vykonania testu kazety.) Please repeat with another cartridge and
verify that the Swab and Bead Beater lid are properly closed (Zopakujte s inou kazetou a skontrolujte, €i
je veko pre tampoény a zariadenie Bead Beater spravne zavreté)

Cartridge execution failure: (Zlyhanie vykonania testu kazety:) Sample concentration too high.
(Koncentracia vzorky je prili§ vysoka.) Please repeat with another cartridge (Zopakuijte s inou kazetou)

Failure during PCR preparation. (Chyba poc¢as pripravy PCR.) Please repeat with another cartridge.
(Zopakujte s inou kazetou.) If this error persists please contact QIAGEN Technical Services (Ak tato
chyba pretrvava, kontaktujte technicky servis spolo¢nosti QIAGEN)

Failure during PCR preparation (dosing) (Chyba pocas pripravy PCR (davkovanie).) Please repeat with
another cartridge. (Zopakuijte s inou kazetou.) If this error persists please contact QIAGEN Technical
Services (Ak tato chyba pretrvava, kontaktujte technicky servis spolo€nosti QIAGEN)

Failure during PCR preparation (dispensing). (Chyba po¢as pripravy PCR (vydavanie).) Please repeat
with another cartridge. (Zopakuijte s inou kazetou.) If this error persists please contact QIAGEN Technical
Services (Ak tato chyba pretrvava, kontaktujte technicky servis spolo¢nosti QIAGEN)

Failure while executing PCR. (Chyba pocas vykonavania PCR.) Please repeat with another cartridge.
(Zopakujte s inou kazetou.) If this error persists please contact QIAGEN Technical Services (Ak tato
chyba pretrvava, kontaktujte technicky servis spolo¢nosti QIAGEN)
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Chybovy kod (kody) Chybové hlasenie
0x0B75
0x0B76
0x0B77
0x0B78
0x0B79
0x0B7A
0x0B7C
0x0BD6
0x0BD7
0x0BD8
0x0BD9
0x0BDA
0x0BDB
0x0BDC
0x0BDD
0x0BDE
0x0BEO
0x0C3A
0x0C3B
0x0C3C
0x0C3D
0x0C3E
0x0C3F
0x0C40
0x0C41
0x0C42
0x0C44
0x0C9E
0x0C9F
0x0CAO0
0x0CA1
0x0CA2
0x0CA3
0x0CA4
0x0CA5
0x0CA6
0x0CA8
0x0D02
0x0D03
0x0D04
0x0D05
0x0D06
0x0DO07
0x0D08
0x0D09
0x0DOA
0x0D0OC
0x0D66
0x0D67
0x0D68
0x0D69
0x0D6A
0x0D6B
0x0D6C
0x0D6D
0x0D6E
0x0D70
0x0DCA
0x0DCB
0x0DCC
0x0DCD
0x0DCE
0xODCF
0x0DDO
0x0DD1
0x0DD2
0x0DD4
0x0E2E
OxOE2F
0x0E30
0x0E31
0x0E32
0x0E33
0x0E34
Ox0E35
0x0E36
0x0E38
0x0E92
0x0E93
0x0E94
0x0E95
0x0E96
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Chybovy kod (kody) Chybové hlasenie
0x0E97
0x0E98
0x0E99
0x0E9A
0x0E9C
0x0EF6
O0x0EF7
0x0EF8
0x0EF9
0x0EFA
0xOEFB
0xOEFC
OxOEFD
OxOEFE
0x0F00
0xOF5A
0x0F5B
0x0F5C
0x0F5D
0xO0F5E
OxOF5F
0x0F60
0x0F61
0x0F62
0x0F64
OxOFBE
OxOFBF
0xOFCO0
0x0FC1
0x0FC2
0x0FC3
0x0FC4
0x0FC5
0x0FC6
0x0FC8
0x1022
0x1023
0x1024
0x1025
0x1026
0x1027
0x1028
0x1029
0x102A
0x102C
0x1086
0x1087
0x1088
0x1089
0x108A
0x108B
0x108C
0x108D
0x108E
0x1090
0x10EA
0x10EB
0x10EC
0x10ED
0x10EE
0x10EF
0x10F0
0x10F1
0x10F2
0x10F4
0x114E
0x114F
0x1150
0x1151
0x1152
0x1153
0x1154
0x1155
0x1156
0x1158
0x11B2
0x11B3
0x11B4
0x11B5
0x11B6
0x11B7
0x11B8
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Chybovy kod (kody) Chybové hlasenie
0x11B9
0x11BA
0x11BC
0x1216
0x1217
0x1218
0x1219
0x121A
0x121B
0x121C
0x121D
0x121E
0x1220
0x127A
0x127B
0x127C
0x127D
0x127E
0x127F
0x1280
0x1281
0x1282
0x1284
0x12DE
0x12DF
0x12E0
0x12E1
0x12E2
0x12E3
0x12E4
0x12E5
0x12E6
0x12E8
0x1342
0x1343
0x1344
0x1345
0x1346
0x1347
0x1348
0x1349
0x134A
0x134C
0x13A6
0x13A7
0x13A8
0x13A9
0x13AA
0x13AB
0x13AC
0x13AD
0x13AE
0x13B0
0x140A
0x140B
0x140C
0x140D
0x140E
0x140F
0x1410
0x1411
0x1412
0x1414
0x146E
0x146F
0x1470
0x1471
0x1472
0x1473
0x1474
0x1475
0x1476
0x1478
0x14D2
0x14D3
0x14D4
0x14D5
0x14D6
0x14D7
0x14D8
0x14D9
0x14DA
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Chybovy kod (kody) Chybové hlasenie
0x14DC
0x1536
0x1537
0x1538
0x1539
0x153A
0x153B
0x153C
0x153D
0x153E
0x1540
0x159A
0x159B
0x159C
0x159D
0x159E
0x159F
0x15A0
0x15A1
0x15A2
0x15A4
0x15FE
0x15FF
0x1600
0x1601
0x1602
0x1603
0x1604
0x1605
0x1606
0x1608
0x1662
0x1663
0x1664
0x1665
0x1666
0x1667
0x1668
0x1669
0x166A
0x166C
0x16C6
0x16C7
0x16C8
0x16C9
0x16CA
0x16CB
0x16CC
0x16CD
0x16CE
0x16D0
0x172A
0x172B
0x172C
0x172D
0x172E
0x172F
0x1730
0x1731
0x1732
0x1734
0x178E
0x178F
0x1790
0x1791
0x1792
0x1793
0x1794
0x1795
0x1796
0x1798
0x17F2
0x17F3
0x17F4
0x17F5
0x17F6
Ox17F7
0x17F8
0x17F9
0x17FA
0x17FC
0x1856
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Chybovy kod (kody)
0x1857
0x1858
0x1859
0x185A
0x185B
0x185C
0x185D
0x185E
0x1860
0x18BA
0x18BB
0x18BC
0x18BD
0x18BE
0x18BF
0x18C0
0x18C1
0x18C2
0x18C4
0x191E
0x191F
0x1920
0x1921
0x1922
0x1923
0x1924
0x1925
0x1926
0x1928
0x1982
0x1983
0x1984
0x1985
0x1986
0x1987
0x1988
0x1989
0x198A
0x198C
0x19E6
0x19E7
0x19E8
0x19E9
0x19EA
0x19EB
0x19EC
0x19ED
0x19EE
0x19F0
0x1A4A
0x1A4B
0x1A4C
0x1A4D
0x1A4E
0x1A4F
0x1A50
0x1A51
0x1A52
0x1A54
0x1AAE
0x1AAF
0x1ABO
0x1AB1
0x1AB2
0x1AB3
0x1AB4
0x1AB5
0x1AB6
0x1AB8

0x0F001001

0x0F001009
0x0F00100A
0x0F00100B

0x0F00100C

0x0F001010

Chybové hlasenie

Backup created with a newer software. (Zaloha bola vytvorena pomocou novsieho softvéru.)
Opening the archive failed. (Otvorenie archivu zlyhalo.)
Opening the archive failed. (Otvorenie archivu zlyhalo.) The archive is corrupted. (Archiv je poSkodeny.)

Opening the archive failed. (Otvorenie archivu zlyhalo.) The database version from the archive is not
compatible with the software. (Verzia databazy z archivu nie je kompatibilna so softvérom.)

Archived results could not be removed. (Archivované vysledky sa nedaju odstranit.) To remove results,
create archive again and select to remove results option. (Na odstranenie vysledkov znovu vytvorte
archiv a vyberte moznost odstranenia vysledkov.)

Could not create the epidemiology report. (Nedala sa vytvorit epidemiologicka sprava.)
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Chybovy kod (kody) Chybové hlasenie

0x10001 Failure in the instrument, please contact QIAGEN Technical Services (Chyba v pristroji, kontaktujte
0x10002 technicky servis spolo¢nosti QIAGEN)
0x10003

0x10004

0x10005

0x10006

0x10007

0x10009

0x10010

0x11001

0x11002

0x11003

0x14000 Failure in the analytical module, please contact QIAGEN Technical Services (Chyba v analytickom
0x14002 module, kontaktujte technicky servis spolo¢nosti QIAGEN)

0x14001 Cartridge execution failure. (Zlyhanie vykonania testu kazety.) Please retry another cartridge and if this
0x14003 error persists contact QIAGEN Technical Services (Skuste znova s inou kazetou, a ak chyba pretrvava,
0x14008 kontaktujte technicky servis spolo¢nosti QIAGEN)
0x14009

0x14010

0x14011

0x14012

0x14014

0x14015

0x14016

0x14017

0x14018

0x14019

0x14020

0x14021

0x14022

0x14024

0x14025

0x14026

0x14027

0x14028

0x14004 Abnormal software failure. (Abnormalna porucha softvéru.) Please retry another cartridge and if this error
0x14005 persists contact QIAGEN Technical Services (Skuste znova s inou kazetou, a ak chyba pretrvava,
0x14029 kontaktujte technicky servis spolo¢nosti QIAGEN)

0x14030

0x14031

0x14032

0x14033

0x14006 Cartridge execution failure. (Zlyhanie vykonania testu kazety.) Please retry a cartridge from another lot
0x14007 and if this error persists contact QIAGEN Technical Services (Skuste znova s kazetou z inej SarzZe, a ak
chyba pretrvava, kontaktujte technicky servis spoloénosti QIAGEN)

0x14013 Possible sample concentration too high. (Koncentracia vzorky je mozno prili§ vysoka.) Please repeat with
0x14023 another cartridge. (Zopakujte s inou kazetou.) If this error persists contact QIAGEN Technical Services
(Ak chyba pretrvava, kontaktujte technicky servis spolo¢nosti QIAGEN)
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11.

Prevadzkové podmienky

Poziadavky na napajanie

Poistka
Teplota
Vihkost’
Nadmorska vyska

Svetlo

50 - 60 Hz

100 -240V AC

Technické Specifikacie

Zasuvka IEC 60320-1 C14

1 x 8 A, ¢asové oneskorenie

15-30°C

20 — 80 % relativna, nekondenzujuca

0-3100m
Max. 4000 lux

Podmienky prepravy

Teplota

0 — 55 °C, maximalna relativna vihkost 85 %, nekondenzujuca

Elektromagneticka kompatibilita (EMC)

Poziadavky EMC

Urovne skusky
emisii EMC

Vyhovuje norme IEC 61326, trieda A

Zariadenie bolo navrhnuté a testované podla CISPR 11, trieda A. V domacom prostredi méze spdsobit’ radiové rusenie —
v takom pripade budete musiet prijat opatrenia na zmiernenie rusenia.

Skuska emisii

Uroveri skusky/arovef
zhody

Elektromagnetické prostredie

VyzZarované emisie
CISPR 11

Uroven emisii trieda A,
skupina 1

Vedené emisie
CISPR 11

Urover emisii trieda A,
skupina 1

Harmonické skreslenie
IEC 61000-3-2

Podla IEC 61000-3-2

Kolisanie napétia a
blikanie

IEC 61000-3-3

Podla IEC 61000-3-3

Emisné charakteristiky tohto zariadenia ho predurcuju na pouzivanie
v priemyselnych oblastiach a nemocniciach (CISPR 11 trieda A). Ak
sa toto zariadenie pouziva v obytnom prostredi (pre ktoré sa bezne
vyzaduje CISPR 11 trieda B), nemusi poskytovat primerant ochranu
radiofrekvenénym komunikaénym sluzbam. Je mozné, Ze pouzivatel
bude musiet prijat opatrenia na zmiernenie rizika, ako je
premiestnenie alebo zmena orientacie zariadenia.
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Urovne skusky
odolnosti EMC

Skuska odolnosti

Uroveri skusky/trover zhody

Elektromagnetické prostredie

Elektrostaticky vyboj
IEC 61000-4-2

+8 kV kontakt
+2 kV, +4 kV, £8 kV, £15 kV vzduch

Vyzarované RF EM
polia

IEC 61000-4-3

3V/im
80 MHz — 6 GHz
(pri 80 % AM pri 1 kHz)

Blizke polia z RF
bezdrétovych
komunika¢nych
zariadeni

IEC 61000-4-3

Pozri tabulku nizsie

Magnetické polia s
menovitou
vykonovou
frekvenciou

IEC 61000-4-8

30 A/m
(50 Hz alebo 60 Hz)

Blizke magnetické
polia

IEC 61000-4-39

Skusobna frekvencia 30 kHz, modulacia CW: 8 A/m

Skusobna frekvencia 134,2 kHz, pulzna modulacia 2,1 kHz:

Skusobna frekvencia 13,56 MHz, pulzna modulacia 50 kHz:

65 A/m

7,5 Alm
Rychle elektrické Napajanie
o - . 2 kV
prechody/vyboje striedavym
IEC 61000-4-4 prudom (5/50 ns, 100 kHz)
Rychle elektrické 1/0 vedenie
P 1 kV
prechody/vyboje
IEC 61000-4-4 (5/50 ns, 100 kHz)
Prepatia vedenie k Napajanie
vedeniu striedavym £0.5KV. +1 KV
Prepétia vedenie k prudom e
zemi +0,5kV, 1 kV, £2 kV
IEC 61000-4-5
Prepatia vedenie k 1/0 vedenie
vedeniu
Prepéatia vedenie k +2 kV
zemi
IEC 61000-4-5
Vedené poruchy Napajanie 3V (150 kHz — 80 MHz)
vyvolané RF pofami striedavym 6 V v ISM pasmach medzi 150 kHz -
IEC 61000-4-6 pridom 80 MHz
(pri 80 % AM pri 1 kHz)

Poklesy napatia Napajanie 0 % UT; 0,5 cyklu (pri 0°, 45°, 90°, 135°,

striedavym 180°, 225°, 270°, 315°)

prudom

Prerusenia napatia
IEC 61000-4-11

0 % UT; 1 cyklus
70 % UT; 25/30 cyklov (pri 0°)

0 % UT; 250/300 cyklov

Zariadenie poskytujuce

profesionalnu zdravotnu
starostlivost

(Prostredie, kde sa poskytuje

odborna zdravotna starostlivost:

Lokality zahffaju nemocnice,
diagnostické laboratéria, krvné
banky, centra darcovstva krvi,
ordinacie lekarov, jednotky
intenzivnej starostlivosti,
chirurgické centra, pohotovosti,
ordinacie, kliniky, izby pre
pacientov, zubné ambulancie,
zariadenia s obmedzenou
starostlivostou, opatrovatel'ské
domy, lekaren s vySkolenym
operatorom a oSetrovne)
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Operaény modul
Rozmery

Hmotnost’

Analyticky modul

Rozmery

Hmotnost’

Rozhranie Ethernet

USB porty

Urovne zhody a skusky, vyzarované RF IEC 61000-4-3

Skusobna Pasmo @ Sluzba @ Modulacia Uroveri skigky odolnosti
frekvencia
(MHz) (MHz)
(V/m)
385 380 az 390 TETRA 400 Pulzna modulacia 27
18 Hz
450 430 az 470 GMRS 460, FRS 460 FM © 28
odchylka +5 kHz
1 kHz sinus
710
745 704 az 787 LTE pasmo 13, 17 Pulzna modulacia ®) 9
217 Hz
780
810
GSM 800/900, TETRA 800, Pulzna modulacia b)
870 800 az 960 iDEN 820, CDMA 850, 18 Hz 28
LTE pasmo 5
930
1720
GSM 1800; CDMA 1900; Pulzna modulacia ®)
1845 1700 az 1990 [ GSM 1900; DECT; LTE pasmo 217 Hz 28
1, 3, 4, 25; UMTS
1970
2450 2400 az 2570 Bluetooth, WLAN, Pulzna modulacia ©) 28
802.11 b/g/n, RFID 2450, 217 Hz
LTE pasmo 7
5240
5500 5100 az 5800 WLAN 802.11 a/n Pulzna modulacia ) 9
217 Hz
5785
Ak je to potrebné na dosiahnutie UROVNE SKUSKY ODOLNOSTI, vzdialenost medzi vysielacou anténou a
ZARIADENIM ME alebo SYSTEMOM ME sa méze zmensit na 1 m. Sku$obna vzdialenost 1 m je povolena normou
IEC 61000-4-3.
a) Pre niektoré sluzby su zahrnuté iba uplinkové frekvencie.
® Nosna vina sa moduluje pomocou 50 % signalu s pravouhlou vinou pracovného cyklu.
© Ako alternativa k FM modulacii méze byt nosna frekvencia pulzne modulovana pomocou 50 % signalu s
pravouhlou vinou pracovného cyklu pri 18 Hz. Aj ked to nepredstavuje skuto¢ni modulaciu, bol by to najhorsi
pripad.

Sirka:

Vyska:
Hibka:

5 kg

Sirka:

Vyska:

Hibka:
16 kg

234 mm
326 mm
517 mm

153 mm
307 mm
428 mm

1x 10/100 — Base-T Ethernet

1 vpredu a 3 vzadu
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12, Prilohy

12.1. Instalacia a konfiguracia tladiarne

Existuje viacero spésobov instalacie tlaciarne do analyzatora QlAstat-Dx Analyzer 2.0. Po pripojeni tlaCiarne k operacnému
modulu mozno tladiarne nainstalovat pomocou predvoleného ovladaca (priloha 12.1.3), inStalaciou tlaciarne
prostrednictvom softvéru (priloha 12.1.4) a inStalaciou ovlada¢a pomocou rozhrania CUPS (priloha 12.1.5). Odpora¢ame

vyskusat tieto postupy v uvedenom poradi.

12.1.1. Pripojenie tlaCiarne cez USB
Pri pripajani tlaciarne pomocou pripojenia USB postupujte podla nizSie uvedenych krokov:

1. Pripojte USB kabel z tlaciarne do jedného z portov USB opera¢ného modulu. K dispozicii su 4 porty USB: 1 na pravej

strane obrazovky a 3 na zadnej strane pristroja.

2. Pokradujte prilohou 12.1.3.

12.1.2. Pripojenie tlaCiarne cez ethernet

Poznamka: Na pripojenie tladiarne cez ethernet je potrebné, aby boli sietova tlaciaren, lokalny pocita¢ a analyzator

QlAstat-Dx Analyzer 2.0 dostupné a pripojené k rovnakej miestnej sieti.
Poznamka: Lokalny pocitac je potrebny len vtedy, ak postupujete podla krokov uvedenych v prilohe 12.1.5.
Pri inStalacii sietovej tlaciarne pomocou pripojenia ethernet postupujte podla nizSie uvedenych krokov:

1. Pripojte tlaCiaren k sieti ethernet a zapnite tlaciareri.
2. Povolte nastavenia siete analyzatora QlAstat-Dx Analyzer 2.0 (pozrite si Cast 6.7.6).

3. Pokracujte prilohou 12.1.3.

12.1.3. Instalacia tlaiarne s predvolenym ovladacom

V softvéri analyzatora QlAstat-Dx Analyzer 2.0 postupujte podla krokov pre instalaciu tlaiarne pomocou predvoleného
ovladaca:

1. Prejdite do nastaveni tlaciarne v softvéri aplikacie operaéného modulu analyzatora QlAstat-Dx Analyzer 2.0 Options

(Moznosti) --> System Config (Konfiguracia systému) --> Printer (Tlaciarer).
2. Vyberte predvolenu tlaCiarer s nazvom B/W USB (obrazok 103)

3. Vytlacte spravu
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administrator System Config 14:20 2021-07-12

Run Test
SETTINGS SELECT A PRINTER
Regional > Add new printer > e
HIS/LIS > Default B/W USB )

View

QlAsphere Base > et
General > @
Printer > Options
Network >
Network Share > @
~ . - Log Out

Save ® Cancel

Obrazok 103. Instalacia tlaciarne s predvolenym ovladacom.

12.1.4. InStalacia tladiarne s inStalaciou ovladaca

V softvéri analyzétora QlAstat-Dx Analyzer 2.0 postupujte podla krokov na instalaciu ovlidda¢a pomocou softvéru:

1.

o N O O,

Prejdite do nastaveni tlaCiarne v softvéri aplikacie operacného modulu analyzatora QlAstat-Dx Analyzer 2.0 Options
(Moznosti) --> System Config (Konfiguracia systému) --> Printer (Tlaciareri)--> Add new printer (Pridat novu

tlaCiareri)

. Zadajte nazov tlaciarne

Nazov tlagiarne musi obsahovat zakladné anglické znaky, ktoré sa daju tlacit, s vynimkou: / # ? \ " ' medzera. Prepnite
rozloZenie klavesnice pomocou tladidla ID v spodnej €asti a tu najdete vSetky zakladné anglické znaky, ktoré sa daju

tlacit.

. Kliknite na moznost Select detected Printer (Vybrat najdena tlaCiareri). Nacita sa zoznam dostupnych tlaciarni.

Upozoriujeme, ze nazvy tlaciarni, ktoré obsahuju nasledujuce znaky, sa nezobrazuju: < > | {} +. TlacCiareri sa da stale

pridat manualne podla IP adresy bez ohladu na nazov tlaCiarne, pokracujte prilohou 12.1.5.

. Zo zoznam vyberte Zelanu tlagiareri. Ak sa tlaiaren v zozname nezobrazuje, pokracujte alternativnym spésobom

opisanym v prilohe 12.1.5.

. Kliknite na moznost’ Add Printer (Pridat tlaCiaren) (obrazok 104).
. Vyberte novo pridanu tlaciaren ako novu tlaciaren.
. Nastavenia ulozte.

. Vytlacte spravu.
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technician

_I Available

SETTINGS

Printer
Network
Network Share
System Log
Version Info
System Update

System Backup

2 Available

VIV IV |V V|V

System Config

Add new printer

Default B/W USB

Obrazok 104. InStalacia tlac¢iarne s instalaciou ovladaca.

3 Available

SELECT A PRINTER

4 Available

NEW PRINTER

Printer name

New-Printer

Select detected printer

Add printer

* Save ® Cancel

12.1.5. In&tal&cia tlaCiarne s manualnou konfiguraciou IPP

V softvéri analyzatora QlAstat-Dx Analyzer 2.0 postupujte podla krokov na inStalaciu oviada¢a pomocou softvéru:
1.

¢}

© oo N O
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(Moznosti) --> System Config (Konfiguracia systému) --> Printer (Tlaciareri)--> Add new printer (Pridat novu

tlaciareri)

. Zadajte nazov tlaciarne.

13:23 2021-04-15

Run Test

View
Results

©

Options

,_
o
[t=]
(@]
=
g

Prejdite do nastaveni tlaciarne v softvéri aplikacie operacného modulu analyzatora QlAstat-Dx Analyzer 2.0 Options

. Nazov tladiarne musi obsahovat zadkladné anglické znaky, ktoré sa daju tlacit, s vynimkou: / # ? \ " ' medzera. Prepnite

rozlozenie klavesnice pomocou tlacidla ID v spodnej ¢asti a tu najdete vSetky zakladné anglické znaky, ktoré sa daju

tlacit.

. Kliknite na moznost Manual IPP Configuration (Manualna konfiguracia IPP).

. Zadajte IP address / Host Name (IP adresa/nazov hostitela) tlaciarne. Ak sa tlagiaren v zozname nezobrazuje,

pokracujte alternativnym spésobom opisanym v prilohe 12.1.

. Kliknite na moznost' Add Printer (Pridat tlaciareri) (obrazok 104).

. Vyberte novo pridanu tlaciaren ako novu tlaciaren.
. Nastavenia ulozte.

. Vytlagte spravu.
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administrator System Configuration 14:37 2023-02-20

F

1 Available °
Run Test
SETTINGS SELECT A PRINTER ... NEW PRINTER
Add new printer > Manual IPP
General > . Configuration ( 4
o 5 Default B/W USB Printer name View
New-Printer fenits
Network >
IP address / Host name
Network Share > 10.135.39.4
Options
System Log >
) Add printer
Version Info >

Software License

PSR R >

)
=]
o
]
=3

[E] save ® Cancel

Obrazok 105. InStalacia tlaciarne s manualnou konfiguraciou PP.

12.1.6. Zoznam testovanych tlaciarni

V Case zverejnenia tejto pouzivatelskej prirucky boli spoloénostou QIAGEN testované tieto tlagiarne, ktoré st kompatibilné
s analyzatorom QlAstat-Dx Analyzer 2.0 prostrednictvom pripojenia USB a Ethernet:

o  HP® OfficeJet® Pro 6230

e HP Color LaserJet® Pro M254dw

e HP Color LaserJet® MFP M227dw

e HP Laserjet® Pro M404n

e Lexmark MS431dw

Dalsie tlagiarne, ktoré podporuju IPP Everywhere, mdéZu byt kompatibilné s analyzatorom QIAstat-Dx Analyzer 2.0
prostrednictvom postupu uvedeného v prilohe 12.14 a 12.1.5. Tieto tlaCiarne su uvedené na stranke
https://www.pwg.org/printers/.

12.1.7. Odstranenie tlaciarne

V softvéri analyzatora QlAstat-Dx Analyzer 2.0 postupujte podla krokov na odstranenie tlaciarne a jej ovladaca pomocou
softvéru:

1. Stlacte Options > System Configuration (Moznosti > Konfiguracia systému).
2. Vyberte moznost Printer (Tladiaref) zo zoznamu nastaveni v lavom stipci.
3. Vyberte tlaCiarefi zo zoznamu dostupnych tlaciarni.

4. Stlacte tlacidlo Remove printer (Odstranit tlaciaren) a tlaCiaren odstrante. Tymto sa vymazu aj vSetky aktivne tlacové
ulohy pre tuto tlaciaren.

Poznamka: Prednastavenu tlaCiaren nie je mozné vymazat.
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12.2. Odpad z elektrickych a elektronickych zariadeni (OEEZ)

Tato Cast poskytuje informacie o likvidacii odpadu z elektrickych a elektronickych zariadeni pouzivatelmi.

Symbol preciarknutej smetnej nadoby s kolieskami (pozri nizSie) oznacuje, Ze tento vyrobok sa nesmie likvidovat s inym
odpadom. Musi sa odovzdat’ do schvaleného zariadenia na spracovanie alebo na uréené zberné miesto na recyklaciu v

sulade s miestnymi zakonmi a predpismi.

Separovany zber a recyklacia odpadovych elektronickych zariadeni v ¢ase likvidacie pomaha zachovavat prirodné zdroje
a zabezpecuje, ze vyrobok bude recyklovany spésobom, ktory chrani fudské zdravie a zivotné prostredie.

Recyklaciu méze na vyZiadanie za priplatok zabezpecit spolo¢nost QIAGEN. V Eurdpskej unii, v sulade s konkrétnymi
poziadavkami na recyklaciu OEEZ a tam, kde spolo¢nost QIAGEN dodava nahradny vyrobok, sa poskytuje bezplatna
recyklacia elektronickych zariadeni oznacenych OEEZ.

Ak chcete recyklovat’ elektronické zariadenia, obratte sa na miestne obchodné zastupenie spolo€nosti QIAGEN a poziadajte
ho o formular pre vratenie. Po odoslani formulara vas bude spolo¢nost QIAGEN kontaktovat bud’ na vyziadanie naslednych
informacii pre planovanie zberu elektronického odpadu, alebo aby vam poskytla individualnu ponuku.

12.3. Dolozka o zodpovednosti

Spolo¢nost QIAGEN bude oslobodend od vSetkych zavazkov vyplyvajlcich zo zaruky v pripade, Ze opravy alebo Upravy
vykonaju iné osoby ako jej vlastnici, okrem pripadov, ked spolo¢nost QIAGEN udelila pisomny suhlas na vykonanie takychto

oprav alebo Uprav.

VSetok material vymeneny v ramci zaruky ma zarucnu lehotu totoznu s pdvodnou zaruénou lehotou a tato v ziadnom pripade
neprekracuje pdvodnu zaruénu lehotu, ak nie je pisomnou formou zastupcom spolo¢nosti QIAGEN dohodnuté inak. Na
odcitacie zariadenia, prepojovacie zariadenia a suvisiaci softvér sa bude poskytovat zaruka iba po€as obdobia, ktoré
ponuka poévodny vyrobca tychto vyrobkov. Vyhlasenia a zaruky poskytnuté akoukolvek osobou vratane zastupcov
spolo¢nosti QIAGEN, ktoré su nekonzistentné alebo su v rozpore s podmienkami v tejto zaruke, nie su zavazné pre

spolo¢nost’ QIAGEN, pokial nie su pisomne vyhotovené a schvalené uradnikom spolo¢nosti QIAGEN.
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12.4. Licencna zmluva pre softvér

TERMS AND CONDITIONS of a LEGAL AGREEMENT (the "Agreement") by and between QIAGEN GmbH, QIAGEN
Strasse 1, D-40724 Hilden, Germany, ("QIAGEN") and you (either an individual or a legal entity), the licensee of the software
(hereinafter referred to as "SOFTWARE")

By installing, having installed and using the SOFTWARE you are agreeing to be bound by the terms of this Agreement. If
you do not agree to the terms of this Agreement, promptly return the software package(s) and the accompanying items

(including written materials) to the place you obtained them for a full refund of the costs of the SOFTWARE.
1. GRANT OF LICENSE

Scope. Subject to the terms and conditions of this agreement, QIAGEN grants you a worldwide, perpetual, non-exclusive,
and nontransferable license to use the SOFTWARE solely for your internal business purposes.

You shall not:

e modify or alter the whole or any part of the SOFTWARE nor merge any part of it with another software nor separate
any components of the SOFTWARE from the SOFTWARE nor, save to the extent and in the circumstances permitted
by law, create derivative works from, or, reverse engineer, decompile, disassemble or otherwise derive source code
from the SOFTWARE or attempt to do any of these things
copy the SOFTWARE (except as provided above)

® assign rent, transfer, sell, disclose, deal in, make available or grant any rights in the Software Product in any form to
any person without the prior written consent of QIAGEN;

® remove alter, obscure, interfere with or add to any proprietary notices, labels, trademarks, names, or marks on,
annexed to, or contained within the SOFTWARE;

e use the SOFTWARE in any manner that infringes the intellectual property or other rights of QIAGEN or any other
party; or

® use the SOFTWARE to provide on-line or other database services to any other person.

Single-Computer Use. This Agreement permits you to use one copy of the SOFTWARE on a single computer.
Trial versions. Trial versions of the SOFTWARE may expire after a period of 30 (thirty) days without prior notice.

Open Software/Third Party Software. This Agreement does not apply to any other software components identified as subject
to an open source license in the relevant notice, license and/or copyright files included with the programs (collectively the
"Open Software"). Furthermore, this Agreement does not apply to any other software for which QIAGEN is only granted a
derived right to use ("Third Party Software"). Open Software and Third Party Software may be supplied in the same electronic
file transmission as the SOFTWARE but are separate and distinct programs. The SOFTWARE is not subject to the GPL or
any other open source license.

If and insofar QIAGEN provides Third Party Software, the license terms for such Third Party Software shall additionally apply

and prevail. If Open Software is provided, the license terms for such Open Software shall additionally apply and prevail.
QIAGEN shall provide you with the corresponding source code of relevant Open Software, if the respective license terms of
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the Open Software include such obligation. QIAGEN shall inform if the SOFTWARE contains Third Party Software and/or
Open Software and make available the corresponding license terms on request.

2. UPGRADES

If the SOFTWARE is an upgrade from a previous version, you are granted a single license to both copies, and you may not
separately transfer the prior version(s) except as a one-time permanent transfer to another user of the latest upgrade and

all prior versions as allowed in Section 4 below.

3. COPYRIGHT
The SOFTWARE, including any images, and text incorporated in the SOFTWARE, is copyrighted and is protected by
German copyright laws and international treaty provisions. You may not copy any of the printed materials accompanying
the SOFTWARE.

4. OTHER RESTRICTIONS
You may not rent or lease the SOFTWARE, but you may transfer the SOFTWARE and accompanying written materials on
a permanent basis to another end user provided you delete the setup files from your computer, and the recipient agrees to
the terms of this Agreement. You may not reverse engineer, decompile, or disassemble the SOFTWARE. Any transfer of

the SOFTWARE must include the most recent upgrade and all prior versions.

Note: For additional license agreements of third party software included in the QlAstat-Dx Analyzer 2.0, navigate to
“Options” > “System Config” > “Version Info”.
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5. LIMITED WARRANTY

QIAGEN warrants that (a) the SOFTWARE will perform substantially in accordance with the accompanying printed materials
for a period of ninety (90) days from the date of receipt. Any implied warranties on the SOFTWARE are limited to ninety (90)

days. Some states/jurisdictions do not allow limitations on duration of an implied warranty, so the above limitation may not

apply to you.

6. CUSTOMER REMEDIES

QIAGEN entire liability and your exclusive remedy shall be, at QIAGEN's option, either (a) return of the price paid or (b)
repair or replacement of the SOFTWARE that does not meet QIAGEN's Limited Warranty and that is returned to QIAGEN
with a copy of your receipt. This Limited Warranty is void if failure of SOFTWARE has resulted from accident, abuse, or
misapplication. Any replacement of SOFTWARE will be warranted for the remainder of the original warranty period or thirty
(30) days, whichever is longer.

7. LIMITED LIABILITY

In no event shall QIAGEN or its suppliers be liable for any damages whatsoever (including, without limitation, damages for
loss of business profits, business interruption, loss of business information, or other pecuniary loss, unforeseeable damage,
lack of commercial success, indirect damage or consequential damage — in particular financial damage — or for damage
resulting from third party claims) arising out of the use or inability to use the SOFTWARE, even if QIAGEN has been advised
of the possibility of such damages.

The above restrictions of liability shall not apply in cases of personal injury or any damage resulting from willful acts or gross
negligence or for any liability based on the Product Liability Act (Produkthaftungsgesetz), guarantees or other mandatory

provisions of law.

The above limitation shall apply accordingly in case of:

e delay,
® compensation due to defect,

® compensation for wasted expenses.

8. NO SUPPORT

Nothing in this agreement shall obligate QIAGEN to provide any support for the SOFTWARE. QIAGEN may, but shall be
under no obligation to, correct any defects in the SOFTWARE and/or provide updates to licensees of the SOFTWARE. You
shall make reasonable efforts to promptly report to QIAGEN any defects you find in the SOFTWARE, as an aid to creating
improved revisions of the SOFTWARE.

Any provision of support by QIAGEN for the SOFTWARE (including network installation support), if any, shall solely be
governed by an according separate support agreement.
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9. TERMINATION

If you fail to comply with the terms and conditions of this Agreement, QIAGEN may terminate this Agreement and your right
and license to use the SOFTWARE. You may terminate this Agreement at any time by notifying QIAGEN. Upon the
termination of this Agreement, you must delete the SOFTWARE from your computer(s) and archives.

YOU AGREE THAT UPON TERMINATION OF THIS AGREEMENT FOR ANY REASON, QIAGEN MAY TAKE ACTIONS
SO THAT THE SOFTWARE NO LONGER OPERATES.

10. GOVERNING LAW, VENUE

This Agreement shall be construed and interpreted in accordance with the laws of Germany, without giving effect to conflict
of laws’ provisions. The application of the provisions of the UN Sales Convention is excluded. Notwithstanding any other
provision under this Agreement, the parties to this Agreement submit to the exclusive jurisdiction of the Diisseldorf courts.

12.5. Odmietnutie zaruk

S VYNIMKOU TOHO, AKO JE UVEDENE V PODMIENKACH PREDAJA SPOLOCNOSTI QIAGEN PRE ANALYZATOR
QlAstat-Dx Analyzer 2.0, SPOLOCNOST QIAGEN NENESIE ZIADNU ZODPOVEDNOST A ODMIETA AKEKOLVEK
VYSLOVNE ALEBO PREDPOKLADANE ZARUKY TYKAJUCE SA POUZIVANIA ANALYZATORA QIAstat-Dx Analyzer 2.0
VRATANE ZODPOVEDNOSTI ALEBO ZARUK TYKAJUCICH SA OBCHODOVATELNOSTI, VHODNOSTI POUZITIA NA
KONKRETNY UCEL ALEBO PORUSENIA AKEHOKOLVEK PATENTU, AUTORSKEHO PRAVA ALEBO INEHO PRAVA
DUSEVNEHO VLASTNICTVA KDEKOLVEK VO SVETE.

Analyzator QlAstat-Dx Analyzer 2.0 je vybaveny portom Ethernet. Kupujuci analyzatora QlAstat-Dx Analyzer 2.0 je vyhradne
zodpovedny za zabranenie vSetkym pocitaovym virusom, ¢ervom, tréjskym korfiom, malvéru, utokom alebo inym typom
naruSeni kybernetickej bezpecnosti. Spolo¢nost QIAGEN neprebera Ziadnu zodpovednost za pocitacové virusy, Cervy,
trojske kone, malvér, utoky alebo iné druhy naruseni kybernetickej bezpecnosti.

12.6. Slovnik

Analyticky modul (AM): Hlavny hardvérovy modul analyzatora QlAstat-Dx Analyzer 2.0 zodpovedny za vykonavanie testov
na testovacich kazetach QlAstat-Dx. Je riadeny operaénym modulom (OM).

Subor definicie testu: Subor definicie testu je subor potrebny na vykonanie testu na analyzatore QlAstat-Dx Analyzer 2.0.
Obsah suboru popisuje, ¢o je mozné merat, spdsob merania a spdsob hodnotenia nespracovanych vysledkov merania.
Pred prvym vykonanim testu by sa mal subor importovat do analyzatora QlAstat-Dx Analyzer 2.0.

GUI: Graphical user interface (Grafické pouzivatelské rozhranie).
IFU: Instructions for use (Navod na pouzitie).

Operaény modul (OM): Specialny hardvér analyzatora QlAstat-Dx Analyzer 2.0, ktory poskytuje pouzivatel'ské rozhranie
pre 1 — 4 analytické moduly (AM).

Pouzivatel: Osoba, ktora obsluhuje analyzator QlAstat-Dx Analyzer 2.0 ur€enym spdsobom.

Pouzivatel'ska prirucka pre analyzator QlAstat-Dx Analyzer 2.0 09/2024 137



13. Histodria revizie dokumentu

Datum Zmeny

HB-3359-001, V1, R1 Prvé vydanie

HB-3359-002, V1, R2 Aktualizacia informacii o kybernetickej bezpecnosti
HB-3359-003, V1, R2 Aktualizovany datum vydania na titulnej strane

Oprava formatovania a odkazov
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Ochranné znamky: QIAGEN®, Sample to Insight®, QlAstat-Dx® (QIAGEN Group); ACGIH® (American Conference of Government Industrial Hygienists, Inc.); Brother® (Brother Industries, Ltd); Clinical and Laboratory
Standards Institute® (Clinical Laboratory and Standards Institute, Inc.); Windows® (Microsoft Corporation); OSHA® (Occupational Safety and Health Administration, U.S. Dept. of Labor); PostScript® (Adobe, Inc.); HP®,
LaserJet®, OfficeJet® (Hewlett-Packard Development Company).

Registrované nazvy, ochranné znamky atd., pouzité v tomto dokumente sa nesmu povazovat za znamky nechranené podla zakona, aj ked neboli ako také oznacené prislusnym symbolom.
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